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Introduction vii

Introduction

Why do photography of the nude?
The human body is a unique photographic subject. Photography of the nude
can be powerful, controversial, and transgressive, revealing in public spaces
such as galleries, books, and on the Internet a totality of ourselves that is 
usually only shown to those with whom we are most intimate. We see 
ourselves reflected in images of the naked body. We see in images such as
Figures 1 and 2 human beauty; but we also perceive our transience and 
mortality. In viewing these images, with their representations of innocence
and knowingness, we experience both desire and fear, attraction and anxiety,
curiosity and embarrassment, reverence and amusement. 

Figure 1 Human beauty.
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Nude photography is now more popular than ever before. Digital photograph-
ic technology combines with the Internet to make it easy for photographers 
to create nude images discreetly (without the need to send film out for 
processing) and then choose how widely they wish to disseminate them. In
many countries this rapidly growing interest in the nude coincides with, and
derives from, social movements such as gay liberation, which by challenging
laws and taboos around different forms of sexuality also engendered much
broader artistic freedoms. 

Who is this book for?
The book is aimed at the intermediate or advanced photographer who’s 
looking to improve the quality and range of his or her photography. That
means, typically, that you’re a photographer who has already made a serious
start developing your skills in photography. You’re willing to invest a certain
amount of money, but much more importantly, a considerable amount of
time, developing your art and skills. The book contains ideas and techniques
that will challenge and develop your creativity and encourage you to expand
your boundaries; see Figure 3.

Figure 2 The body as 
landscape.
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The book’s also written on the assumption that you have something to say
about the human body, about beauty, and about photography itself. I don’t
mean that you have a “philosophy of photography” that you can set out in
words. (I envy you if you do!) But if you’re serious enough about photo-
graphy of the nude to have bought this book, then you’ll have a strong 
visual imagination and curiosity that impel and shape the images you create,
and a direction (or number of directions) in which you want your work to
develop; see Figure 4. 

Figure 3 The body in a 
landscape.

Figure 4 An unusual view of a
different subject.
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Most photographers of the nude (and, it’s a safe bet, readers of this book)
are male, and the models they prefer to work with are young, attractive, and
female. But a look around the wider scene reveals a wide and widening range
of themes, as in the stunning classic male nudes of Robert Mapplethorpe,
for example, or the nude images created by women photographers like
Kattaryna Breaux, Tee A. Corinne, or Grace Lau, who often use models who
challenge the viewer through their different appearances (older, larger, phys-
ically disabled, pierced, tattooed…) or are photographed as participants in
unconventional lifestyles. I hope that Mastering Digital Nude Photography
will encourage you to explore some of these approaches.

What’s in the book?
What styles of nude photography will you find in this book? All the labels we
apply to different types of photography are imprecise and have very over-
lapping boundaries, so what follows is only a broad-brush description of
what the book deals with.

You won’t find pornography in the book—at least not in the terms that the
publishers and I understand the word. This isn’t a moral judgment; it’s just
that there isn’t much art, visual creativity, or imagination in the vast bulk of
pornography. (That’s not to say that there isn’t a small number of photo-
graphers working today who can construct, from the explicit, genitally
focused “language” of conventional pornography, images of extraordinary
confrontational power and beauty.) 

Styles of Photography
You’ll find (but not in great numbers) glamour images. Glamour is almost as
hard to define as pornography. To me it refers to a style of photography that
uses the model’s expression and pose combined with a very frontal style of
lighting to stimulate and appeal to the viewer’s fantasy of the model being (or
very nearly being) sexually available; see Figure 5.

The book includes methods and approaches to erotic nude photography.
Without defining pornography and glamour, it’s hard to define erotic. I take
the word to refer to images that may again be intended to stimulate a fantasy
of the model’s availability, but are less explicit and visually more subtle than
either porn or glamour; see Figure 6. 
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Figure 5 A glamour-style shot.

Figure 6 Oil, water, the shot
framing, and the positioning of
the model’s hands combine to
make an erotic image.



Introductionxii

The book also deals with bodyscapes: images of parts of the body seen in an
abstract way that depersonalize them and invite the viewer to concentrate on
form, pattern, and texture. The word bodyscape is coined in imitation 
of landscape, and bodyscapes often suggest or seem to refer to forms of 
landscape: the body seen as a formation of hills and valleys. Bodyscapes could
be seen as a specific form of art nude; see Figure 7.

Art nude is the style which occupies most of the book. I’d define art nude as
the approach to photography which, of all types of nude photography, is
most concerned with the image as a whole; that is, with everything within the
frame, not just with the naked human figure(s) within the frame. Art nude
aims at sensuality rather than sexuality, at moving its audience, rather than
arousing them. As part of that aim, art nude images are often monochrome
rather than color. Removing color from the image is one of the ways of
depersonalizing and making it less about the specific model and more about
the body in general. Art nude is often elusive: It may be about the play of
light on the body, with the body itself indistinct and receding from the
image. See Figure 8.

Moving in another direction, the book also contains a number of fetish
images, such as Figure 9. Fetish moves us into the underbelly of “deviant”
sexuality and sensuality: areas where fantasies about taking or yielding power
are enacted and expressed. This theme is one which, like many photo-
graphers, I find increasingly interesting.

Figure 7 Careful lighting and
framing are key elements in
bodyscapes.
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Figure 8 Art nude.

Figure 9 The wrist restraints
and outstretched hands convey
clearly the essence of the
image, but the oblique lighting
adds a great deal to its impact.
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At the opposite extreme, perhaps, is what I’m tempted to call the documentary
nude. This deals in a more objective way with themes such as age, disability,
pregnancy, and so on. Objectivity doesn’t exclude sensuality, but the aim here,
certainly with age and disability, is to confront the viewer with subjects for
nude photography that are usually excluded or assumed to be unattractive. 
It can’t be said too often that beautiful and powerful images don’t require 
conventionally beautiful subjects; see Figure 10.

It’s a cliché of all the visual arts that the partially concealed or implicit nude
can be more evocative and moving than the more overt and explicit. Across
these themes, we’ll also see and discuss images which are only partially nude,
such as Figure 11.

Figure 10 A study in the 
textures of skin, hair, and nails.
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Influences
There are many good, and a few great, photographers working today and
showing their images on the Internet. Their work provides a vast, readily
available, and free repertoire of ideas and ways of looking at the world and
the body, and of techniques for realizing those ideas. It makes sense to learn
from them!

At the same time, and without starting a grand debate about the relationship
between photography and other, longer-established visual art forms such as
painting, I think photographers can also learn from the great artists of the
past. It’s not a matter of imitating them (though it can be instructive, and
usually frustrating, to try). It’s more a matter of experimenting with their
themes, ideas, or sometimes just poses, to see what photographic equivalent
you can find; see Figure 12. My own favorite artist, from this point of view,
is the nineteenth-century French painter Gustave Courbet, many of whose
works are found in the Musée d’Orsay in Paris. Courbet renders skin and
flesh in ways that make his nudes utterly real, not in a photographic sense,
but in the combination of sensuality, solidity, and vulnerability with which
he embodies them. The beautiful nude drawings and etchings of English
illustrator, sculptor, and typographer Eric Gill have also influenced me pro-
foundly, although I’d find it hard to point to many of my photographs in
which that influence is explicit. 

Figure 11 A playful example of
partial nudity.
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Influences don’t have to be visual. There’s a poem, for example, by French
poet Baudelaire, in which he describes his lover coming to him wearing
nothing but her “clashing jewels”; and that verbal image has provided a
theme which I’m still pursuing; see Figure 13. The intense, moving, and
visually evocative eroticism of the Song of Songs in the Old Testament has
also been an inspiration. 

Figure 12 Influences—visual.
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Assumptions
Once you’ve found your theme or idea there are, broadly speaking, two steps
in digital photography: creating the image in the camera and then manipu-
lating it on the computer. In each step the creative processes are mediated
and shaped by a whole range of technologies. I’ve made some assumptions
about the level of equipment you’re likely to use. It’s not essential, in order to
benefit from the book, that you’re equipped to that level: It just provides a
baseline. So, for example, I assume that you own a digital SLR camera that

� Accepts interchangeable lenses

� Has a hotshoe or other method of syncing flash heads

� Displays a histogram of the image after (and possibly before) you’ve
shot it

� Shows highlights and overexposed areas in an image after you’ve shot it

� Can produce RAW picture files

Figure 13 Influences—literary.
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I assume also that you have a computer with sufficient processing power,
RAM, storage, and backup to cope with 16-bit picture files which, as you
add layers and masks, may grow to more than 100MB per file (but will 
usually be reduced in size before you save them). And finally I’ve assumed
that, as well as shooting on location, you may work from a home studio with
good available light as well as perhaps two or three flash heads, and also have
access to a more fully equipped professional studio for some shoots. 

Most of the techniques of digital image manipulation shown here aren’t 
difficult to grasp. However, many of the methods described in detail deliber-
ately avoid the automated ways of, for example, selecting an area available in
most image-editing applications, in favor of slightly slower but safer and
more precise manual methods. These methods give you much more control
over the process of manipulation, as well as the capacity to more easily back-
track when things go wrong. See Figure 14.

Most people would argue that creativity, vision, and imagination can’t be
taught: There’s a view that these are instinctive, intuitive elements in human
nature, often arising from emotional processes and impulses we may be aware
of but have little conscious control over. Nonetheless, the expertise needed 
to turn that vision or idea into a form that can be communicated to your
audience often can be defined and described. What I’ve tried to do in
Mastering Digital Nude Photography is present different ways of working that
I hope will trigger new ideas for images in you, the book’s reader, and pro-
vide the means to achieve them. Experimentation is the best way forward,
always accepting that some experiments will be unsuccessful! The low 
running costs of digital photography encourage us to be adventurous 
during the shoot; and with safe working methods in picture editing and
manipulation you can be confident that if you decide to abandon an 
experimental edit, your original image remains unscathed, and any useful
versions of it you created along the way can also be saved. 

Chapter Outline
The book is divided into five sections: equipment and software; models;
lighting; shooting; and postproduction.

Equipment and Software
In terms of technologies available to the man in the street, the history of 
digital photography is considerably shorter than that of digital image manipu-
lation. Photoshop when it originally appeared was, for most photographers,



a tool for manipulating images shot on film and then scanned into the 
computer. One of the factors which makes this book timely is that digital
photography has, by now, clearly caught up.

The book doesn’t, by the way, cover scanners: My impression (and the pub-
lisher’s) is that—particularly with the advent of affordable digital SLRs—the
days of the scanner are numbered, at least as far as the serious amateur 
photographer is concerned. Every photographer of my acquaintance who was
film-based two years ago when I wrote Digital Nude Photography now shoots
principally or entirely with a digital camera. 

The range of digital cameras available changes so rapidly that it isn’t helpful
to write about specific models: By the time you read this, many of the 
cameras currently on the market as I’m writing will have been superseded.
(Not all “improvements” to cameras are convincing. The Nikon D70, for
example, did away with the D100’s tapped shutter button to which a cable
release could be attached, and replaced it with an infrared remote control
which is slower to use and less reliable.) But it’s still possible to discuss what
features are desirable in a camera (and which aren’t worth paying money for),
and what lenses should form the basis of the digital nude photographer’s kit.
We’ll take a look at anti-shake technologies, both those built into lenses and
those incorporated into the camera’s imaging chip. The merits of working
with RAW images are discussed here also, as are issues to consider when 
buying lights, computer systems, and tripods.

Unlike camera models, image-editing software remains relatively constant. 
It may be subject to ongoing development, but significant features rarely 
disappear from an application when a new version is produced. The book is
focused on Adobe Photoshop CS2, which is the application most photo-
graphers use. (A quick survey I carried out recently revealed that while some
of the photographers I spoke to use other applications as well as Photoshop,
every one of them uses Photoshop.) Later versions of Photoshop may well
contain valuable additional features, but it’s unlikely that any technique
described here will be unavailable in the future. 

A word on computer platforms: My background is in managing media 
production and design and print, so it’s perhaps not surprising that I prefer
using Apple Macintosh computers. Photoshop runs under both Mac and
Windows operating systems, so while the figures throughout the book 
illustrate Photoshop techniques on the Mac, exactly the same results can be
achieved on a Windows machine. Indeed, my approach to explaining how to
get the best out of Photoshop has been shaped by several years’ experience
teaching courses on this truly amazing piece of software, in a lab equipped
with Windows machines.

Introduction xix
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The same applies to screen and printer calibration software and equipment.
We’ll look in detail at what’s involved in calibrating your system, and 
shine some light on what often seems like a rather murky and elusive area of
imaging technology. What works on Macs also works under Windows.

With computers as with cameras, models change frequently, so here too the
discussion will be about desirable features and configurations, rather than
specific machines. 

Two final observations about equipment generally. I’m not obsessed with
technology: I don’t own, or hanker after, the very latest camera body, lens,
computer, or whatever. I now shoot with a Nikon D70 with a D100 for
backup, but when I wrote the predecessor to this book, Digital Nude
Photography, I shot most of it with a Nikon 5700—a pretty basic camera
which doesn’t even have interchangeable lenses. And the 5700 could do 
one or two tricks that I can’t do with my “better” cameras. For example, its
rotating monitor screen lets me shoot easily from very high or low angles; and
its fish-eye “lens” was an attachment which fitted over its zoom lens and
allowed me to zoom into the center of the fish-eye image, creating some very
interesting results. When I bought my Apple G5, I bought the cheapest 
(read: slowest) one I could find. For almost every task I require it to do, it
still thinks faster than I can! What matters much more than all the latest bells
and whistles is the photographer’s eye.

In the same way, it happens that I use Nikon cameras. The university I worked
for used Nikon cameras for teaching and production, so it made sense at that
time to stick with the same brand for myself, in order to have access to the
expertise of my colleagues in deciding which equipment to purchase (and 
borrow lenses occasionally). The result is that I’m embarrassingly ignorant
about other camera makes; but I certainly wouldn’t argue that Nikon cameras
are in any way better than other brands—they’re just what I’m used to. And
of course, having a range of Nikon lenses makes it more expensive to change
to a different manufacturer, so I guess I’m (happily) locked in.

Models
Without the model, there can be no images. Of all the aspects of photo-
graphy of the nude which inspire me and push me to try out different ideas
and methods, the experience of working with models of all kinds, in 
different combinations and situations, is one of the most powerful and 
challenging. The choice of model is a key element, and it’s determined by the
kind of photographer each of us wishes to be and the kind of photographs
we wish to produce. The possible range is considerable: Models can be male,
female, young, old, able bodied, disabled, of different ethnicities…. They
may be stunningly beautiful or handsome, or their looks may be average. We
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may shoot them singly or in pairs or more, combine female and male, or
work with just one gender at a time. Some themes may be achievable only
with that one special model whose unique look is integral to your vision;
other ideas may be less specific; see Figures 14 and 15.

Figure 14 A very special look:
This image derives much of its
impact from the play of light
across Martha’s shoulders and
throat. No other model I’ve
worked with has quite this
look.
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I hope you’ll find the range of models I use stimulating; or you may decide
that your own tastes are different. The most important point to consider here
is that beautiful models don’t automatically guarantee beautiful, original, 
eye-catching photographs. It’s not difficult to light your beautiful model, from
the front with flattering light from a huge softbox and from behind with a 
little hair light: it’ll work every time, in the sense that it will convey to 
viewers how beautiful your model is. But the resulting images may have very
little individuality about them: They may be images anyone could have taken.
The goal here is to develop skills and techniques through which you can find
and communicate unique ways of seeing.

Figure 15 Another unique
look: Zoey’s exotic hairstyles
and makeup are the focal 
element in this image. 
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Lighting
Without light there can be no photography; see Figure 16. This section con-
siders the importance of light, and of shadow and darkness, in determining
the impact and quality of every image we create. We then look in detail at
the use of available light, by which I mean both the natural light we work
with when shooting outdoors, and the daylight that passes through windows
into the interiors of buildings. Available light brings to indoor photography
an unbeatable subtlety, delicacy, and natural appearance, as well as problems
(and opportunities) in balancing light and shade. In addition we’ll look at
high-power continuous light sources, on-camera flash, and studio flash 
systems, as well as the panoply of softboxes, reflectors, and other lighting
peripherals.

Figure 16 Window light. 
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One of the greatest benefits of digital cameras is the capacity to display histo-
grams and highlights, thus making it very much easier to get the lighting 
for each shot exactly the way you want it and technically perfect as well,
exploiting the full tonal range of the camera. 

Here I need to indicate that the book doesn’t cover the use of flash meters. I’ve
found that working with a meter slows everything down too far and impedes
the concentration and connection between model and photographer, which is
essential to the whole process. I work with the histogram and highlight displays
on the camera’s monitor screen, which with a little experience and practice have
shown themselves to be very reliable indicators of what I’ve captured.

Again, I find studying the work of other photographers, as well as other visual
artists who create images of the nude, particularly useful where lighting is 
concerned. Often noticing a subtle difference between what I’m used to doing
and what I see another photographer achieving is enough to stimulate new
experiments and methods and create a different look in my work. And it isn’t
always the great masters who provide this challenge. One of my favorite web
sites is www.photosig.com, whose contributors are photographers of every level
of skill and imagination, shooting every conceivable subject. It’s unusual for a
week to go by on Sig without my seeing at least one picture that makes me ask,
“How did they do that?” and start moving lights around in my studio. 

The Shoot
This is the culmination of the first part of the process of creating an image.
Here, camera, lights, location, model, and lighting come together. The 
variables are almost infinite! You can position the camera and lights anywhere
around the model in the space you’ve chosen; you can select any combina-
tion of aperture and shutter speed and any focal length; your model can
move into any one of a thousand different poses; and you can choose the
expression you want her or him to adopt. In this chapter we’ll look at ways
of handling these possibilities and making the best selection.

Some approaches to the nude are site specific: They make use of the trees in
the woods, the pebbles on the beach, a library filled with old, leather-bound
books, the old wooden stairwell in a building…. Other styles have simpler
requirements which are easiest met in the studio: a plain dark background or
a bright white one.

This section deals with the use of “real” locations, as well as the possibilities
(and limitations) of two different types of studios; see Figure 17. Many 
photographers create a home studio by adapting part of their domestic living
space to their creative needs, and this section considers ways of doing this. It
also looks at a typical professional studio for hire and discusses the pros and
cons of using it. 

www.photosig.com
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Postproduction
The more I look at my own work and that of other photographers, the more
crucial this aspect of photographic creativity seems to be. It covers the whole
range of processes we put images through after the shutter clicks: from 
tidying the image, fixing skin blemishes and making the verticals vertical,
through manipulation of color, tone, and grain, to the transplanting of the
model into a different environment. We’ll also look in some detail at
Photoshop’s RAW-file interface and at Photoshop’s powerful but not widely
understood ways of creating and manipulating strong black-and-white
images from color originals.

The old cliché of the digital darkroom severely understates the power of the
computer and, most importantly, the freedom it gives (with negligible 
running costs) to take risks and experiment, far beyond what was feasible or
affordable in a real darkroom. At the same time, we can be confident, if
we’ve adopted safe and systematic working practices, that however much we
experiment, nothing will be lost or damaged and that original files can be
safely retrieved and reused. Linked to this is the certainty that every print
we make from a given file will be identical.

Printing itself is covered in Mastering Digital Printing, Second Edition, by
Harald Johnson; it is recommended for its very detailed and clear coverage of
nearly every aspect of digital printing. 

Figure 17 A natural location.



About the Author
I’m Australian born and based in Cambridge, England. I retired at the end of
2004, after a career in a university managing media production and media
training. Over the years I’ve designed courses in and taught Photoshop to
hundreds of undergraduate students and written detailed training manuals for
Photoshop and other media applications such as Media100 and AfterEffects. 

My first experience with nude photography was in the late ’70s, shooting
35mm b/w (mostly Pan F) with an Olympus OM2. This interest was 
rekindled in 2001 when I bought my first digital camera. My favorite styles
of nude imagery come within the broad headings of art nude and fetish. I
work mostly from my home studio with intense bursts of outdoor location 
shooting every summer (as far as the English climate allows).
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Figure 18 The author, pho-
tographed by Sheena Belham.
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You can envision the whole photographic production process as a series of
steps, each of which moves the photographer closer to the ultimate 
realization of his goal for each image. Step one might be to light the scene, for
example, step two to pose the model, step three to take the photograph, step
four to edit it, and so on. Beyond the model’s crucial participation and the
photographer’s creative vision, imagination, and skills, success in 
achieving this goal depends on a chain of equipment, from the camera
through the computer and its software, to the printer, all working together to
deliver that realization. See Figures 1.1 and 1.2 for examples of where these
things might take you. In this chapter you’ll consider options for each element
in the chain, including color management and the technology that helps to
achieve consistency in the appearance of your images, across the whole
process. And because the security of your digital photographs is as important
as the images themselves, you look at the reasons for backing up and 
archiving, and then at the technologies you need to keep your work safe.
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Figure 1.1 What the 
photographer thinks about: 
setting, pose, expression, gaze,
adornments, lighting…
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Figure 1.2 …depth of field,
camera angle, field of view,
contrast, crop, cleanup, 
catchlights, layers, masks, 
filters… . 



Sixteen Bits of RAW
When considering how to achieve the best technical quality for the images
you’re going to produce, there are two aspects: which camera settings to
choose and (anticipating a little) which bit-depth to use in postproduction.

Cheap and mid-range digital cameras usually store images as JPEG files, and
JPEG is also usually the out-of-the-box setting for digital SLRs. JPEG is a
lossy form of compression: Some of the data captured by the camera’s imag-
ing sensor is actually thrown away before the picture is saved to a file. That
data can’t be retrieved. JPEG compression can be applied at different levels,
keeping more or less of the original data, and most cameras offer two or three
levels for you to choose from. In its own terms the JPEG algorithm is pretty
smart, and it’s surprising how much data can be lost without the picture
becoming visibly ragged. To illustrate this, look at a detail from Figure 1.3.
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Figure 1.3 The whole image.



Figures 1.4 through 1.6 show an enlarged section of the model’s right eye,
shot with a JPEG compression ratio of 6:1, 10:1, and 24:1 respectively. The
increasing loss of color information, as the ratios go up, is unmistakeable. For
comparison, Figure 1.7 shows the same area when shot RAW.
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Figure 1.5 Medium-resolution JPEG.

Figure 1.6 Low-resolution JPEG.

Figure 1.7 The RAW image shows no loss of information.

Figure 1.4 High-resolution JPEG



Initially, the main justification for JPEG compression was to enable picture
files to be transmitted over slow networks and to save storage space on small
hard drives. JPEG has also, of course, become the only full-color file format
for displaying images on the Internet, so much of what we shoot is likely to
end up as a JPEG for that purpose. And it has to be said that images which
don’t require major work in postproduction can look surprisingly good when
saved and displayed or even printed from medium- to high-quality JPEG files.

There are limitations, however. JPEG allocates 8 bits to each of the three
channels of an RGB image, thus allowing 256 different shades of each color.
This creates a palette of 16.7 million color definitions (256 � 256 � 256),
which seems like quite a lot! However, most current digital cameras allocate
12 bits to each channel (4,096 shades of each color), so saving the image as
a JPEG (a process performed by the camera’s software) inevitably results in
the irretrievable loss of a significant amount of that original data. The data is
weeded out according to the camera’s own rules. Those rules will be 
pretty good, but if they’re not ideal for the kind of photography you do,
there’s nothing you can do to change them.

Just like our eyes, sensing devices such as camera chips can’t always handle
the full dynamic range of light, from glaring sunshine to dark shade, that
may be present in a scene. We work round this in a variety of ways, such as
bracketing exposures to find a “least-worst” solution. But JPEG compression
adds an extra difficulty, because it works less effectively on dark areas than
light ones, with dark areas of an image likely to become noisy and grainy.
Unlike the grain of traditional film, digital grain is too irregular to have much
aesthetic value, and it’s almost impossible to remove it from the image. This
constrains our options when we come to edit, or makes us spend extra time
cleaning up dark areas.

There are other problems in postproduction with JPEG compression. The
JPEG algorithm handles data in blocks of 8 � 8 pixels, and is notoriously
bad at coping with images which have been repeatedly cropped by only one
or two pixels, as Figures 1.8 and 1.9 demonstrate. More generally, it’s not
good at handling gentle color gradations. Lossy compression may also cause
problems printing images at large sizes. 

Mastering Digital Nude Photography8
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Figure 1.8 A JPEG as saved by
the camera, at 200-percent
enlargement.

Figure 1.9 The result of
repeatedly cropping a few 
pixels off the image: Artifacts
are noticeable, particularly
along the jaw line and around
the eyes.



In an age of storage cards with capacities of 1GB or more, the need to 
conserve space in saving files in the camera is less pressing than it was. And
in an age of very large and cheap mass storage, the need to constrain the size
of files which have been through postproduction has also declined, if not
vanished. This is why shooting pictures in RAW format, and editing them as
16-bit files, has become the preferred way to work. Using RAW avoids 
the limitations and weaknesses of JPEG, and also provides more powerful
postproduction tools. Because getting the best results depends both on using
RAW to shoot and edit, and on editing in 16-bit mode, we’ll look at both
processes now, but RAW editing is covered in detail in Chapter 5. 

To sum it all up, then: Shooting RAW has a number of advantages over
JPEG, both technical and creative, particularly for the photographer who
intends his work to be seen as prints. RAW images are cleaner than JPEGs.
Dark areas in particular are less noisy, and will also show subtler tonal 
variation. Photoshop’s Raw interface provides powerful tools which are more
effective than those in the main menu for optimising the image’s dynamic
range without losing any data. There’s also a simple eye-dropper tool for 
setting the white balance. These aren’t just technical considerations: RAW
offers you greater freedom to interpret the image, to give it the mood and
feeeling you’re striving for. That’s what makes the extra effort required so
worthwhile, and is the real reason for shooting RAW.

Understanding Camera Raw
A Camera Raw file is essentially what its name suggests: It’s a file containing,
in unprocessed form, all the data captured by the camera’s imaging sensor.
Because each sensor element only registers the intensity of light on a gray
scale, but not its color, the RAW file also contains information about how the
data from each sensor element should be interpreted (as red, green, 
or blue) along with metadata such as the camera make and model, the white
balance setting, and so on. 

To encode the different levels of light as data, each camera model may have
its own algorithm to assign and store a numerical value to the light which
passes through the lens and falls on each separate sensor element. The 
algorithm your camera uses may be different even from those used by other
camera models from the same manufacturer. Any picture-editing software
has to be capable, when you open the file, of displaying the image in 
accordance with the algorithm with which the image was shot. You can 
pretty much rely on any recent version of Photoshop to include plug-ins to
handle RAW files from camera models current at the time it was released,
and plug-ins for newer camera models appear promptly on Adobe’s web sites.

Mastering Digital Nude Photography10
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RAW files are larger than JPEGs. Typically the highest-quality JPEG from a
Nikon D70 is stored at around 2.2MB for a 2,000 � 3,008 pixel image; a
RAW file for the same size image is around 4.9MB. 

The JPEG version has to be produced by the camera, because that’s what’s dis-
played on the camera monitor. However, some cameras offer the possibility of
saving each image twice: once as a RAW file and once as a medium-quality
JPEG (on the D70, about 750KB per image). If you regularly give your model
a CD of pictures from the shoot, the JPEGs can be quite useful as a means of
doing so quickly and easily, without having to process all the RAW files. But
it does call for some care if you want to rename all the files. In Figure 1.10,
note the matching pairs of .jpg and .nef files (.nef is Nikon’s file extension for
RAW files). I’ve used iView MediaPro to batch rename all the files from the
shoot so that matching images still have the same number.

Figure 1.10 Part of a catalog generated by iView Media Pro.
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Camera Raw is also sometimes referred to as digital negative. Because RAW
files contain more data, without compression, they offer much more lati-
tude than JPEGs. It’s possible to alter the exposure in either direction by as
much as a stop or more, in very small increments, as well as easily make fine
adjustments to the white balance, black level (shadows), brightness, and
contrast. In addition, the Raw interface works nondestructively: You can
always reinstate the RAW image back to its camera settings, and you can’t in
any case permanently alter the RAW data. These are the reasons RAW is
becoming the preferred format for many photographers.

A note on jargon: Camera Raw is the name given in Photoshop to RAW files
produced by the camera, as described here. But among Photoshop’s file 
formats, in the Save As menu, you’ll find Photoshop Raw. This is completely
different! If it has a place in your workflow it’s likely to be at the end of post-
production, not the beginning. The use of Photoshop Raw is outside the
scope of this book, and from now on I’ll refer to Camera Raw simply as Raw.

Photoshop’s way of handling RAW files is to open them with a different
interface from the normal one; see Figure 1.11. You manipulate the RAW file
using the controls provided, and when you click OK, the RAW file is
processed to take account of the changes you’ve made and opens into the
standard Photoshop interface.

Figure 1.11 The Camera 
Raw interface. The histogram
indictes that the dynamic 
range of this image can be
expanded at both ends. Note
the eyedropper tool (top left)
used to set the white point, 
and the metadata following the
filename.



Getting Flexibility from 16 Bit
As we’ve seen, JPEG images use 8 bits per channel, which allows over 16 
million colors. Photoshop allows you to work at 16 bits per channel, which
allows over 35 trillion colors. This isn’t the overkill it seems. Working in 
16-bit mode means that you can use all the 12 bits per channel created by
your camera (with some headroom). Photoshop editing is destructive: When
you use a tool such as Curves or Levels, you’re throwing data away. That’s
why, for example, you often see those vertical white stripes in the Levels 
histogram; see Figure 1.12. They’re the representation of places in the image
where the tonal range has been stretched, so that the image actually contains
no data at that level. Repeated manipulation of levels will open wider gaps
until there’s visible posterization. The more you wish to manipulate the
image’s tonal range, and edit and re-edit using Photoshop’s destructive tools,
the more advantage you get from the extra flexibility those 16 bits provide:
fewer and smaller gaps in the histogram, and overall more robustness to with-
stand your most radical and adventurous creative impulses. 
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Figure 1.12 The effect of
adjusting levels using normal
Photoshop tools. The image
now uses the full dynamic
range available, but gaps have
opened up in the histogram,
showing that some tonal levels
have been lost.
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Shooting with Camera Raw
Once you’ve set your camera to RAW or RAW + JPEG, there are two impor-
tant steps to follow. The first is to include some reference for the white 
balance with each lighting setup, and the other is consistently to make use of
the histogram and highlight displays to check that you have the optimum
exposure. Because of the linear way the picture data is constructed in digital
photography, this means exposing for the highlights.

Consider a camera which has a dynamic range of six stops and records the
image using 12 bits per channel. Of the 4,096 possible levels the camera can
record in each channel, half (2,048) are allocated to the brightest stop; half
again (1,024) to the next brightest stop; and so on down to the darkest stop,
for which only 64 levels are available. This is a linear process, inherent in the
technology of sensors; but it isn’t at all the way the human eye responds to
light! When we open an image in the Photoshop Raw window, a complex
series of conversions are carried to make the linear data match the way we see
the world. The more use you make of the greater range of levels at 
the bright end (checking with the histogram and highlight display to avoid
overexposure), the more effective that match will be. 

To keep control over white balance, we need a reliable reference, such as the
widely used GretagMacbeth 24-square ColorChecker Chart shown in Figure
1.13. The bottom row of squares (white to black) is used to set the white 
balance, and the color squares can be used for very precise color adjustments. 

Figure 1.13 The Gretag-
Macbeth ColorChecker Chart.



To use the chart, set up the lighting as you want it for the scene, then 
position the chart in the scene, and shoot it, as in Figure 1.14. It doesn’t have
to fill the scene, but it’s important that it’s evenly lit and that nothing else in
the scene is shadowing it or reflecting color onto it. When you come to edit
your pictures, that shot becomes a reference, and the settings you chose for
it can be applied to other shots done with the same lighting conditions.
Figures 1.14 and 1.15, for example, show the chart and an image from the
set, as shot.
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Figure 1.14 Shooting the
chart before correction.

Figure 1.15 The real image
shot under the same lighting
conditions.
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Figure 1.16 The chart, 
corrected in Photoshop Raw.

Compare those images with 1.16 and 1.17, where Photoshop Raw has been
used on the chart to correct the white balance, and the same correction has
then been applied to the real image.

Figure 1.17 The correction
applied to the image.
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One final note of caution: To get the best out of shooting RAW, we need to
expose the highlights as fully as possible. However, completely overexposed
areas can’t be retrieved: If there’s no detail in any channel in an area because
every sensor has recorded absolute white (RGB 255, 255, 255), Photoshop’s
Raw interface has nothing with which to work. It may be possible 
convincingly to fill in small overexposed areas in Photoshop using the Clone
tool—a shoulder, for example, or the upper slope of a breast—but beyond
that, any overexposed areas in the image will remain. This means that, even
with the highlight indicator and histogram to help you, you may still want
to bracket your exposures to be certain of getting the most successful 
exposure. It’s helpful also to know exactly what the highlight indicator on
your camera is telling you. On Nikon digital SLRs, for example, the 
highlight display indicates everything above and including 96 percent of
maximum correct exposure, so an image which has no flashing highlights is
slightly underexposed. It’s a question of getting used to the camera’s displays
and what they’re telling you. 

Camera Considerations
In this section you look at some of the factors to consider in choosing the
camera that’s right for you. As always, don’t expect recommendations of 
specific camera models, but a more generalized discussion that touches on
major considerations. The largest camera format you look at is the digital
SLR (single lens reflex)—the approximate equivalent to the 35mm camera.
Large-format digital cameras and backs are coming onto the market all the
time, but they’re outside the scope of this book.

The discussion here is relatively brief. If you want to find out more about the
innards of your digital camera, either the excellent general introduction to
digital photography in this series, Mastering Digital Photography, or, for 
digital SLR owners, Mastering Digital SLR Photography, both by David D.
Busch (Course PTR), will more than satisfy your curiosity. Many magazines
are also devoted to digital photography; but my favorite source for reliable
and up-to-date information about the digital camera market has to 
be www.dpreview.com. This wonderful web site also contains invaluable 
general information about digital imaging, discussions from users about dif-
ferent camera models, and a detailed and clearly written glossary, together
with links to other equally useful informational sites.

www.dpreview.com
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I’ll be concentrating on aspects of choosing and using a camera that are 
particularly relevant to photography of the nude, but digital cameras are all-
rounders, packed with features which may not help with nude photography
but may be very useful for other types of photography in which you’re also
interested. An example is the ability to shoot bursts of images: I’ve rarely
needed that for a nude shoot, but if I were also interested in shooting, say,
motor-bike races or football games, capacity to shoot continuously would
certainly be a major consideration for me in choosing a camera. In the same
way, the 105mm micro lens I use to shoot extreme close-ups (see Figure 1.18)
as part of nude and flower photography (see Figure 1.19) is also a wonderful
lens for landscape (see Figure 1.20), and that’s a consideration which 
influenced my decision to buy it.

Figure 1.18 The 105mm lens,
with its field of view equivalent
to about 160mm on a 35mm
camera, is ideal for detailed
bodyscape shots, but but being
a telephoto lens needs to be
stopped down (f/22 here) to
give decent depth of field. This
in turn requires more light
than a wider lens which doesn’t
have to be stopped down so far
to give the same depth of field.
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Figure 1.19 The 105mm lens also works equally well for flower photography. A detail (not without erotic meaning!) of a
calla lily, taken with the same lens stopped down to f/36, and lit using flash. 

Figure 1.20 At the opposite
extreme, the 105mm lens also
provides just the right amount
of compression for landscape
photography, such as this
image of the hills near Gualdo,
a tiny village in the Marche
district of northern Italy. 



Prints Versus the Internet
You’ll notice that in this chapter I often discuss how your choice of camera,
lens, or whatever impacts the quality of prints you can produce. This is
because print quality is a better and more significant test of how your system
works (and of how you go about editing your pictures) than is your system’s
capacity to produce images for the Internet. Computer monitors are a 
relatively low-resolution form of display. Digital prints, on the other hand,
whether produced as machine prints by your local photographic store or via
your computer printer, require much more data, and thus make more
demands of your equipment and software at every stage.

If you only ever show your work online, then this argument may not have
much impact on what equipment you decide to buy or how you work. But
it’s also unfortunately the case that you have little control over how your
Internet audience sees your images, because you can never be sure that their
monitors are properly calibrated, or adequately sharp, or are being viewed
with appropriate ambient lighting. Equally, of course, when selling a print
you have no control over the environment in which it’s exhibited, but at least
when displaying it, you have the chance of ensuring that your work is seen
at its best. For all of these reasons I still think of the print, rather than any
onscreen representation, as being the real version of the photographs I take.

Sensors
Let me start by taking a brief overview of how digital cameras form images,
because it’s relevant to this book’s discussion about shooting RAW and 
provides some indication of the limits of digital cameras.

Camera sensors consist of an array of light-sensitive elements, each of which
contributes one pixel to the complete image. The sensor sits behind the lens,
which converges light from the scene you’re shooting onto the sensor, just as
in a film camera it converges light onto the film. So a camera which produces
a 3,008 � 2,000 pixel image has a sensor containing that many elements.
The physical size of the sensor affects the quality of the image—the bigger
the sensor is, the better—and also determines the multiplier, which tells you
the lens’ actual field of view (the area you can see through the lens) when
compared to the field of view of the same lens on a 35mm camera. 

In our shorthand way of referring to these things, we often talk or read about
the focal length of the lens of a digital SLR being 1.5 times that of the same
lens on a 35mm camera. But the lens’ focal length is a function of the lens’
design and structure, not of the camera body it’s attached to. It’s the field of
view which changes. 
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Figure 1.21 A (simulated)
35mm image. The image 
occupies the whole of the 
36 � 24mm frame.

For example: The dimensions of a 35mm frame are 36 � 24mm. A typical
digital SLR sensor might measure 23.7 � 15.6mm (Nikon D70), 22.2 �
14.8mm (Canon Rebel XT), or 17.3 � 13.00mm (Olympus E300). When
you attach a lens designed for a 35mm SLR to a digital SLR, the image
formed by the lens isn’t scaled down to the size of the sensor; it is in effect
cropped to the dimensions of the sensor. (To put it another way, the sensor,
being smaller than a 35mm frame, isn’t big enough to take the whole image
created by the lens.) The result, as the examples in Figure 1.21 and 1.22 indi-
cate, is to narrow the field of view, so the image appears to have been shot
with a lens with a longer focal length. For the cameras mentioned earlier, the
field of view multipliers are about 1.5 (36/23.7), 1.6 (36/22.2), and 2.1
(36/17.3), respectively. The effect of narrowing the field of view is to make
the subject appear closer.

Figure 1.22 The same image
taken on a digital SLR (Nikon
D70), with the 35mm frame
superimposed. The scale hasn’t
changed (the model’s the same
size), but the smaller size of the
sensor (23.7 � 15.6mm)
results in a cropped image. 



The difference in the sensors’ physical sizes also explains why your SLR 
really produces better images than the camera on a mobile phone—and, of
course, difference in lens quality may have something to do with it as well!
Small sensors containing very large numbers of elements don’t always deliver
the results you might hope for: See, for example, the discussion of blooming
later in this section. Note also that because there isn’t (yet) a standard size for
sensors, the multiplier for SLR lenses varies from maker to maker, and that
non-SLR digital cameras may have much smaller sensors than SLRs.

However, the way the sensor forms the image isn’t that simple. The sensor
records grayscale information only: intensity of light, but not color. (On a
digital SLR, with typically a 12-bit sensor, this means that each element can
record 4,096 different levels of gray.) This means that filters have to be
applied to the sensor elements, making them sensitive to either red, green, or
blue light. Because our eyes are more sensitive to green light, twice as many
elements have green filters overlaid on them as either red or blue. It’s 
possible to construct the whole of the spectrum of visible light out of red,
green, and blue light (that’s essentially how our eyes view the world), so once
the RGB filters have been applied, we should have full-color images.

Alas, we’re still not out of the woods! If we could see the result of the 
imaging process at this stage, after applying the filters, we’d see that the image
as a whole is made up out of sequences, rather like a mosaic, of pixels of each
separate color (alternating rows of red, green, red, green, and blue, green,
blue, green…). This is sometimes called a Bayer pattern. No part of the image
is in full color, because an element which has a filter over it to make it 
sensitive to, say, blue light is incapable of recording how much red or green
light is present at that specific location. The camera has to provide the 
missing information, by looking at red and green elements adjacent to that
blue element, averaging out their values, and using the results as the red and
green values at the location of the blue element; it does the same for the other
colors as well. This process is called de-mosaicing. These approximated 
values are one of the main reasons digital cameras have problems with 
sharpness. Note in Figure 1.23 that there are two green sensors for every 
red or blue one. This means that the green channel is less prone to noise 
than the red and blue ones, because less of its content has to be calculated 
(extrapolated) from adjacent red and blue elements. 

Mastering Digital Nude Photography22



Equipment and Software 23

So the image is actually significantly constructed out of data which, rather
than being directly derived from the light falling onto the sensor, has been
calculated by the camera’s software. In addition, sensors are prone to a 
phenomenon known as blooming, whereby an element hit by more light than
it’s capable of storing allows some of that extra light to spill over into adja-
cent elements, resulting in a fringing effect, similar in appearance to the chro-
matic aberrations produced by some budget lenses. This is illustrated in
Figures 1.24 through 1.27 (Remember that when I talk about light here, I’m
actually referring to the voltages by which the light is represented in each 
element: A high voltage in one element can raise the voltage in adjacent
ones.) The smaller the sensor (or the more elements a sensor of a given 
size contains), the more blooming will occur, because the elements are 
physically packed in more densely.

Figure 1.23 The pattern of 
filters laid over the grayscale
sensor is shown (on a very
exaggerated scale: each square
here is 100 � 100 pixels)
across the center of this image.
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Figure 1.24 The brightest part
of the background is slightly
overexposed.

Figure 1.25 Typical purple
blooming is visible here along
the edge of the background
paper lit most strongly by the
studio strobe.
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Figure 1.26 Working outdoors
with bright sunlight.

Figure 1.27 Here the bloom-
ing in the foliage creates a 
yellow-green fringe. There is 
no information at all in the
white areas within the fringing.
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This description of the way the image is formed applies to most makes of
camera. Some cameras, however, use a different technology. The Foveon sen-
sor, employed by Sigma in its digital SLRs, employs a three-layered sensor
with filters, which can store “real” (not interpolated) values for red, green,
and blue at every position in the array. This means that less data processing
is necessary to generate the whole image, but Foveon sensors (see Figure
1.28) have other drawbacks in terms of production cost, speed, low light 
sensitivity, and color accuracy, which mean that in practice their benefits over
Bayer pattern type devices are not as great as might first appear. It’s not clear
whether either technology will win out over the other, or whether different
camera manufacturers will continue to use both. For your purposes, neither
technology has an edge over the other: Both work fine.

Figure 1.28 This schematic
diagram shows Foveon 
technology’s three-layer sensor.
Each of the top two layers is
capable of recording one color
and allowing light of the other
color(s) to pass through to the
layer(s) beneath. 
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So, having said all that, what about image size? How much does it really 
matter? Is it worth trading up from a 4-megapixel (MP) camera to a 6MP
camera? From a 6MP camera to an 8MP camera? I think that the greatest
advantage to be gained from bigger images is the capacity to crop them hard,
and still have enough information left to be able to display the results at an
adequate scale either on the Internet, or, more significantly, as prints.

To take a rather extreme example: Assume that the largest size you’d want to
display an image on the Internet is 800 pixels. In the case of an image in 
portrait orientation, you could crop away more than three quarters of a 
6MP (3,000 � 2,000 pixel) file, and still have a crisp, clear image for
Internet display. On the other hand, you would be in some difficulty if you
wanted to make a 10 � 6.6 print (see Figures 1.29 through 1.31) from that
same small area of the image. In the more likely situation, where you’ve
cropped maybe a couple of hundred pixels of each side of an image, it should
still print beautifully at 10 � 6.6. Indeed, if your printer has good inter-
polation capability, you should be able to print such an image much larger
than 10 � 6.6.

Figure 1.29 

A full 3,008 � 2,000 pixel
image will print comfortably 
at 10 � 6.6 or larger.
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Figure 1.30 An 800-pixel-high
section from the same image. It
doesn’t look too bad at this
size, but…

Figure 1.31 …this is what the
image looks like, if you try to
print it at 10 � 8. Loss of
image quality is clearly visible
in the corset’s edges, lacing,
and eyelet.
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It’s possible to print images very satisfactorily up to 4' high from slightly
cropped images, for example on Epson and HP large format printers. And it
goes without saying that the way to avoid having to attempt extreme crops is
to shoot carefully and thoroughly, covering every possible angle and framing
your subject appropriately, as Figure 1.32 demonstrates! 

Figure 1.32 Do as I say, not 
as I do! There’s a lot of empty
space in this image (about 13
percent of its height), as the
possible crop lines indicate. I
don’t think the extra space adds
anything to the image. The
crop limits the maximum size
at which the image will print
cleanly. 



If you’ve ever done your own printing from 35mm negatives, you’ll recognize
the similarities between the old and the new technologies here. Even a 
full 35mm frame will only print so big (depending on the film speed, the
quality of your camera and enlarger lenses, and so on) before the result looks
too soft or grainy to be acceptable. And the more you crop the image, the
sooner you reach the system’s limitations.

Probably because I’ve used 6MP cameras for a few years now, I feel entirely
happy with that image size. I get images which are sharp enough, or, if they’re
not, can easily and safely be sharpened using Photoshop’s Unsharp Mask
command. With the Nikon 5700 (5MP) I used before that, I occasionally
felt that I was pushing its limits, and getting less than satisfactory prints from
cropped images. However, that may have been due to the less sharp lens on
that camera, as much as to the file being too small to print at the size I was
aiming for. In the end, my decision to upgrade was driven much more by
frustration with the lack of fast, easy manual controls on the camera (see
“Wish Lists” later in this chapter), than by profound dissatisfaction with
image quality or size. 

In mid-2006, several 6MP cameras on the market are still in the prosumer 
category, and more recent models are 8MP or more. If I were choosing a cam-
era today, I think I’d be more influenced by other operational features than by
pixel count in choosing between 6MP and 8MP models; and if I were buying
a camera kit complete with lens, I’d also be influenced by the quality of 
the lens that was included in the kit (see the discussion of lenses next in this
chapter). Having said that, though, I don’t think I’d be tempted by a camera
with an image size of less than 5MP for photography of the nude.

Lenses
In mid-2006, the market is still dominated by lenses designed to be used
with both 35mm and digital SLRs, with small numbers of models designed
exclusively for digital SLRs just beginning to appear. Digital-only lenses are
designed and built to cover only the field of view of the sensor used by that
camera manufacturer in their digital SLRs. Such lenses can be made smaller
and lighter (and, hopefully, cheaper) than 35mm lenses. 

I’ve assumed in this section that your preference is for zoom lenses, rather than
for fixed focal-length lenses. The main reasons for this are budgetary. Fixed
focal-length lenses are often faster, but they’re relatively more expensive, 
and it takes two just to cover both ends of the range of a zoom lens, to say
nothing of all the focal lengths in between. On the other hand, some special
lenses, notably fish-eye and other very wide-angle lenses, are only made as
fixed focal length. 
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The zoom lenses included in camera kits are typically around 18–55mm
(Canon Rebel XT) to 18–70mm (Nikon D70). Taking into account the
multipliers for each camera (see “Sensors” in this chapter), this gives a real
maximum field of view equivalent to 88mm (55 � 1.6) and 105mm (70 �
1.5), respectively. As is often pointed out, you get more close-up for your
money on digital SLRs, but at the same time you get less wide angle: 48mm
and 52.5mm respectively, neither of which really counts as wide angle at all,
if you’re looking to use the lens to make your images visibly bend.

A note on 35mm equivalence: In the longer term it’s possible that the 
market in digital cameras will simplify itself, and one sensor size will emerge
for digital SLRs as a widely accepted standard, analogous to 35mm in film;
but there are no indications that this will happen any time soon. So, even if
you’ve never used a 35mm camera, these digital lenses’ ratings in terms of
35mm equivalence are still significant, as they’ve become the accepted way of
comparing the range of one lens with that of another.

Here, your choice of technology impacts on your aesthetic. The field of view
you choose to work with plays a significant part in giving each of your images
its look. It’s not the only factor, but it’s an important one. It seems to me that
it makes good sense to choose, as your main lens, one that suits most of your
needs so you don’t have to change lenses too often or invest too much in 
several different lenses. I’ve found that I like to work with a certain amount of
spatial compression in my shots. It adds a feeling of strength and power to the
body and gives me the look I prefer. (It also allows me to work at 
a distance from the model, which can be a reassuring comfort factor for 
inexperienced nude models.) Although a field of view equivalen to 105mm on
a 35mm camera can give rather too much compression for some portrait
shots, it’s become my default setting for nude images. At certain angles the
compression created by this field of view produces an almost distorting effect
on the limbs, which in itself can be very effective in conveying a sense of 
erotic power and presence. The result is that I work predominantly with the
35–70mm zoom lens set to 70mm, moving backward and forward in relation
to the model to alter the frame, rather than using the zoom to reframe.

Fortunately my studio is just deep enough, front to back, to allow me to
frame a single standing model full length with my lens set to 70mm.
Unfortunately, the ceiling isn’t high enough to let me do the same thing 
overhead with a model lying on the floor—let alone the chaise lounge! I can
produce some pleasing overhead images, and frame the model fully, with the
lens zoomed to its widest setting, but they often seem to me to lack that sense
of the model’s almost physical presence in the image that I get with lens at
70mm. And with more than one model (see Figure 1.33), the whole 
question becomes more complicated.
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Figure 1.33 Working with
three models in a confined
space presents a stimulating
challenge.



Stepping up to longer focal-length lenses, I find the 105mm lens invaluable
for bodyscapes and outdoors for landscape work (with or without nude
model) as described earlier. You can see my 105mm lens in use in Figure
1.34. My least useful purchase has been a 100–200mm zoom lens—unusable
without a tripod, not sharp enough, and exhibits too much compression.
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Figure 1.34 Landscape
with nude, shot with the
105mm lens.
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It’s with shorter focal-length lenses that the possibilities for nude photo-
graphy open up. Probably the most famous exponent of the wide-angle 
classic nude is the British photographer Bill Brandt, who produced a 
stunning series of black and white images in the 1950s, which exploited the
power of wide-angle lenses to bend and distort objects in the foreground.
The visual means Brandt explored then have become more commonplace,
but there’s still scope to explore them. Here, however, you encounter the
downside of the “field of view multiplier” phenomenon that is peculiar to
digital cameras. A (relatively inexpensive) wide-angle zoom is likely to have a
minimum focal length of about 18mm—a field of view equivalent to 24mm
or 35mm camera. That isn’t very wide: It allows only moderate distortion.
My favorite wide-angle lens is the far-from-inexpensive 12–24mm (the
35mm film equivalent of around 18mm at the widest), which really does
make it possible to bend the world out of shape. See Figure 1.35. I’m lucky
enough to be able to borrow one occasionally, but much as I love it, I’m not
sure I’d ever buy one because I wouldn’t use it often enough to justify it. But
even if you can’t borrow lenses that you can’t justify buying, rental stores will
rent you what you’re looking for.

Figure 1.35 Working with the
12mm lens. 



The same applies to fish-eye lenses. Like very ultra-angle lenses, these can be
tricky to work with: All sorts of unexpected elements from your location are
likely to find their way into the circular edge of the image, including your
feet. Fish-eye images have an unmistakable look (see Figure 1.36), and it’s
always a challenge to come up with a new and different way of using them. 
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Figure 1.36 Working with the
fish-eye lens.



Stabilizing the Image
Working with a 70mm lens, I regard anything slower than 1/50 second as a
long exposure which needs the camera to be held in a steady position. This
avoids camera shake caused by my hands being fractionally unsteady, or even
by my breathing. This means that when shooting interior nudes by window
light, I use a tripod frequently. There are other ways of steadying images,
however, and we’ll look at those as well.

Tripods
The technology of tripods may not be as spectacular as that of cameras or
computers, but it includes a wide range of designs, in a pretty competitive
marketplace with new products and gimmicks arriving frequently. A good
tripod should make it easy (or at least no more difficult) for you to work.
This suggests that as well as holding the camera steady, the tripod legs and
the head need to be easily, rapidly, and precisely adjustable; and they need to
stay put after you’ve adjusted them, without sagging or twisting. 

Now you start to run up against some practical problems. To be comfortably
portable, a tripod needs to be light. To work effectively, it needs to be heavy,
both to ensure stability, and because accurately adjustable head mechanisms
are not, by their nature, lightweight. Weight is less of a problem in the 
studio (see Figure 1.37), because you never have to move the tripod very far,
but it does become a real issue on location, where you have lots of other
equipment as well as the tripod to manage. And it’s surprising how little
breeze it takes to make a fully extended lightweight tripod sway gently, with
a bulky camera and lens attached, with unfortunate effects on your sunset
shoot. This is an area where lightweight components such as carbon-fiber legs
and magnesium heads may seem attractive, but may not be helpful unless
you also use a stone bag—a small bag filled with anything heavy and hung
from below the tripod head to help keep it steady.

Good tripods aren’t cheap. I work with a fairly heavy Manfrotto tripod,
which is indeed a nuisance to lug up a mountain, but does its job properly
when I get there. Usefully, the head can be easily unmounted from the 
column, which makes the whole thing easier to pack. The legs have 
quick-release locks, and the column can be mounted horizontally, as well as
vertically, which can make it easier to achieve some close-up shots. When the
tripod’s completely extended, I need to stand on a short ladder to get my eye
up to the viewfinder.
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But the real reason for choosing this tripod is its friction head. The head has
three rotary controls to let you adjust its position continuously and precisely
in three planes: pan, vertical tilt, and lateral tilt. As you turn each knob, the
head moves in that plane. Each control also has a clutch mechanism, which
lets you disengage the control and move the head freely in that plane, to
make large adjustments rapidly. Once you have the camera positioned, it
stays exactly where you set it, without requiring a locking mechanism. The
head also has a mounting plate and quick-release mechanism, so that you 
can get the camera off the tripod quickly if you want to scout around for 
different shooting positions. It’s an impressive combination of ease, speed,
and precision. Compared to conventional three-axis heads with locking
mechanisms, this friction system may be fractionally slower, but it’s much
more precise.

Ball-and-socket heads are also worth considering, particularly models that
have a clutch mechanism operated by a pistol grip, rather than just a locking
screw, to lock the ball in the right position. Such heads are fast to adjust, even
to extreme angles. However, they are tougher to position precisely; when the
clutch is engaged, the head can move freely on all three axes, whereas on a fric-
tion head you can adjust each axis separately without impacting the other two.

Figure 1.37 Last of the
evening light: 1/25 second 
at f/3.5.



Image-Stabilizing Lenses
Nikon calls stabilizing lenses Vibration Reduction (VR) lenses; Canon describes
them as Image Stabilizing (IS) lenses. In each case the additional technology
installed in the lens is designed to detect and counteract camera shake, by
making minute counter-movements of the lens elements. Thus, you can 
produce sharp images, without a tripod, at slower shutter speeds than would
otherwise be possible: at 1/15 sec rather than 1/60, say. The most useful for
your purposes from Nikon is a 24–120mm f3.5–5.6 zoom; Canon’s range
includes a 17–85mm f4–5.6 zoom and a 28–135mm f3.5–5.6 zoom. (Note
that at present there is a price to pay for the stabilization technology; the 
lenses are relatively slow.) Both manufacturers also make a range of telephoto
lenses with image stabilization incorporated. Nikon has also incorporated VR
technology in their Coolpix 8800, a sign of things to come in high-end 
compact cameras. Panasonic, with a depth of experience in stabilizing video
images, now also incorporates stabilization in their still cameras.

Stabilizing Sensors
Konica Minolta has taken a different approach. Their Maxxum 7D has a
“body-integral anti-shake system.” Rather than moving the lens elements to
compensate for camera shake, it moves the sensor in the camera body. One
immediate advantage is that the photographer incurs the additional cost of
incorporating the stabilization system once only, rather than having to pay
for it in every lens. 

Light and Lighting
Photography of the nude is essentially about observing and experi-
menting with light falling on the human body. Understanding and using
appropriate light sources for their different emotional effects (and rejecting
inappropriate ones) is therefore a key part of the process. In this section you
look at some possible light sources; in Chapter 3 you look at how those
sources can best be used.

When I talk about hard light or soft light, I’m really describing the shadows
cast by a particular light source. Soft shadows have blurred, indistinct edges
(so it’s hard to tell exactly where the shadow begins) and, in a correct 
exposure, aren’t solid black even at their deepest point (so you can still 
see color and detail). Figure 1.38 is an example of soft light. Hard shadows
have sharp, distinct edges and may drop to complete black, with no visible
detail, at their deepest point. Figure 1.39 shows a hard light example. And
the real world provides combinations and blends of these two extremes; see
Figure 1.40.
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Figure 1.38 Soft light, here
coming from the viewer’s left,
softly molds the model’s shape.

Figure 1.39 Hard light creates
a forceful contrast with the
model’s pregnant curves.
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Daylight

Daylight can be anything from the glare of the summer sun overhead at noon
to the soft, lingering, golden rays of sunset on a hazy winter day. In terms of
equipment, the simplest aids for working with daylight are a polarizing filter
and a collapsible reflector about 4' in diameter. The polarizing filter helps
you hold the color in the sky or in water without blowout (losing highlight
detail) and the reflector permits you to lighten shadows. Figures 1.41 and
1.42 show shots with and without a polarizer. Figures 1.43 and 1.44 show
work done with and without a reflector. 

Figure 1.40 Working out-
doors, light shining through
my oak tree is hard, soft, and
everything in between.
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Figure 1.41 Shot without a
polarizer. 

Figure 1.42 Shot with a 
polarizer. 
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Figure 1.43 Working outdoors
without a reflector. Note
the relatively flat look of 
the skintones. 

Figure 1.44 Compare the
same setting, but with a 
reflector bouncing some 
sunlight back into the shot. 



Working indoors with window light, you’re less likely to need a polarizer, but
a big reflector is an important item of equipment. One common type is made
of fabric, measures 6 � 6', is white on one side and gold on the other, and
can be attached to a lightweight, self-supporting frame that is collapsible for
storage. The gold side reflects warmer light back into the scene and works
particularly well for images that are going to be converted into black and
white. Figure 1.45 reveals the gold side of a reflector. 
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Figure 1.45 Use a large 
reflector to bounce window
light back into the image.
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Built-in Flash
Most digital SLRs have rather low-powered built-in flash units, perhaps
because more powerful flash units would be too bulky and would quickly
drain the camera’s battery. Possibly also the makers realize that a photographer
who’s invested that much in a camera will also have other light sources at his 
disposal, and is unlikely to make much use of the built-in facility. Flash units
located next to the lens are prone to generating red eye in subjects looking
directly at the camera, but even if your camera has some form of red-eye
reduction built in there’s still a problem: The flash is located so close to the
lens that its light is always frontal, harsh, and unflattering, its overall look flat
and uninspiring. See Figure 1.46.

Figure 1.46 Built-in flash has
little to recommend it. 
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On-Camera Flash Units
High-specification, dedicated, on-camera flash units are more flexible in use:
They offer impressive levels of synergy with the camera, responding and
adjusting their outputs automatically as you vary zoom or aperture. They also
generally have a manual mode in which the output can be varied by 0.3 stops. 

When you use on-camera flash as your principal or only light source, the
extra distance between the flashgun and the lens, by comparison with the
built-in unit, makes red eye less of a problem, but it doesn’t do much to over-
come the problem of the light’s directional quality. Strong frontal lighting
minimizes the shadows on the subject and thus plays down the form and
contours of the body (while at the same time possibly creating very large
shadows in the background). However, the on-camera unit comes into its
own in other ways. It doesn’t offer a convincing alternative to studio-type
flash heads (see the later section), but when unavailable, or there isn’t enough
space (or a power source) to deploy them, on-camera flash can 
produce very satisfactory results

Some units include a Fill option, which senses the ambient light levels in 
the scene and varies the flash output to ensure that the subject is well lit,
without taking away the feel of the ambient lighting. You can achieve the
same results with a certain amount of trial and error by manually adjusting
the output. This is an instance where the ability to check your results shot 
by shot as you work (and without running up a huge bill for film and 
processing) is particularly helpful. And because on-camera flash units are 
battery powered and very portable, they provide a source of fill-in light 
outdoors (see Figure 1.47) as well as indoors.

Figure 1.47 On-camera strobe
used as a fill light in a location
shoot helps to create this high-
key rendition of skin tone.
Note the fairly hard-edged
shadows, noticeable on the
model’s calves. 
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High-key images contain predominantly lighter tones, with most of the rest
of the image occupying the mid range. A high-key image should also contain
small areas of black, without which it will look flat and insipid.

On-camera units also work well indoors as bounce light sources, where the
flash is angled upwards and reflects off the ceiling, which acts as a large 
diffuser/reflector. (The ceiling needs to be white, or very close to white.) Too
high a ceiling may not bounce enough light back into the scene; too low a
ceiling may not diffuse the light widely enough. The unit’s sensors may only
work when the flash head is pointing straight forward, so getting the output
level right when using the flash in bounce mode may again require a certain
amount of trial and error. This can also be a very effective way of using the
flash as a fill source, while preserving the feel of the natural light on the scene.
See Figure 1.48.

Figure 1.48 On-camera strobe
bounced off the ceiling.



Finally, one of the most useful adjuncts to an on-camera flash unit is an
extension cable, which allows you to position the flash unit away from the
camera. The extension cable should connect to your camera’s hotshoe at one
end, and the other end should be another hotshoe (tapped underneath so
that you can attach it to your tripod) to which the flash unit is attached. Even
if the cable only allows you to move the flash three or four feet away from
the camera, it will give you scope to experiment and discover different effects.
See Figure 1.49.
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Figure 1.49 Shot with the 
on-camera strobe head set 
to one side. A striking look,
resulting from the position of
the head and the hard-edged
lighting it produces. 
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Continuous Lighting
Continuous lighting harks back to the days before flash units were widely
available. Originally, continuous light sources were high-wattage tungsten
lamps like those used in Hollywood movie lighting, but today they’re more
likely to be color-balanced fluorescent sources: either a single high-wattage
lamp or possibly an array of lower-powered lamps, enclosed within a 
diffusion unit to prevent multiple shadows. Such lamps last much longer
than tungsten, and run much cooler as well.

The main use I make of continuous lighting is to shoot slow-motion images.
With the right combination of positioning of the light source and aperture,
it’s possible to get down to a slow shutter speed (around 1/4 sec). This 
captures the blur of movement very effectively, as you can see in Figure 1.50.

Figure 1.50 Motion blur using
a continuous lighting source.
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Ordinary domestic lighting sources are well worth experimenting with also.
Because small, portable domestic sources such as reading lamps tend to be low
powered (compared to “real” photographic lights) and only light small areas,
it can be difficult to get light levels high enough to avoid unintentional blur
with them and to get their illumination to spread wide enough, but at the
same time they are very atmospheric. See Figure 1.51. Figure 1.52 shows that
candles also work well.

Figure 1.51 A classic of 
modern industrial design, the
elegant design of this Tizio
lamp contributes to the image.

Figure 1.52 A simple setup
using candles.



Also in the category of continuous lighting, I should mention blacklight
(ultraviolet light). More often encountered as part of the “clubbing” scene,
blacklight works with ultraviolet-sensitive body paint to produce the startling
results shown in Figure 1.53.
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Figure 1.53 Ultraviolet-
sensitive body paint.



Flash Heads
In the past few years flash heads have become increasingly sophisticated, as
well as smaller and lighter. The most important development has been the
introduction of continuously variable flashes, whose output can typically be
reduced to as little as 1/32 of full power, making it possible to work with
shallower depths of field. Flash heads are designed to accept a range of attach-
ments, such as barn doors, brollies, snoots, and softboxes. You look at the
uses of each, and the different types of light they produce, in more detail in
Chapter 3, but it’s worth making a brief comment on softboxes now.

Softbox light mimics cloudy sunlight or north light, and is both flattering
and sensual. A good softbox is an essential tool for most styles of nude 
photography. But because of the way they’re designed (with a series of 
diffusers located in front of internal reflective surfaces) lights equipped with
softboxes suffer from a sharp fall-off in power as you move them farther away
from your subject. Unfortunately, most flash kits seem to include only 
minimal attachments: one brolly, for example, one snoot, and one too-small
(maybe only 2 � 2') softbox. The most valuable additional investment you
can make for your lighting kit is a very large softbox that you can work with
close to the model: 4 � 3' isn’t excessive, and 6 � 6' or 6 � 3' is even 
better. See Figure 1.54.
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Figure 1.54 Softboxes: the
bigger the better!



How many flash heads? You can buy kits of two heads or three heads, all of
the same power or of different outputs (for example, a kit of three 500W
heads, or two 500W and one 250W head). The more powerful heads cost
more than the lower-powered ones, and as a general rule three heads in a kit
cost less per head than buying them separately, or even buying a two-head
kit, then adding one more head later. It might seem to make sense to go for
a three-head kit if you can afford one. However, it’s surprising what you can
achieve with just one head and a big reflector placed opposite it on the other
side of the model; and there are even ways, as you’ll see, of producing near
shadowless high-key lighting with a single powerful head on the camera side
and a smaller one to add a little backlight. A three-head kit could therefore
turn out to be a bit of a luxury; the money might be better invested in a 
two-head kit and, yes, a very large softbox! 

Wish Lists
Leaving aside the question of image size, then, what other features are valu-
able in a camera for the photographer of the nude? Because the market in
digital cameras at every level is so competitive, many features that were con-
fined to high-end models a couple of years ago are now more widely incor-
porated. Even so, it’s hard to imagine getting very far without these things:

� Complete manual control over the camera, with a clear, easily readable 
display of the main camera settings in the viewfinder. Controlling depth
of field is essential in nude photography, so you need to be able to
manipulate aperture and shutter speed as you work, without having to
take your eye from the viewfinder to read data. It’s helpful also to have
separate aperture and exposure controls, whether thumbwheels or some
other form such as up-and-down buttons, positioned so they lie easily
under your hands when you have the camera up to your eye, in either
landscape or portrait orientation. It’s much less useful to have these 
settings only accessible via a menu, or both on the same control. 

� The ability to switch the camera’s color space between sRGB IEC-61966-
2.1 and Adobe RGB (1998). The color space you choose determines
how the camera handles the enormous range of colors in the world—a
range that is much wider than the camera can reproduce. I’ll deal with
this in more detail later in this chapter in “Color Management,” but
it’s very useful to be able to set the camera to use a color profile best
suited to the Internet or print, depending on the destination of 
your images. 
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� A histogram display in the camera monitor. This enables you to assess the
shot’s exposure after you’ve taken it. Some non-SLR cameras also give a
histogram display of the scene before you shoot it, which can be useful
if you’re working with available light or other continuous light sources,
but it doesn’t help if you’re using flash. 

Not all cameras display the histogram full-size in the monitor: Some
tuck it into one corner of the display, which makes it harder to read.
The histogram displays the image’s grayscale values, from black on the
left to white on the right. The higher the histogram at any point, the
larger the areas in the picture at that level of gray. Watching the right
side lets you check that the image isn’t blowing out. Watching the left
side lets you see whether the image goes all the way down to black: 
in other words, whether you’re using the full dynamic range of the
imaging sensor. When the histogram is displayed over the image,
there’s no connection between any point on the histogram and the 
part of the image which lies behind it: To see exactly where your image
is overexposed, the histogram needs to be used in conjunction with a
highlight display.

� A highlight display. Typically this makes bright areas of the image,
which are either fully exposed or overexposed, flash black and white.
This lets you adjust exposure to keep the image within the dynamic
range your camera can handle, and also lets you check whether the 
distribution of light in the image is what you thought it was. As you’ll
see, if you’re shooting RAW, it’s important to get the exposure as bright
as possible, without allowing key areas of the image to blow out. With
time and experience it’s easy to get the knack of using the highlight 
display to set the exposure accurately and quickly to achieve this.
Figures 1.55 and 1.56 exhibit the highlight’s effectiveness.

� Depth of field preview. A stop-down button that lets you preview the
shot’s depth of field as you compose it.

� Facility to record RAW files. After the detailed discussion of RAW earlier
in the chapter, this won’t be a surprise. Not all cameras offer RAW, so
it’s worth checking.
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On the other hand, my personal list of camera features the nude photo-
grapher can probably manage without would include the following:

� Backlight and highlight settings, together with the range of settings for 
night shot, sporting action, portrait. On many cameras these things are
available on one of the main control dials. Although these settings are
meant to help you handle unusual lighting or depth-of-field conditions,
they seem to deal with only rather small deviations from normal 
conditions, and are often inadequate for the more adventurous lighting

Figure 1.55 Well, this looks
like it might be a little 
overexposed.

Figure 1.56 Ouch! As well as
confirming that the image is
overexposed, the highlight 
display shows you exactly
where the overexposed areas
are, suggesting that the lights
need to be repositioned.



setups for which you may be aiming. I’ve also found that to be the case
with the Automatic setting on most of the cameras I’ve used: Auto 
settings seem to handle only moderate lighting conditions without 
typically blowing out the highlights. Unless your nude photography
involves a lot of quick, spontaneous shooting from the hip, you’re likely
to need more control than Auto offers. 

� Direct exposure on the computer by connecting the camera to the computer
with a USB or FireWire cable. With this you use the camera maker’s 
proprietary software to set exposure, aperture, and the like, and to fire
the shutter. Photography of the nude depends on a combination of
spontaneity and thoughtful reflection. I’ve found that shooting directly
onto the computer in the studio kills the spontaneity, without any 
compensating benefits. It’s true that you don’t have to worry about 
filling up your camera storage cards, but cards are cheap. You can always
buy an extra one or two, and taking a few minutes to put a new card in
the camera and start downloading the one you’ve just filled up will give
your model a well-deserved break. The whole setup is pretty unwieldy,
as well, with even more cables trailing round the studio than usual.

� A black-and-white setting. Cameras that have this facility may produce
black-and-white images which are slightly less noisy than the results
you get by shooting in color and using basic methods such as
Photoshop’s Image > Adjustments > Desaturate to create a mono-
chrome version; see Figures 1.57 and 1.58. But in opting to shoot in
black and white, you give up the possibility of using the image in color,
either natural or manipulated; and Photoshop has much more powerful
tools than Desaturate, which give you extensive control over the whole
look of your black-and-white work. Those tools work by beginning
with a color image.

� Video facilities. The day will doubtless come when one imaging device
can both take good photographs and shoot high-quality video (with
high-quality audio). We still seem to be some considerable distance
from it in 2006. 
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Figure 1.57 Taken with the
camera set to black and white,
the image uses the full dynamic
range available, but still has a
rather flat look.

Figure 1.58 Black and white from color, using Image > Calculations to give the image a more dramatic look. 



How Many Cameras?
If you’ve never had a camera fail in the middle of a shoot, you may never have
seriously considered buying a second camera body as a spare. If you’ve had
that alarming experience, I’d guess you may have a spare body already. Even
as a serious amateur, the loss of time, productivity, satisfaction, and if you’re
paying your model, money, caused by your camera ceasing abruptly to work
really make it worthwhile to consider having a spare. Like other forms of
insurance, you hope not to need to use it, but it’s reassuring that it’s there. 

It has to be acknowledged that once you start thinking in these terms, it’s
hard to know where to stop. What about spare lenses? Spare flash heads?
Spare tripods? Is one spare camera body enough? Maybe I really need two
spare bodies, as some books recommend? Should they all be the same model? 

It’s a question of risk assessment, and thus partly depends on how and where
you work. I’ve been through the experience of having a camera body fail 
mid-shoot, so I now have a spare. (I’ve also learned that in the event of a 
camera failure it will take at least two weeks to ship the camera to a repair
agent; have the faults assessed and an estimate given for repair; arrange 
payment; get the repairs carried out; and have the camera shipped back—
a long period to rent a replacement camera!) On the other hand, I’ve never
had a lens or a flash head fail, so I don’t keep spares of those. 

I’ve had flash tubes wear out, of course, and after the occasion on which my
friendly local professional camera store, which always carries spare tubes, had
run out and took 10 days to get one, I certainly keep spare tubes, expensive
though they are, and modeling lamps.

On the day my Nikon D100 failed mid-shoot, the only replacement 
immediately available was a reasonably high-spec, consumer-level digital
camera with a noninterchangeable lens. It wasn’t difficult to learn to operate
its basic controls, but working with it was very limiting, because its lens 
didn’t have the same range as the set of lenses I had with the D100. It makes
sense therefore, I concluded, to have a spare camera whose functionality is at
the same level (or very close to it) as your principal camera, and uses the same
lenses and preferably the same storage cards and batteries. 

Computers
Compared to even a couple of years ago, the power of computers has risen
and the costs fallen, to the extent that it’s almost true to say that whatever
computer you buy today will work fine for carrying out photographic manip-
ulation. A few principles are worth keeping in mind, however, if you’re
choosing new equipment.
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As already mentioned, coming from a background in media production and
still working in that field, I use Apple Macintosh computers. But good
Windows-based computers are just as good for photographic work, and
indeed third-party Photoshop filter creators often release new filters for
Windows first, and produce the Mac versions later (if indeed they get around
to doing so at all).

Desktop Versus Laptop
The main features to look for in choosing a computer are the same, whether
you’re thinking about a desktop machine or a laptop. You’ll need a fast
machine, with a big screen, and lots of memory and storage. Processor speed
is desirable when you want to apply certain Photoshop effects; the big screen
(or the combination of two smaller ones) is useful when you need lots of
Photoshop windows open at the same time; lots of memory lets you make
use of all Photoshop’s facilities on large multilayered files without waiting
while the computer swaps components in and out of memory; lots of 
storage enables you to hold large numbers of large files where they’re 
immediately available.

Current laptops are certainly powerful enough to use for picture editing. The
main drawback in working exclusively on a laptop is the relatively small screen
size and the difficulty of ensuring accurate color on the screen. A fast laptop
with a larger (15"+) external screen attached (and able to support a resolution
of at least 1,280 � 1,024 pixels) can be very effective. It can be a sensible solu-
tion if you do a lot of location work and want a laptop to download your cards
to as you shoot. The only drawbacks may be that a laptop that is your only
computer and leads a rugged life may not be the best place to store your 
precious and irreplaceable files. This leads us neatly into storage and backup.

Storage and Backup
There should be a variant of Parkinson’s law which says that files expand to
fill the storage space available for them. Digital image files can be large, 
particularly if they’re RAW files, and/or multilayered, and/or 16 bit—
anything up to 100MB or more. This means that if you produce images in
any quantity (and most digital photographers do), your storage requirements
are likely to fairly rapidly exceed the single hard drive that was installed 
in your computer when you bought it. Additional drives can be added 
externally or internally. Many photographers now favor external FireWire
drives because they’re cheap, adequately fast, come in very large sizes, are easy
to daisy chain, and if your computer breaks down, can easily be transferred
to another computer. FireWire drives in the 250–500GB range cost as little
as 80 cents per gigabyte—an astonishingly low price compared to even a 
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couple of years ago. Photographers have benefited here from the much
tougher demands made of hard drives by other creative fields such as video
editing and games design, which require even larger capacity and higher
speeds than do photographers. Single FireWire drives are currently available
in sizes up to 2TB.

Your storage requirements also depend on the approach you take when you
review your images at the end of a shoot: whether you keep every picture you
take or ruthlessly select only the best one or two from each set and dump the
rest. If you’ve been the ruthless type so far, cheap mass storage gives you an
opportunity to reconsider your approach, by making it easier and cheaper for
you to hold more images. This offers the creative benefit of avoiding snap
judgments about what to keep and what to reject. This in turn means that 
as you become more skilled at picture editing and manipulation, you can
revisit and make use of shots that might once have been too difficult or time
consuming to put right. 

One way or the other, however, it’s important to address the question of
how to back up and archive your work. Computer professionals talk about
the need to take precautions against “catastrophic” data loss, and the word
is no exaggeration. On the day your only camera breaks down, all you lose
is the rest of the work you were going to do that day and any shoots 
you have to cancel until you can get a replacement camera. When your 
computer’s hard drive fails, you may well lose everything on it, which could
represent years of work. 

Traditionally, backing up means copying files that are still active—for example
they’re from today’s shoot, you’re working on them, need to refer to them, or
are planning to work on them in the near future. They are usually on some
medium which is physically separate from the originals (not just copying a file
or folder onto the same hard drive). Thus you have two identical copies of
every file: the one you work on (stored on your working hard drive) and the
backup copy. Systematic backing up is intended to minimize two broad areas
of risk. One is, as you’ve seen, failure of the hard drive on which the images
are stored. The other area covers loss of data as a result of external events such
as fire, flood, or theft.

Backup is dynamic and needs to be done regularly—every night, for exam-
ple. If my computer’s internal hard drive fails right now, I’ll lose everything
I’ve written today, but everything I wrote up to midnight last night has been
copied onto an external drive, from which I can retrieve it. (In practice it’s
very unlikely that my computer will fail as I’m typing this: Hard drive 
failures, which are the most common form of computer failure, most 
frequently occur on startup, not while the computer’s running. Otherwise
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you’d spend more time backing up than working!) And if I’m away from my
house for any length of time, I can secure that external drive in a fireproof
safe or in some other secure location. Regular backups help guard against
another category of incident: the occasion when you accidentally throw away
a file or edit it in some way that you regret but can’t reverse. Of course this
shouldn’t happen, because of the safe working practices we all take care to
adopt, but it does! How often should you back up? Again, it’s a matter of
assessing the risks attached to the way you work, but a safe answer to the
question is once a day, or just before you switch your computer off, which-
ever happens sooner. Many backup applications allow you to schedule 
backups regularly—overnight when your computer’s not in use, for example.

Because a busy day’s shooting and editing can generate gigabytes of material,
backup systems should be speedy. The best way to achieve this is to use fast
storage devices, together with software which tracks accurately the files that
have been added or altered since the last backup, and copies only those.
Typically such devices will be external hard drives, rather than rewritable
media such as CD-RW (not really large enough if you’re shooting RAW) or
DVD±RW. Most hard drive manufacturers include basic but effective back-
up software with their products, such as Lacie’s Backup Software. More
sophisticated applications are available from other companies, such as EMC
Dantz’ Retrospect for both Mac and Windows.

The advent of cheap mass storage has implications also for archiving.
Traditionally, archiving means copying files—files you’re not currently 
working on, don’t need for immediate reference, and don’t intend to work on
in the foreseeable future—onto another storage medium and then deleting
them from your working hard drive. If you choose to work in this way,
DVD±R, or DVD±RW are effective media, particularly as the next few years
will see significant increases in its capacity, to 8GB and beyond, which will
make it even more suitable. And just as you’ve been careful to keep two copies
of every active file—the working and backup copies—it makes good sense to
make two copies, on two separate DVDs, of everything you archive.

However, this approach to archiving is based on an industrial and commercial
model, where it’s assumed that you really do finish with some of the material
you store on your computer. In the case of a company, for example, a decision
might be taken to archive sales records from three or four years ago, which the
company needs to keep secure, but will rarely need to refer to. And there’s also
an underlying assumption, in this model, that the material you choose to
archive is so bulky that it’s just too expensive to store all online.

Neither of these assumptions seems to me necessarily to apply to the way
photographers work. Photographs are never “finished” in the sense that the
company’s sales records are finished. Many photographers regularly revisit
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old work—maybe to reprint a successful picture; to rework a favorite image;
to make another attempt at fashioning out of a reluctant file the image which
the inner eye insists is in there somewhere; or even just to steal a background
out of one image to use in another. At the same time, as you’ve seen, the cost
of holding a very large number of images online has fallen steeply. Installing,
say, two 400GB hard drives on your system—one for working files, one for
backup—makes it possible to hold a very large number of images (about
70,000 3,008 � 2,000 pixel RAW files, for example) online, with backups.
And the more files you can hold backed up, the less you need an archive and
the easier it is to access any image you need.

Whether or not you opt for the traditional approach to archiving, it can’t 
be emphasized too much that backing up and archiving need to be done
meticulously, and with whatever frequency keeps all your work secure. It’s
also important to check your backup sets regularly: Copy a couple of folders
from your backup drive to your working drive (without overwriting the
working copies of the folders!) and verify that all the files that should be in
each folder are there. Then open a few files at random, use Save As to make
copies of them, and manipulate them in Photoshop to verify that they’re
complete and correct. Figure 1.59 shows this type of comparison. 

Figure 1.59 Compare active
(left) and backed-up (right)
files. Note that the number of
items shown at the bottom of
each window is the same—a
useful quick check.



Monitors
The opportunity to choose between CRT (traditional tube) screens and
LCD/TFT (flat panel) screens is rapidly disappearing, as manufacturers cease
production of CRTs. This is a shame, because dollar for dollar, few LCD
screens can yet match the quality of CRT screens in terms of color accuracy
(particularly black reproduction) and viewing angle. There are no agreed 
criteria among manufacturers for specifying or quantifying color accuracy,
which seems to be of less concern to them than parameters such as contrast
ratio and refresh times.

The LCD market is very dynamic, with frequent improvements and 
developments in the main LCD technologies. (It’s by no means easy to know
exactly what’s in the box when you buy an LCD monitor, as vendors may
switch between these technologies without going out of their way to
announce that they’ve done so.) The most important advice here has to be,
go look: Assess the monitors you’re choosing between by displaying several
images you’re familiar with. It’s worth noting that as well as the familiar 
issue of inadequate horizontal viewing angles, some LCDs may also have 
narrow vertical viewing angles. If you’re not positioned with your eyeline 
perpendicular to the very center of the screen, you may see some darkening
or fading of colors at the top or bottom, as well as to one side or the other. 

After all those cautions, however, there’s some consensus that 17" (and 
larger) LCD screens from Apple, Formac, Ilyama, LG, NEC, Philips,
Samsung, and Sony can be calibrated to give excellent and stable color 
rendition, preferably when connected via their DVI inputs, which provide
much better results than their analog inputs. These preferred screens are
expensive. Smaller and cheaper screens (including most laptop screens) can
be less accurate and less stable in terms of color rendition. Two web sites that
contain very detailed discussions and comparisons of different LCD screens
(without always reaching the same conclusions) are www.xbitlabs.com and
www.behardware.com. 

In Place of the Mouse
I’ve used a graphics tablet for many years. Initially I bought it because of the
risk of developing RSI (repetitive strain injury) from using a mouse all day
while on a nonlinear video editing system. However, I quickly found that the
graphics tablet and stylus were also much better suited than a mouse for still
picture manipulation, which often calls for very cramped and repetitive hand
movements. This applies in particular to any editing process involving
repeated brush- or pencil-like actions (such as painting out layer masks or
erasing areas of an image), where the stylus is faster and more precise than a
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mouse. (This also applies to other applications such as word processors and
spreadsheets, as much as to Photoshop.) I also edit pictures occasionally 
on my laptop using a mouse, and I’ve no doubt that by comparison the
graphics tablet provides a real gain, not only in comfort and safety, but also
in throughput. Using a single screen, the tablet doesn’t need to be huge: the
6 � 8" size works fine. You may decide that a larger tablet (9 � 12", for
example) is preferable if you’re working with two screens, in order to have a
each screen mapped onto reasonably large tablet area.

Printers
New printers appear every day, often at give-away prices for standard 8.5 �
11" sizes. The printers themselves are cheap because the manufacturers make
their money on consumables: ink and paper. It’s difficult to calculate the cost
of an “average” print (and the cost of ownership for a printer) because there
can be so much variation between one image and the next, as Figures 1.60
through 1.62 indicate. 

Figure 1.60 Not much ink 
is required to print this very
high-key image.
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Figure 1.61 This low-key
standing nude consumes much
more ink.

Figure 1.62 Different again!
The varied nature of 
photography of the nude
makes it difficult to work out
how much it costs to produce
an average print.



As you’ve seen, the basic technology of inkjet printers uses four inks: cyan,
magenta, yellow, and black. (Black’s added because the blacks produced by
simply combining cyan, magenta and yellow in full strength lack punch.)
This simple model is gradually being supplanted by printers which seek to
extend the gamut and achieve more accuracy by splitting the four basic col-
ors—for example, by using magenta and light magenta, or cyan and light
cyan. Some printers also offer light-gray and gloss-optimizer cartridges. 

In addition, third-party makers of inks and papers offer products to compete
with those offered by the printer manufacturers. Ilford Galerie Classic Pearl
paper, for example, is cheaper than Epson Premium Semigloss (and also
slightly thinner, at 240g/m2 as opposed to 251g/m2) but looks at least as good.
In terms of calibration, both papers appear to have exactly the same profile. A
number of companies such as Lyson (www.lyson.com) specialize in wide-
gamut inks, which enable you to print a wider range of colors than the print-
er manufacturer’s inks will. Gamut means the range of colors the inks can
reproduce. (A note of caution here: Don’t confuse these products with cheap
third-party inkjet cartridges from your local computer store: Wide-gamut inks
from companies like Lyson are intended to be better, not cheaper.)

High-quality black-and-white printing has always been difficult to achieve
on inkjet printers, because of the likelihood of color casts caused by the
blending of three or more colors to produce black. A number of different
methods of overcoming this problem are emerging. Some printers now use
eight colors, including three blacks: black, light black, and light-light black,
which are claimed to produce exhibition-quality monochrome images.

Piezography (www.piezography.com) produces sets of monochromatic inks
which split the grayscale across four or more intensities, or dilutions, ranging
from light gray through to black, replacing the color cartridges in the 
printer. These ink sets provide wider and subtler gradations of the grayscale
than you can get with conventional CMYK inks, approaching (or it’s
claimed, exceeding) the dynamic range of traditional silver halide printing
papers. The manufacturer also offers different tonal sets, such as cool and
warm blacks.

Another approach is that of Lyson, whose Small Gamut inks enable you to
subtly vary the hue of monochrome images from a precisely neutral grayscale
to warmer and cooler tones. Lyson and Piezography inks produce similar
results, but Lyson’s approach does offer the advantage of producing a range
of monochrome tones from a single set of inks. Figures 1.63 through 1.65
show the different effects.
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Figure 1.63 A cooler black,
using Lyson’s Small Gamut 
system.

Figure 1.64 Neutral black.
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However, it’s impossible to remove and replace sets of monochrome and color
inks in one printer without a lot of waste, so the best solution is to have two
printers. If you do a lot of printing, some printers can be fitted with ink tanks,
rather than cartridges, which need less frequent replacement and cost less per
print. Not all printers are adaptable to third-party inks and continuous 
ink-feed systems. Epson is currently the maker for whose printers (some of
them, at least) the most varied range of third-party inks is available. Larger
printers are also becoming very much more affordable, with sizes up to 24"
wide from HP, listing at around $1,900. 

Finally, printer manufacturers demonstrate their products using files which
have been carefully optimized to show each printer at its best. So when it
comes to choosing a printer, once more the advice is, go look. Run a couple
of your own files through the printers you’re thinking about buying.

Unless you’re intending to produce a large quantity of prints, in which case
buying a large-format printer will work out cheapest in the long run, it 
may be worth approaching local studios to find one which has large-format
printers with spare capacity, on which they’re willing to print your work. This
works out cheaper than using print shops.

Figure 1.65 A warmer, sepia
effect.
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Color Management 
So now you’ve bought your camera, your computer, your monitor, and your
printer. You’ve connected your system and it’s working. What happens when
you download an image from the camera, edit it, and print it?

The Problem
Cameras, monitors and printers all interpret colors differently. When the
photo in Figure 1.66 was taken, the camera’s software converted the light
waves reflecting off the model’s skin to a set of red, green, and blue values (in
the middle of the box the values are R:204, G:193, B:191). A different 
camera using different software might have come up with slightly different
values. When I display the image onscreen, my computer’s software projects
red, green, and blue light onto the screen in the proportions specified by
those RGB values, to produce the “same” color. It can’t be guaranteed that
the color I see onscreen will match the color of the model’s skin. (Again, a
different monitor might make the image look different.) Finally, if I print the
image, my printer converts those RGB values to specify how much of its four
inks (cyan, magenta, yellow, and black) are needed to produce the “same”
color. (In this case the values are C:18%, M:22%, Y:19%, K:0%.) See Figures
1.67 and 1.68 for RGB and CMYK exhibits. There’s no certainty that the
colors on the print will exactly match those onscreen, and it goes without
saying that if I print the image on a different printer (or even use the same
printer, but different paper) the result will look different again.

Figure 1.66 We judge the
quality of color in an image
mostly by the accuracy of the
skintones.



Equipment and Software 69

Essentially the inconsistency between input, monitor, and output occurs
because of the different technologies involved. That is, the color I’ve been
describing is device dependent. Sensors in cameras reacting to light waves
behave differently from streams of electrons in monitors, which in turn aren’t
the same as ink droplets in a printer. In particular there’s a difference between
the monitor, which creates color additively, and the printer, which makes 
colors subtractively. Monitors produce color by combining (adding) red,
green, and blue light in different quantities to produce a range of colors. By
contrast, every dot of color created by the printer combines cyan, magenta,
yellow, and black ink in such a way that all colors of the visible spectrum
except the one that is to be seen at that location are absorbed (subtracted);
only the desired color is reflected. (This is the way we experience most color
in the world. A leaf appears green, for example, because it absorbs the 
wavelengths of all other parts of the visible spectrum and only reflects light
waves from the green range of the spectrum.)

Figure 1.67 Transmitted light:
Red, green, and blue added
together produce white.

Figure 1.68 Reflected light:
The combination of cyan,
magenta, and yellow inks 
produces black.
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There’s a further aspect to this inconsistency. No imaging system available
can record or reproduce more than a small part of the complete visible 
spectrum. However, the range of colors (the gamut) RGB systems can see is
generally wider than the gamut of CMYK. At the same time, CYMK can
handle some colors RGB can’t. So when you print an image, something needs
to be done to fit the wider gamut of RGB into the narrower boundaries of
CMYK.

The Solution
You can solve the problem in one of two ways. In a very simple system, in
which you shoot under constant lighting conditions and always use the same
camera, monitor, editing software, printer, and paper, you can improve your
results by tweaking your monitor and printer settings by trial and error, until
you get satisfactory output from the printer (output which looks the same as
what you see onscreen and in the original scene). However, this approach
places a lot of reliance on your subjective judgment of what looks right, and
can be time consuming and frustrating. It also needs redoing whenever any
component of your system changes. 

A more reliable and long-term solution can be obtained through color 
management. Color management works by using, as a reference, a standard
color space (a set of colors) that isn’t related to any specific device (device
independent). The colors produced by any device can be transformed into
the standard color space; once that transformation is done, the standardized 
colors can be transformed again according to the requirements of any other
device. (Once all your equipment is correctly set up and calibrated, these
transformations happen automatically.) The preferred standard color space
is Adobe RGB (1998) if you make prints of your work; see Figure 1.69. If 
you only display images onscreen, then sRGB IEC-61966-2.1 may be
preferable (see Figure 1.70), but note that you generally get better results if
you switch an image’s color space from Adobe 1998 to sRGB, than the other
way round. As well as setting your camera to work in whichever space you’ve
chosen, you should also set Photoshop to the same working space.
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Figure 1.69 The two color
spaces do look very different.
This test chart was shot with
the camera set to Adobe RGB
(1998) and viewed with
Photoshop set to the same 
profile. 

Figure 1.70 Here’s the same
image with its profile 
reassigned to sRGB 
IEC-61966-2.1.
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How are these transformations carried out? A profile needs to be created for
your monitor and another for your printer. (You can’t create a profile for
your camera, because you can’t alter its software, but the camera’s software
should allow you to set it up to use a predefined color space.) To profile a
monitor you use a colorimeter (an optical instrument that measures the 
relative intensities of reflected or emitted red, green, and blue light) with
appropriate software. The software generates a series of colors on the 
monitor, and the colorimeter is positioned against the monitor to measure
the colors and check whether what the monitor thinks is red, for example,
is the same as the red of the standard color space. If it isn’t, you adjust the
monitor settings until it is, using the onscreen readout from the colori-
meter to tell you when you’ve got it right; and the same with green, blue,
and a range of gray points. In other words, this method does objectively
(and therefore much more reliably) what you’d do by eye if you didn’t have
the colorimeter, with the other great advantage that the software remembers
the settings you create and saves them into a file—the profile for your 
monitor. If you use more than one monitor, you need to profile each one,
which you can see being done in Figure 1.71.

Figure 1.71 Using an Eye-One
colorimeter to profile a CRT
monitor.
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To create a profile for your printer, print the color test chart included in your
color-management software. All of the color values on this chart are known
and defined within the standard color space. You then run the colorimeter
(shown in Figure 1.72) over your print of the color chart (let the print dry
first) to measure the actual colors produced by the combination of printer,
inks, and paper you’re currently working with. The software uses the 
colorimeter readings to build up a table of equivalent values—a list of the
adjustments to be made to the colors the printer produces, to ensure that
they all look as close as possible to the corresponding colors on the original
chart. (This table is often referred to as a LUT, or look-up table.) If you use
different printers, papers, or inks, repeat the process for each combination.
Again, each profile produced in this way is saved and applied when you’re
printing with that particular setup.

Figure 1.72 Using the 
colorimeter to calibrate 
a printer.



You can now see how color management fits the disparate elements of your
system together, assuring you of color consistency and ensuring that you can
trust what you see: 

� You’ve set the camera to work within your chosen color space. When
you do that, the camera tags every image. The tag is an instruction to
your picture-editing software to open the picture file into the same
color space within which it was shot. 

� You’ve profiled the monitor so you can be confident that the colors it
displays are correct for that color space. 

� You’ve profiled your chosen combination of printer, ink, and paper, so
that the colors you see in prints match the colors on the monitor.

Color management utilities aren’t exactly cheap. For example, the entry-level
Eye-One kit from GretagMacbeth lists at around $1,100. (Most of that is
cost of the colorimeter.) It seems a lot to pay for equipment you may 
only need to use four or five times a year. But in most big cities, a growing
number of color-management companies will come to your studio and 
calibrate and profile your system for you. Indeed it’s possible to get your
printer profiled by printing a color-management company’s printer 
calibration chart and posting the print to them. They will calibrate the print
and email you the resulting profile, which you can install on your system.

This is also the right moment to give some thought to the working environ-
ment in which you edit your pictures. There’s little point in calibrating your
monitor and your printer if the light in your workspace varies significantly
from one time of day to another, or throughout the year. Workspaces for
editing pictures need to be rather bland and as consistent as possible: no
vividly colored surfaces, no bright lights casting shadows over the monitor,
no direct sunlight. If possible, illuminate the room with daylight-value 
fluorescent tubes, with diffusers, or daylight-value incandescent lamps. Some
monitor manufacturers provide hoods for their screens to prevent light
spilling onto them from above or from either side.
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Why deal with models, in detail, in a book which claims to deal with
advanced nude photography? At this level, doesn’t every photographer know
everything about models? Not necessarily. Every conversation I have with
models about their experiences with photographers at every skill and 
experience level suggests that many photographers still treat models with less
than the respect, sensitivity, and clear, truthful communication to which
they’re entitled. See Figures 2.1 through 2.3. So, on the one hand this section
is written mainly for photographers who may be well versed in other types of
work, but are relatively new to working with models, and with nude models
in particular; and on the other hand I hope that it may also prove thought
provoking to experienced photographers of the nude as well. 
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Figure 2.1 A careful start to
the model’s first nude shoot,
including a nice cup of tea.
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Figure 2.2 Easing into the
shoot: a set with the model
wearing her own lingerie.

Figure 2.3 Posing nude, with a
little jewelry.



Modeling seems to appeal to many women, as well as quite a few men.
Modeling web sites add dozens of new entrants to their membership every
week. Many, perhaps most, of these will drop out after no more than a 
couple of shoots; but there’s still no shortage of models to choose from. In
the U.S., variations in community standards from state to state or district to
district over issues such as pornography seem to be reflected in the local 
availability of models. For example, you’ll probably find more models willing
to pose nude in New York City than you will in the Bible belt. This occurs
to a more significant extent than in other countries such as the U.K. In what
follows I’ve assumed that you live, or at least do your photography, in an area
where models are available. See Figures 2.4 through 2.6. 
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Figure 2.4 Even in the U.K.,
where distances between towns
aren’t enormous, it’s very 
helpful to be able to work 
with models who live locally.
Caz is one such model…
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Figure 2.5 …as is Eliz…

Figure 2.6 …and Emily, seen
here preparing for a body-paint
shoot.



Choosing a Model
Photographers often come to photography of the nude with a notion already
formed of the look they want their model to have. It may be an idealized,
perfect, unattainable image; maybe it’s based on the film stars of your youth,
or a favorite painting, or your first crush. Or it might be nothing more than
a liking for models who are, for example, curvy and voluptuous, or models
who are slender and more boyish in appearance. Your preferences may focus
on color and length of hair, and so on; see Figures 2.7 through 2.9. 
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Figure 2.7 Catya was one of
the first models I worked with.
Looking at her…
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Figure 2.8 …at KO, and…

Figure 2.9 …at Red Lilly, two
other models I worked with
then, it’s clear that at the time I
must have had a penchant for
long hair!
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For your first nude shoots, there’s nothing wrong with encouraging your
visual imagination by seeking out and working with a model who 
approximates to the appearance of your ideal woman or man. But over time,
most photographers seek to broaden the range of models they work with,
motivated by the desire to test out their growing skills and to develop a
diverse portfolio. And perhaps there’s also a feeling that somewhere out there
is the perfect model for you, if only you can find her. I did, once. Sadly, she
then started full time at college and gave up modeling. Back to the drawing
board…. (There are some noteworthy exceptions to this principle of 
working with diverse models. The great American photographer William
Stieglitz [1864–1946] photographed his lover [later wife], the artist Georgia
O’Keeffe, over a period of about 20 years, producing some stunning nude
images. Throughout most of that period, she was his only nude model.)

Nude models don’t have to be outstandingly beautiful, or physically perfect,
or sexy, or only just 18 years old (although in most countries they must be at
least 18). Nude photography is about creating beauty in the image, and that
doesn’t just mean taking a photograph of a perfect model. Powerful and 
moving images can also be made from imperfect bodies and from the marks
which time and experience leave. Indeed, models who are stunningly 
beautiful may make life too easy for the photographer, letting him get away
with paying less attention to all those other things which make up a great
image: lighting, location, depth of field, camera angle, and so on. See Figures
2.10 through 2.12. 

Figure 2.10 Disability
combined with confidence 
in front of the camera can 
produce original and powerful
images.
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Figure 2.11 Some models have
such grace and beauty that it
seems the photographer has
only to press the shutter.

Figure 2.12 The marks of life
and experience.



On top of all that, beauty can, as we know, be in the eye of the beholder: The
models I find lovely may not appeal to you, and vice versa. I’m fascinated by
tattoos and piercings, as Figure 22.13 shows, but they don’t appeal to every
photographer. 
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Figure 2.13 The background
is unconventional for a model
with such a distinctively urban
appearance, and it heightens
the viewer’s attention. 



As you work with more models you’ll become increasingly aware of the 
factors, other than the model’s appearance, which can make a vital difference
between a good shoot and a mediocre one. It’s a question of whether you
click with the model. This is an experience which is as hard to predict as it is
to define. But you’ll quickly find, with models as with everyone else you
meet, that you get on better with some than others. Maybe you share a sense
of humor or a love of cats! You feel relaxed as you work with her, and more
able to focus on getting every shot right. A bond of trust quickly develops
between you. And as you develop your own photographic style, you’ll also
find that some models seem to have an almost intuitive grasp of what you’re
trying to do. They’ll offer suggestions for poses, costumes, and setups (and
won’t be offended if you politely decline their ideas), and during the shoot
will move quickly and smoothly from one pose to the next. This capacity to
work effectively with you is at least as valuable a quality in a model as the
most stunning beauty. These are the models you’ll want to work with again
and again; see Figures 2.14 through 2.16.
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Figure 2.14 Gradually I 
started to work with models
with very different looks.

Figure 2.15 I always look for
people I feel comfortable with.



Working with such models will be a pleasurable experience for you and the
model. It’s also a productive process: You’ll take more photos, and of better
quality, in a given period of time. And as your experience grows, your capac-
ity to put models at their ease and get the best out of them will also improve.

It also has to be said, by way of warning, that feeling 100 percent in sync with
a model as you work is no guarantee that the results will be wonderful! And
you may also encounter models you find it hard to work with, but with whom
you still make great images. It’s a good idea, then, to work with 
different models in order to diversify your work. Some photographic ideas and
projects may call for a specific attribute necessary for the way you’ve 
visualized the shoot: a particular coloring, build, or height, for example. See
Figure 2.17. On the other hand, a model’s look when you see it in her port-
folio may suggest a particular image or approach; see Figures 2.18 and 2.19.
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Figure 2.16 And I look for
people who feel comfortable
with me.
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Figure 2.17 Much of this
image’s impact comes from the
model’s skin and hair coloring.

Figure 2.18 The model’s long,
braided hair prompted this
dynamic image, with its 
outdoor setting. 
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Because nude photography is located on one of the borders where art 
meets sex, it’s likely, particularly when you’re first shooting nudes, that you’re
interested in working with a model who fits your own sexuality: straight 
photographers usually choose models of the opposite sex, gay photographers
choose models of the same sex, and so on. (This is a broad generalization, I
admit!) And of course there are other possibilities: male-female couples,
female-female pairs, male-male pairs, and so on. (In my experience, most
female models are willing to work with another female model; few straight
male models can be persuaded into working with another male.)

Broadening your boundaries, for example, by working with two or more
models leads to fascinating challenges, both technical and creative; see Figure
2.20. It’s generally a good idea to combine models only after you’ve worked
successfully with each of them individually. Figure 2.21 shows a photo taken
in my home studio, which has a ceiling height of 10' 6". I wanted to achieve
this shot without using a very wide-angle lens, which would make the 
models look obviously distorted. I ended up at the top of a ladder, my back
pressed flat against the ceiling, using a focal length of 21mm. I’m quite
pleased with the shot, with its relaxed sensuality, but more headroom would
have enabled me to let Naomi (upper left) stretch her legs a little more.

Figure 2.19 The lighting pays
tribute to the model’s figure,
lips, and collarbones.
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Figure 2.21 An unusual 
problem. 

Figure 2.20 The models are
partners in real life, and that
enables them to be more
relaxed with each other than
they might have been if they’d
only just met for the first time.
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Outside the occasions such as those I’ve mentioned, when your idea for the
shoot requires a model with a specific look, I think it’s sensible to approach
the quest for a new model without too many preconceptions about what 
she should look like. My only preference is for models whose faces are 
expressive—in particular for models whose gaze into the camera doesn’t 
suggest passivity or weakness, but instead challenges the viewer or even 
suggests indifference to his presence; see Figures 2.22 and 2.23. But ques-
tions such as the model’s build—voluptuous, slender, tall, short—or hair—
light, dark, long, short—or ethnicity now seem less important.

Figure 2.22 There are a several
elements at work in this image,
but its starting point was the
model’s rather fierce gaze,
which can be discerned even
behind the dark glasses.
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Figure 2.23 Another image
from the Three Graces shoot.
What makes the image work
for me is Naomi’s poised,
direct, unconcerned gaze at the
viewer.



Finding Your First Model
Let’s stay with the perspective and needs of the photographer experienced in
other areas of photography but just starting to shoot nudes. Broadly speaking
there are two ways to find models. There are models who advertise their 
services, on a scale from amateur to professional, usually on the Internet; 
and models you find for yourself, from among friends and acquaintances
(including recommendations from other photographers and models), who
may never have posed nude before. (I’m excluding “real-world” modeling
agencies of the traditional kind, because their role in providing nude models
seems to have been almost entirely taken over by the online modeling sites.)
Over time these categories may become blended: Some of the models you find
online will become good friends, and some of the friends you introduce to
modeling may sign up on modeling web sites.

For the photographer just getting started in nude photography, there’s 
something of a vicious circle at work here. The distinctive nature of nude
photography—the naked model exposed to the gaze and control of the
clothed photographer—is unlike anything most of us encounter elsewhere 
in our lives, and it can be edgy, and, from the model’s point of view in 
particular, risky. Most models are properly cautious, and will require evidence
from you to establish your bona fides. They understandably want to know
that you’re safe to work with, as well as competent. The best form of 
evidence, and the one most models will ask for, is recommendations from
models you’ve worked with in the past; but this is only possible when you’ve
already done a number of nude shoots.

So how can you book a model for your first nude shoot if you don’t yet have
the evidence and references to demonstrate that you’re trustworthy? There are
a couple of ways out of this dilemma.

Demonstrate competence, which you can do by building up a portfolio of
clothed shots, if you don’t already have one: fashion and portraits like those
in Figures 2.24 through 2.26, for example. All three of these images demon-
strate qualities that are as relevant to photography of the nude as they are 
to portraiture. Good portrait shots say a lot for your ability to make your
models feel relaxed, and for your capacity to empathize with them.
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Figure 2.24 Unusual framing
makes a striking image.

Figure 2.25 This playfully
quizzical look suggests a good
working relationship between
model and photographer.



Mastering Digital Nude Photography96

In this context, fashion doesn’t mean models on the catwalk! It’s more a
question of inviting models to bring along some of their favorite garments
to be photographed in. This is a safer form of modeling (and should be
cheaper, if you’re hiring a model) than working nude, and you should have
little trouble in finding models who are sympathetic to the fact that you’re
just getting started and are happy to work with you at this level; see Figures
2.27 and 2.28.

Figure 2.26 A gaze whose
ambiguity challenges the 
viewer. 
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Figure 2.27 A casual look,
carefully achieved.
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If these shoots go well, the models should also be willing to act as references
for you, if you ask them at the end of the shoot. It’s also often suggested that
taking part in group nude or glamour shoots, as organized by some model-
ing web sites, local photography clubs, and studios, will let you develop a
portfolio, thus demonstrating competence. This may be true if the shoot isn’t
too crowded and you have the confidence to make full use of the time you’re
allocated with the model(s). One photographer described his first group
nude shoot as “…like the opening day of trout season and combat photog-
raphy rolled into one.” It’s also unlikely that the models taking part in a
group shoot will get to know you well enough to be able or willing to give
you a reference. 

Figure 2.28 Your clothed shots
don’t all have to be decorous—
a little raunchiness does no
harm at all!
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A brief word on organizing portfolios, applying equally to prints and to 
collections of your work on web sites. When preparing to show work to a 
general audience, I’m convinced that the golden rule is “less is more.” Your 10
best images will have more impact on the viewer when they’re seen by 
themselves, than if surrounded by another 20 mediocre images—particularly
if those 20 images include some which are similar to the 10 best. But when
you’re trying to interest a prospective model in working with you, there’s
something to be said for showing her not just the best image of a set, but also
perhaps two others from that set which you judge to be nearly as good. This
gives the model an idea of how you think visually and of how you run your
shoots. See Figures 2.29through 2.31. 

Figure 2.29 Something about
the hair flopped over the
model’s eye made this my
favorite image from this shoot.
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Figure 2.30 This runs it a
close second…

Figure 2.31 …as does this.



Another alternative is to seek out models who don’t require references.
Usually such models will insist on bringing a chaperone at least to their first
shoot with you (a requirement which I believe is entirely reasonable under
any circumstances), or will want to work in a professional studio where 
they won’t be completely alone with you. Or you can seek models from
among friends and acquaintances, as described later in this chapter (again,
encouraging them to bring a chaperone). 

This raises another question: If you’re a beginner at nude photography, are
you better off working with an experienced model or a novice? The obvious
answer might appear that you’ll learn more and get better results if you work
with an experienced model, but I don’t think this is necessarily the case. If
you have some reasonably clear ideas for a shoot, you won’t find it difficult
to explain them to a novice model, who may well prove more flexible and
adaptable. And because you’re working in digital, you can see the results of
your efforts and adjust them as you work, thus climbing the learning curve
quite rapidly; see Figures 2.32 through 2.34.
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Figure 2.32 These three
images are from Toria’s first
nude shoot. 
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Figure 2.33 Prior to this she
had done a small number of
fashion shoots.

Figure 2.34 Her strong 
presence makes itself felt in
every image.



Against that, it’s argued that working with experienced models allows you 
to leave the posing to the model and concentrate on the photography. An
experienced model will also know what angles and poses don’t work so well
with his or her particular body shape and face. This can certainly work, but
the downside is that you’re likely to end up with images which look the same
as other photographers’ work, because the poses the model gives you are
those he or she learned that other photographers prefer. So if you do decide
to go for experienced models, it’s not a bad idea to let them know that you
will be setting the poses—while still drawing on their awareness of what
poses and angles don’t work—and not just relying on a standard repertoire;
see Figures 2.35 and 2.36. Experienced models will also be much less likely
to alter in midshoot the level to which they’re willing to work; see “Modeling
Levels” later in this chapter.

Models 103

Figure 2.35 Working with 
two experienced models and
drawing their knowledge and
feel for how they work best
together.
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Partners, Friends, Acquaintances, and Strangers
Let’s digress briefly from the processes of working with models you find on
the Internet to those closer to home.

The dynamic between photographer and model is very different from that
between partners such as husband and wife. Switching between the different
roles isn’t always easy for either partner: It works in some relationships but
creates huge strains in others. If you do decide to try using your partner as a
model, probably the best advice is not to persist if the experience proves 
difficult or stressful for either of you in your first attempts: Those stresses are
unlikely to dissipate however earnestly and openly you try to talk them
through. On the other hand, if it works for you both, you join a long 
tradition of artists and photographers, from Rembrandt and Rubens to
Stieglitz, Weston and many of our contemporaries, whose life partner has
also become photographic subject and muse; see Figure 2.37. 

Figure 2.36 In these examples,
as well as shifting the camera
angle, I’m asking them to try
different hand and arm 
positions.
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Recruiting friends, acquaintances, and even strangers often turns out 
easier than one might expect. It does need an approach which is totally 
nonthreatening, and a willingness to accept rejection cheerfully. At least six
of the models in this book are people I first met at parties or in pubs, coffee
bars, or other public places. Again, it’s easier to do when you’ve developed a
repertoire of images to show potential models. 

Here’s what often works for me:

� I always carry business cards, which are simple but good design, 
inexpensive, listing my name, phone number, and web site URL, 
and identifying me as a photographer.

� I always have with me my Palm handheld computer, with its 
multimedia card loaded with about a hundred varied images most, 
but not all, nude.

� I’m very careful always to approach a potential model in an environ-
ment where she can feel safe, and will hopefully be willing to have a
conversation with me because she knows that help is close if she needs
it: perhaps while she’s with friends or in a café whose staff are nearby.

� Many of the people I’ve approached to model for me had something
about their appearance when I first saw them which suggested that
they were extroverted and confident in their appearance; see Figures
2.38 through 2.40. Many of them turned out to have modeling 
experience already.

� I watch my body language and keep a respectful distance.

Figure 2.37 Working with
one’s partner (seen here on the
right), along with other 
models, can be a very creative
and challenging experience.
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Figure 2.38 When I first
introduced myself to Zoey 
in a coffee shop in London,
everything about her suggested
confidence in herself and in 
her appearance.

Figure 2.39 I was struck by
Nichola’s short-cropped blond
hair and tough look, and wasn’t
surprised that she had previous
modeling experience. For this
shoot she brought with her a
friend, also a model.



If you’re finding models from among friends and acquaintances, you’ll still
need to follow the steps set out in “On First Contacting a Model,” although
you’ll probably be able to do so in conversation with your potential model,
rather than via email.
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Figure 2.40 I met Alex when
she was modeling in a catwalk
show I’d been commissioned 
to photograph. (The picture
shown here is not from that
shoot!)



Mastering Digital Nude Photography108

Models on the Internet
On the Internet you’ll find general modeling sites that register models for
every type of work from kids’ fashions to adult modeling; more focused sites
that specialize in specific types of work; and models’ personal web sites.
Many photographers also provide links from their web sites to those of the
models they’ve worked with.

Let’s deal with the modeling web sites first. OneModelPlace (OMP,
www.onemodelplace.com) is the biggest, and I’ll use it as an example, but
there are many other smaller sites with similar features. Searching online for a
phrase like photographic modeling will give you plenty to explore. For 
photographers, most sites require subscription; models can often sign up for
free. For example, you can browse OMP free of charge, but you can’t use any
of its powerful facilities for searching for and contacting models in your area
without becoming a paid member; see Figure 2.41. Signing up with a couple
of modeling sites and joining in the forum discussions will give you the
chance to make contact with other photographers in your area, as well as 
see what models are available. Subscriptions are usually available at different
levels, offering, for example, space for different numbers of images, restricted
or unlimited use of the site’s email facilities, and so on.

Figure 2.41 My portfolio on
OneModelPlace.

www.onemodelplace.com


You’ll notice that nearly all modeling web sites provide scope for the model to
give vital statistics and color of hair and eyes. Few impose requirements or
provide advice for a new model on what kinds of pictures would best give
photographers a good idea of their overall look. The result is that, while 
advertising themselves as available for nude work, some models, even 
experienced ones, just put up a series of headshots or other clothed shots. Even
if you share my view that an expressive face is essential in a good model, that
is less than helpful! There’s a suggestion on how to put this situation right, in
the section “On First Contacting a Model.”

On the other hand, where a model has provided a good range of images,
study them closely, looking for the model within the image. If the 
photographs are high quality, that also says something about the model’s own
standards. Figure 2.42 shows quality work by about a dozen different 
photographers (a recommendation in itself ) and portrays the model,
Imogen1979, in many different guises. This demonstrates her versatility and
her thoughtfulness in organizing her portfolio—both indications of her 
professionalism. Most web sites provide scope for models to link their images
to the photographers who took them (assuming the photographers are also
members of that web site) so you can also move from the model’s portfolio 
to a photographer’s if, for example, you want to ask the photographer 
to comment on the experience working with the model.
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Figure 2.42 Part of model
Imogen1979’s portfolio on 
the excellent U.K. web site
www.web-models.co.uk. 

www.web-models.co.uk
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Some sites also include a reference-check system, whereby models can make
comments on their experiences of working with specific photographers, and
vice versa. These are located in models-only and photographers-only areas of
the site. There isn’t usually any process of verification that the comments are
accurate, nor is there any legitimate way of finding out what comments have
been made about you. Even so, the systems don’t seem to be abused, so they
can provide helpful observations on models you may be considering working
with, as well as motivating photographers to pay careful attention to their
behavior during the shoot!

Modeling Levels
You’ll discover that the different levels to which models work are classified
according to a terminology which varies from web site to web site, and is
rarely defined by the sites themselves. Some terms are pretty clear, others less
so, but they’re usually listed in ascending order of exposure and cost, if the
model charges for services. Modeling levels specify what’s expected of the
model in terms of how much of the body the photographer expects to be
revealed; the levels don’t define the aesthetic properties of the resulting images.
If you’re in any doubt, it’s always better (if initially a little embarrassing) to
spell out beforehand to the models what you’re asking them to do; don’t leave
it until you’re about to start shooting! See Figure 2.43.

Figure 2.43 The position and
angle of the camera are critical
here, both for the composition
of the image and for the 
photographer’s commitment 
to the model to shoot within
her limits.



As you read the descriptions which follow, you’ll see that they’re less than
totally precise. However careful you are in agreeing on levels with a model
before the shoot, it’s always possible that differences of opinion about the
level of a specific shot will occur during the shoot. It’s also possible that
inexperienced models will change their minds, midshoot, about what level
they’re comfortable with. Ways of dealing with these situations are discussed
in “Disagreements During the Shoot.”

Implied topless, for example, means a female model’s upper body will 
be unclothed, but her nipples are concealed, perhaps by a garment, or by 
her hands or hair; or the shot may be taken from the back. See Figures 2.44
and 2.45.
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Figure 2.44 Implied topless: a
frontal shot.
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Topless describes shots where the nipples are visible, possibly through trans-
parent or wet garments; see Figure 2.46.

Figure 2.45 Implied topless: a
back view.

Figure 2.4 A topless image
using a see-through garment.



Art(istic) nude or figure nude means the model is naked, but posed in such a
way that the pubic area is concealed, either by her hands, by the way the body
is angled towards the camera, or by the way the shot is lit. See Figure 2.47.

Implied nude may mean the same thing, but may mean that the model’s 
nipples are covered as well; see Figure 2.48.
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Figure 2.47 Artistic nude
using a male model (and a
carefully positioned lily)!
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Figure 2.48 Implied nude
constructed by using shadows
and the model’s hands.

Plain nude means that the pubic area can be shown; see Figure 2.49.

Figure 2.49 A nude shot.



Erotic nude covers images which show erotic activity, real or simulated, but
doesn’t necessarily involve more exposure than nude; see Figure 2.50.

Adult nude and its many subdivisions takes us into the regions of porno-
graphy. Fetish refers to the use of fetish clothing—latex, leather, PVC, and so
on—together possibly with elements of fantasy or bondage, which could
involve any level of nudity, or none at all. Whereas there’s a clear line, so 
to speak, sloping up from implied topless to adult nude, fetish refers to a 
different aspect of imagery. Not all models, even those who do adult nude,
are interested in doing fetish work. See Figures 2.51 and 2.52.
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Figure 2.50 I’d classify this 
as an erotic nude shot, both 
aesthetically and in terms of
the physical contact it requires
from the models.
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Figure 2.51 With its focus on
the erotic kick of very high-
heeled boots, I’d classify this as
a fetish image.

Figure 2.52 With its inverted
lighting and exaggerated
“Come here, slave!” expression,
this image comes close to 
satirizing what it represents.



Why are levels of nude modeling defined in such detail? Two reasons. First,
if you’re hiring a model, the higher (the more explicit) the level you want to
shoot, the more you can expect to pay. Second, if you engage a model to
work to her highest level, one of the worst mistakes you can make is to try to
talk her into working to an even higher level. Many models identify this as
one of the most off-putting and annoying things a photographer can do.
(Note also that, unless you explicitly negotiate a different arrangement
beforehand, you should expect to pay for the whole of the shoot at the rate
which applies to the highest level work you’ve agreed with the model. In
other words, if you book a model to do two-and-a-half hours of clothed 
portraits, and half an hour of topless, the model will expect to be paid for
three hours at her topless rate. See Figures 2.53 through 2.55.)
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Figure 2.53 If you shoot
this…
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Figure 2.54 …and this…

Figure 2.55 …in the same
shoot as this, you should
expect to pay for the whole
shoot at the highest applicable
rate (in this case, the rate for a
topless shoot). 



Ethical behavior and self-interest often go together in photography of the
nude. Every model sets the maximum level after much thought: That level
represents the extent to which they are prepared to reveal themselves to the
photographer’s gaze and lens, and to allow their image to live, virtually 
forever, on the Internet. A photographer who tries and succeeds in pushing
and manipulating a model to work beyond this limit is very likely to be
rewarded with images in which the model’s look clearly conveys some 
discomfort. Such images make unappealing viewing. Doing the right thing,
and sticking within limits clearly spelled out before the shoot begins, also
gives you the best pictures; see Figures 2.56 and 2.57.
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Figure 2.56 More of a 
snapshot than a serious image,
his shows the mood which
should prevail in a carefully
prepared and well-run shoot,
with the models comfortable
with each other, with the 
camera, and with the 
photographer. 

Figure 2.57 A good friend,
who’d modeled for other 
photographers and artists,
looking very relaxed at the
beginning of our first shoot
together.
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Paperwork: Payment and Releases
In this section I’m assuming that you’re not yet at a stage in your work as a
photographer of the nude where you can charge models for photographing
them.

Not all models seek monetary payment. Models just making a start in the
business, for example, will often be willing to pose for you in exchange for
some edited prints, or possibly a CD of the images from the shoot. The same
applies to models who wish to update or expand their portfolios. The model
is giving her time in exchange for prints or a CD, so these arrangements are
often referred to as TFP/PFT (time for prints/prints for time) and TFCD
(time for CD). See Figure 2.58. TFP is appropriate for a model who 
maintains a portfolio of prints to show to prospective photographers; TFCD
is for a model who uses a web site to get business, but doesn’t bother with a
portfolio. When reaching a TFP agreement with a model, it’s important to
specify how many prints you will give. Five or six prints for each hour of the
shoot is a fairly common figure. Equally, with TFCD, you’ll want to specify
how many images you’re prepared to edit for the model to use. 

Figure 2.58 Edited images for
Eden, a British model now 
living in Florida. I made .psd
files, which are full size for
printing and which I hold, 
and a small .jpg file of each
image for Eden to use on her
web site if she wishes.
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TFP and TFCD seem like good arrangements for the photographer: The
only costs, apart from the model’s traveling expenses, might appear to be the
CD or paper and ink to make the prints, plus postage. However, time is also
money, as the saying goes, and one should never underestimate how long it
can take to prepare images for printing. For example, if you’ve agreed to give
the model six images of her choice for each hour of the shoot, after a three-
hour shoot, she is entitled to 18 images. If each of these takes 10 minutes to
edit (and that’s a low estimate), that’s three hours’ work; see Figures 2.59 and
2.60. If we assume that perhaps six of them are images you would have edit-
ed for your own portfolio, you’ve still spent a couple of hours editing work
just for the model. That’s why some keen photographers decide, after start-
ing off doing TFP/TFCD, that they’d prefer to pay the model for the shoot
and work only on the prints they want for their own portfolio.

Figure 2.59 The photograph
as shot.

Figure 2.60 The same image
after editing. Among other
things, I’ve rotated it a few
degrees, which then 
necessitated cloning in a 
small section of the skirt and
the model’s abdomen to fill 
in the gaps created by the 
rotation. It all takes time!



You’ll also find models who choose to work free for some photographers,
whose style of work they like and want to include in their portfolio, while
working for pay with others. When you encounter a model who offers the
possibility of both TFP/TFCD and paid work, it’s likely that, while payment
may be negotiable, the assumption is that nude work will be paid.
Negotiations over payment may cover not just the hourly rate, but also other
possibilities such as a part-pay, part-TFP agreement, where you pay half the
rate the model’s asking, and contribute, say, three prints for each hour of the
shoot. It’s also common practice to pay the model’s traveling expenses on
TFP/TFCD shoots, as well as on paid shoots. 

If you’re looking to sell some of your work, another arrangement you can
make with the model is profit share. This means that the model works for
you for free, you both use the resulting images to build up your portfolios,
and split the profits from any images you or the model sell.

The possible variations within the broad TFP/TFCD/payment/profit-share
framework are numerous. So before you start to negotiate with a model, you
need to be clear in your own mind exactly what combination of different
types of payment you want to offer. Many photographers codify this in a
standard form letter which they send out to prospective models, in addition
to requiring the model to sign a release. 

For example, it’s common practice with TFP and even paid shoots to provide
the model with a CD of either all the images from the shoot (usually reduced
to measure 600–650 pixels on the longer side) or only those you judge the
best. (Selecting the images which strike you as the best takes time, and in any
case may exclude images which may not be superb photographs, but still
show the model well. This is why some photographers just put the whole
shoot onto the CD.) Without this it’s hard for the model to choose which
images they want printed for TFP, and in any case it allows the images to be
included in their web portfolio, if you’ve agreed that; see Figure 2.61. If you
have a web site, an alternative method of letting the model browse the images
is, again, to reduce them in size but to load them onto your web site, on a
discrete page not accessible from your web site proper, and to email the URL
for that page to the model.
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Figure 2.61 An image chosen by Florida-based British model Eden for use on her web site.



You may choose to adopt any or all of these policies. There’s no obligation,
for example, to allow a model you’ve paid to use the images on a web site or
anywhere else; but it seems to be a fairly common practice to allow this, on
condition that the images are credited. What’s important is to spell out to the
model, as your negotiations develop, just what you’re offering and then to
stick to it, in a timely manner. For example, the CD should be on its way to
the model no later than the day after the shoot. (Keep a good supply of 
CD-sized padded envelopes and postage stamps!) If you’re doing
TFP/TFCD, once you’ve received the model’s list of the images she wants,
you should take no more than two weeks to deliver them. “He never sent me
the prints I was promised!” is another common complaint from models.

If you’ve agreed to allow the model to mount some images from the shoot on
a web site, experience indicates that it’s essential to include in your model
release a clear statement to the effect that the model must tell you the 
reference numbers of all the pictures to be used, and must then wait for you
to check them before adding them to her web site; see Figure 2.62. Put this
in writing, explain beforehand, and remind the model again at the end of the
shoot. I’m not sure why many models lose track of this and rush to mount
the unedited images on their web sites: Perhaps it’s the excitement and 
pleasure of having a CD full of the wonderful images you’ve created of them.
Imposing this condition gives you the chance to make any necessary 
alterations to the images: adjusting color balance or levels, for example; or
rotating the picture to get the verticals and horizontals to look right; or, of
course, removing blemishes from the model’s skin. 
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Figure 2.62 Two edited 
pictures from a location shoot
with Jessie, as they appear on
her web site.



Another form of payment is clothes for prints. This can work for nude 
models as well! Nude shoots, more often than not, include sets of the model
partly undressed or wearing fetish garments, corsets, boots, and the like. The
photographer provides garments for the model to wear during the shoot, and
at the end of the shoot the model gets to keep them. This might seem to be
the same thing as paying the model a standard modeling fee and requiring
her to provide the wardrobe. In fact, models who offer this arrangement
often do so because they’re less interested in earning a lot of money through
modeling than in building up a wild collection of clothes, and will be happy
to work for the equivalent of a much lower hourly rate than normal; see
Figure 2.63.
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Figure 2.63 Naomi was happy
to do a time-for-clothes deal
with me, which included this
spectacular corset and some 
red boots. 



So how much is a normal rate? That depends very much on your location,
what level you want the model to work at, and how experienced, 
well-known, and in-demand the model is. Ask a few models in your area
what they charge for, say, art nude, and you may be surprised at the 
variations in their rates. This is where your negotiating skills may enable you
to strike a better deal with the model than is initially offered. 

Whatever financial arrangement you reach with the model, if you intend to
publish the images (for example, by putting them on a web site), the model
must agree to sign a model release. A model release is a contract between you
and the model. In exchange for a consideration, the model agrees to allow
you to make the use of the photographs you take of her in whatever ways the
release specifies. The consideration will be either payment, prints, or a CD,
or a combination of these. (In most U.S. states a contract is only valid if 
some compensation is provided in exchange for the service rendered: That
compensation, the “consideration,” need be no more than a dollar or a 
single print.) 

Typically a model release will permit you and your heirs to publish the
images

� Anywhere: In any publication, in any medium, in any country. I know
one photographer whose release includes the phrase “in the universe.”
The release should also be future-proofed by specifying media “now or
hereafter known.” 

� In any form: You can manipulate the image, or distort it, or collage it
with other images.

� For any purpose: You can use the images for advertising or editorial
purposes, or include them in an exhibition of your work.

� Forever.

The best way to find suitable wording for a model release is to search online
for “model release” and look for examples which are clearly worded and 
thorough in their coverage. You may want to have a lawyer friend look the
release over before you use it. These can form the basis for your own versions.
I use three: one each for TFP, TFCD, and pay. The core paragraphs are the
same in each, the only difference being in the statement of the consideration
the model agrees to accept in each case. You may also, on occasions, need to
produce releases tailored to the needs of a particular model. Two of the 
models who appear in this book, for example, agreed to be photographed on
the condition that the images were only to be used for print publications, and
could not appear on the Internet. I can see their reasoning: Once you upload
anything onto the Internet, you lose all control over it; see Figure 2.64.
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In addition to stipulations regarding usage and copyright, don’t forget to
include in your release a requirement for the model to check with you before
uploading images into the Internet, as described earlier. If you share my 
(old-fashioned) view that the print is the only true form of an image, and are
therefore particularly concerned to control the quality of every print made of
your work, you may also want to stipulate that the model is not to make any
prints from the CD you’ve sent her. You don’t, realistically, have any way of
preventing her from doing this, even if you add a big copyright statement
right across each image on her CD, so I usually indicate to paid models that
if they decide after the shoot that they want just two or three prints, I’ll be
happy to do them for them. It’s better to get along than go to war.

Some models will ask you to pay an extra fee to have them sign the model
release. This is largely a question of how the model structures her fees: She
may charge less per hour and charge for the release separately; or she may
charge more per hour, but include the release within that rate. At the end of
the day what will concern you is the total fee you pay the model, so it’s
important that you check during your negotiations how the model handles
this. It’s important to show the model release to the model before the shoot,
so she knows what she’s committing herself to, but it should only be signed
at the end of the shoot, when the model can be reasonably certain that she’s
happy with the way she’s been photographed.

Figure 2.64 Some models 
will be happy for you to show
their images as prints or in
publications, but may have
reservations about living 
forever on the Internet.



A note on age: In different countries, the age at which it’s lawful for a model
to be photographed in sexually explicit poses varies. In the U.S., the age is 18.
Having said that, there’s no law in the U.S. which forbids the models under
the age of 18 from being photographed nude, providing the resulting images
aren’t sexually explicit. The difficulty, however, which confronts any 
photographer who’s contemplating shooting nude images of an under-18
model is that the photographer’s judgment of what constitutes an image that’s
not sexually explicit may turn out to differ very significantly from the views
of local police and courts. All the models in this book were 18 or over when
I photographed them, with the exception of the clothed portrait of Sheena.
The only sensible policy, if you’re working in the field of nude photography
of any kind, is to stick to models who are over the age of 18.

Arranging the Shoot
This is where clear and precise communication is essential. With a model
you’ve found on the Internet, her published details should have given you a
good indication of what her working levels are. If you’re not sure that the
shoot you have in mind is clearly within her range of styles, it’s essential you
describe what you have in mind, and confirm that she’s happy with that. It’s
impossible to exaggerate the importance of this part of the process. Close to
the top of the list of models’ pet hates is being pushed or cajoled during the
shoot to work at a higher level than was initially agreed. 

Avoiding Conflict
Let’s return to the business of finding models on the Internet. In the three or
four years I’ve been seriously involved in photography of the nude, this
process has grown noticeably more complicated and time consuming. As
society in the U.K. and the U.S. becomes more risk aware and risk averse,
models become more careful in their dealings with photographers who want
to book them. Keep in mind, when you’re negotiating with a model, that her
caution isn’t a reflection of her attitude to you personally, but derives from
her previous experiences. Most models will have encountered one or two
unsavory characters in their careers who proclaim themselves to be photog-
raphers, along with genuine photographers who just don’t understand that
models are entitled to be treated with respect. While I was working on this
chapter, I invited some models to contribute their best/worst horror stories
about experiences with photographers. They’d make a book in themselves!
I’ve included a few here, not because I think that otherwise you may say 
or do things like this, but just as examples of how some “photographers’”
behavior impacts models; see Figure 2.65.
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In all negotiations with you, a model will be looking for assurance that 
none of these problems will occur, and also watching for any indications that
they may:

� Unsurprisingly, the most common sources of offense have to do with sex:
requests for or offers of sexual favors from photographers; comments on
or questions about the model’s sexual life or sexuality. This can start
before the shoot. One novice photographer asked in a web forum recent-
ly why he got no replies to his emails to models. He included a sample of
those emails, which typically began “Wow, you’re really hot and fancia-
ble! Would you like to do a shoot with me?” It says a lot for the patience
and good humor of models that several gently explained to him in the
forum that perhaps that wasn’t the best approach to take!

� Comments on the model’s appearance run a close second: “Your butt’s
too big and your boobs are too small!” was one photographer’s notion
of how to break the ice with a new model.

� Trying to push the model beyond the agreed limits.

� Derogatory comments about other models: “If he says that about other
models to me, what’s he going to say about me to other models and
photographers?”

Figure 2.65 The confident
and relaxed expression which
give this simple image its
charm are shaped as much by
the communication between
the photographer and the
model in the run-up to the
shoot as they are by the 
shoot itself.



� This one surprised me, but more than one model made the comment:
“A lot of photographers grunt when they press the shutter, almost like
some kind of sexual satisfaction.”

� Objectification of the model: The model expects to be treated like a
person, not an object. As one model wrote (I hope, for the sake of 
photographers everywhere, with some exaggeration), “98 percent of the
time, photographers make me feel like some piece of moving meat.”

Most of these stories don’t really have an upside. But in a scene worthy of one
of Charles Dickens’ most eccentric characters, a photographer recently 
greeted a model friend of mine at the door when she arrived for their second
shoot together, got down on one knee, and proposed marriage. “So what did
you do?” I asked. “I turned round and walked right out the door, of course!”
Sadly, the photographer in question seems proud of this bizarre behavior, and
has boasted about it to other models.

“Can I Bring a Chaperone?”
This is a topic guaranteed to start a vigorous debate in any forum of photog-
raphers and models. My own views are quite simple, given the unpleasant
experiences with photographers most models have gone through. If a model
asks to bring a chaperone, I agree. On a paid shoot she brings the chaperone
at her own expense; on a TFP/TFCD shoot I may agree to contribute to the
cost of the chaperone’s travel, depending on the distance. If she asks for the
chaperone to be in the studio with us during the shoot, I agree. If the 
chaperone starts to intervene in the shoot in any way, I ask them politely, but
very firmly, not to. So far I’ve never had a problem or a difficult experience
with a chaperone. And chaperones can be useful for making tea, holding
reflectors, entertaining the cats, and so on.

The most common difficulty you may encounter is when the chaperone is
the model’s partner, and the model is relatively inexperienced and/or the
chaperone hasn’t been to many (or any) nude shoots with her. Partners who
aren’t used to being chaperones can become overly protective or possessive
when they see their beloved standing naked in front of the photographer.
This is why it’s a good idea in these circumstances to make sure in your 
negotiations with the model that she understands that she has to guarantee
that the chaperone will behave correctly.

On the other hand, it’s not unknown for a chaperone to become a model; see
Figures 2.66 through 2.68.
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Figure 2.66 When Emzy came
to do her first shoot with me,
she brought her friend Caz
with her as chaperone.

Figure 2.67 I was fascinated
by Caz’s unique look and 
invited her to pose for me,
which she did, both with Emzy
and without.
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Other participants in a shoot may become curious and ask if they can join
in; see Figures 2.69 and 2.70.

Figure 2.68 Caz by herself.
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Figure 2.69 When I arranged
to shoot Naomi with a snake,
her friend, Belladonna, an
experienced snake-handler, had
to be there as well.

Figure 2.70 As the shoot 
progressed, Belladonna became
increasingly intrigued and
joined in. 



On First Contacting a Model 
So far we’ve focused on what you’re looking for in a model; but what will 
a model be looking for in a photographer? How can you sell yourself 
successfully to a model you haven’t worked with before?

Again, we’re looking at this from the perspective of a photographer making
a start in photography of the nude, but with at least a modest portfolio of
portrait and fashion shots. (That seems to be the least you need.) These days
the process of engaging a model is usually email-based, but it’s also possible
(and at some stages preferable) to carry out these negotiations using a chat
service like MSN Messenger or AIM. Don’t expect the model to give you her
phone number until you’ve established your credentials.

An initial message from you to a prospective model is likely to include:

� Your name.

� Your location. The name of the town you live in, rather than your full
postal address, is all that’s necessary at this stage.

� Your email address. If you’re contacting the model through a web site,
some will automatically disclose your own email address, whereas 
others will enable a model only to reply internally through that web
site. In the latter case, if she only has free membership of the web site,
the number of emails that can be sent each day may be limited, 
so if you give out your own email address you’ll both be able to 
communicate more easily and effectively.

� Your ID on MSN Messenger, AIM, or whichever chat service you use.

� Your experience, including any web sites where examples of your work
can be seen; failing that, an offer to email her samples of your work.
Mention that you can provide her with contact details of models you’ve
worked with, but don’t include them at this stage.

� The level of work you’re hoping to shoot with the model. It can’t be
too strongly emphasized how important it is to be clear and explicit
about this. It’s better all around to be turned down by a model at this
early stage than to run into difficulties during the shoot. And be aware
of the importance of discussing different themes as well as levels.
Models arrive at the shoot mentally prepared for the work you’ve 
negotiated with them. A model who’s expecting to do a straight nude
shoot may not be happy if, partway through the shoot, you spring a
proposal to do some bondage or fetish shots (even if she is to be 
partially clothed in them). 
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� The location of the shoot: in your home studio, in a commercial 
studio, outdoors, and so on.

� The duration of the shoot. Don’t forget to mention the coffee and
chocolate biscuits that will be made available during the breaks.

� The method of payment proposed or request for details of the model’s
fee for a shoot of the duration and level specified. If I’m proposing a
TFP/TFCD shoot, I always invite the model to bring along a selection
of garments (no more than three or four changes) she’d like to be 
photographed in. It won’t take me long to shoot them, and that way
she can be certain of getting a broad range of images for her portfolio.

� If you have a specific date in mind for the shoot, mention that. It’s 
better, however, to suggest a range of dates. Most part-time models are
only available weekends or evenings.

� Mention that if she wishes to bring a chaperone, she’s welcome to do so.

� If you have household pets, mention them, just in case the model has
an allergy.

� If the model’s web site includes only headshots, and the rest of her
details convince you that you’d like to work with her, it’s reasonable to
want to see some full-length shots of her. (This may seem unlikely to
happen, but some headshots can be very alluring; see Figure 2.71.)
Many a photographer has come to grief here! At this early stage it may
not be a good idea ask her to email you nude images of herself, which
may lead her to suspect that you’re a pervert, rather than a serious 
photographer. You could tell her that, while you like what you’ve seen
in the headshots, it would be helpful to see her full length, and ask her
if she has another web site with a wider range of images on it. Failing
that, full-length, clothed images should still give you an idea of the
model’s overall proportions.

If the model replies to your email, she may have a list of further questions for
you. If she doesn’t reply within a few days, there’s no harm in emailing her
again. Messages do disappear in cyberspace, particularly if you or the model
use a mass, free email service. If she doesn’t reply to a second email within 
a few days, you should probably take that as a less-than-polite way of 
indicating that she is not interested in working with you.

As well as dealing with any questions, your next email is the right moment
to send a copy of the appropriate model release, and to invite her to confirm
agreement with its conditions, as well as checking that your proposals about
the number of prints for TFP, use of images off the CD, and so on, are
acceptable. If she wants to bring a chaperone, it’s reasonable to ask whether
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Figure 2.71 It didn’t take
more than a headshot like this
to persuade me that Amber
would be a very interesting
model to work with.

the chaperone has attended other shoots with the model before; see Figure
2.72. If the chaperone is the model’s partner, and her responses to these 
questions give you any concern that the chaperone may impede the shoot, it’s
perfectly reasonable to express your concerns, maybe by asking whether your
model is confident that her partner will be comfortable watching her 
work. These issues are easier to deal with in online chat, rather than by email.
This is also the moment to give the model your address and phone number
(preferably landline), as well as the address and number of the 
studio, if you’re using one. Finally, you can email again, setting out every-
thing you’ve agreed to in writing. 

Figure 2.72 An impromptu
appearance by the model’s
boyfriend/chaperone (or at
least his arms).
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If the model asks to be put in touch with models you’ve worked with, make
sure that those models are happy for you to give out their phone numbers or
email addresses. Some models are happy to give you a blanket permission to
pass their details to potential models whenever you need to; others may want
you to check with them each time.

Welcoming the Model to the Shoot
We’ll assume that your shoot is going to be a mixture of nude and clothed or
partially clothed images, and we’ll also consider the steps you might want to
follow with a relatively inexperienced model you’re working with for the first
time. Not all of these steps will be necessary or appropriate with a model
who’s more experienced, or one you’ve worked with previously.

The model will need somewhere to change (both when she arrives and leaves,
and between sets) and, of course, somewhere to do her makeup. Some 
models are happy to change in the studio, while others will request a separate
space. As the shoot progresses and they feel more relaxed with you, many
models who’ve started off changing in a different room will decide that
they’re happy to change in the studio, which is helpful because it saves time
and maintains concentration and focus. You also need to provide a robe (a
nice, photogenic one—not a tatty one!) for the model to wear after she’s first
undressed, and for her to slip into during lulls in the shoot; see Figure 2.73. 

Figure 2.73 No need to wrap
up! Toria relaxes between sets
during her first shoot. She’s
talking to her partner and 
fellow model Trevor, whose
bejeaned legs can be seen on
the right side of the picture. 
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For makeup, I have a well-lit dressing table with a large mirror in a separate
room. Some models will gratefully make use of this, but many prefer to use
their own hand mirror or the mirror in a makeup box, while perched on a
stool in the studio. I also keep in the studio an illuminated double-sided 
mirror, one side of which is curved to provide magnification, which is useful
for doing or touching-up eye makeup in particular, and capable of providing
photo opportunities in its own right; see Figure 2.74.

Figure 2.74 The process of
putting on makeup has its own
sensual appeal.



I always ask the model to change into a robe the moment she arrives. This
provides time for any marks left on her skin by her clothes (bra straps, 
waistbands, and the like) to fade. This rarely works completely. However
carefully the model’s chosen loose garments to wear to the shoot, there’s
always clean-up work to do in Photoshop. So you can leave her to get into
the robe in private, while you’re busy in the kitchen making her a cup of tea.

Makeup and Other Adornments
Makeup plays a less significant role in artistic photography of the nude than
it does in fashion or glamour photography. Unless you’re planning some 
elaborate body decoration, makeup for photography of the nude works best
when it’s subtle, giving the model’s face a natural look. Most models are
happy to apply their own makeup, and you can discuss with them the look
you want. You can check the first images of the shoot on the back of the 
camera and ask the model to tone down any part of the makeup which seems
overemphasized. In particular, makeup that’s been heavily applied to cover
minor skin blemishes may be more time consuming to fix in Photoshop than
the blemish would have been if left untouched. The same applies even 
more to tattoos covered with makeup. Many models will offer to cover their 
tattoos, but it’s hard to do perfectly, and is slow work. Assuming it’s a 
small tattoo, you can quickly fix it in Photoshop. 

If you’re looking for a more elaborate look, you can bring in a makeup artist
(mua) to do the model’s makeup and hair, possibly negotiating payment for
the work in prints or publicity shoots for the mua. In the photo shown in
Figures 2.75 through 2.77 I worked with Jay, a local mua, to create quite 
dramatic faces for two models. It was an interesting experiment. Images of
the models’ heads and torsos worked quite well, but in full-length shots the
gap between the elaborate facial makeup and the unadorned bodies was too
great to make sense. It’s instructive to compare Figure 2.77 with Figure 2.81.
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Figure 2.75 Alex given a 
natural look by mua Jay.

Figure 2.76 Dramatic eyes and
burnished skin.



One of the most striking aspects of 
this shoot was the way her makeup spoke to
Alex and inspired different moods and
expressions, as Figures 2.78 and 2.79 
illustrate.
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Figure 2.77 Makeup loses its
impact in full-length shots.

Figure 2.78 Different 
makeup…
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Body painting extends the possibilities of makeup; see Figures 2.80 and 2.81.

Figure 2.79 …different
moods.

Figure 2.80 Belladonna
decorated with daylight paint.



I work with international body painter Mike Pilkington who, as well as using
conventional daylight paints, specializes in blacklight work, using paints
which respond to ultraviolet light; see Figures 2.82 and 2.83.
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Figure 2.81 Emily and
Belladonna in complementary
color schemes.

Figure 2.82 Mike Pilkington
at work.



In one of the shoots from which these images are taken we also tried out a
beautiful Venetian mask belonging to one of the models, another form of
adornment, which worked surprisingly well with Mike’s blacklight designs.
See Figure 2.84.
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Figure 2.83 The results.



Body paint shoots are slow work: A full cover of the kind you see in these
photographs takes a couple of hours at least to do. Blacklight photography
calls for powerful UV light sources: We used big UV cannons with outputs
of up to 4kw on these shoots, balancing them for some shots against daylight.
In Figure 2.85 the base layers of bronze and gold paint are daylight sensitive,
and the other colors (as well as model Zoey’s hair extensions) are UV 
sensitive. Even with big UV sources, typical exposures for blacklight images
are 1/10–1/15 second. 
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Figure 2.84 An unlikely but
successful combination of 
elements.



In a more lighthearted vein, there’s a long tradition of the use of food in 
photography of the nude. A little experimentation with sprinkles and
coconut butter (other adhesives such as honey proved too shiny) produced
the images in Figures 2.86 and 2.87. 
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Figure 2.85 Mixing daylight
and UV light.
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Figure 2.86 Say “Aaaah!”

Figure 2.87 Adding a little
color.
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Figure 2.88 As we gaze at them, they gaze back at us. 

Working with More Than One Model
Multiple nudes always seem to tell a story, however indirectly. Perhaps it’s
because our instinct is to try to understand or invent the relationship
between the figures when we see them together in the same frame. It’s 
natural to think of those figures as characters in a narrative of some kind,
and I’ll often refer to them as characters rather than as models. The poses
you plan will create those characters. What fantasy, for example, might we
embroider around these three women in Figure 2.88, two of whom fix us so
boldly with their gaze?
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Figure 2.89 Passion flowers.

Setting and pose can suggest the story as much as physical contact between
the models, as in Figure 2.89, where just the proximity of the models encour-
ages the viewer to imagine what these two women are doing together in this
green summer setting. 



The same holds true even in as formal an image as Figure 2.90, where the ele-
gant interlocking of the models’ hips and waists on the rumpled bedsheet
suggests an intimacy beyond what’s visible. Where have they come from?
Where are they going? Much of the pleasure of viewing these images comes
from their ambiguity, from the fact that each one suggests a different story to
every viewer. 

Directing your first shoot with more than one model can be an intimidating
experience, as well as an exhilarating one. Preparation is vital, particularly to
ensure that the levels you’re proposing to work to are understood and agreed.
You will have given thought to the height and build of your models, as well
as to their previous experience with you and with each other, selecting 
people who you hope will fit together in every way.

With all this carefully done, there’s still that heart-stopping moment when
you ask the models to remove their robes and take up the first pose. Even
more than with a single model, it makes sense to begin gently, perhaps with
relaxed poses such as Figure 2.91. This shot is from early in the shoot, which
also produced Figures 2.93 and 2.94, both of which called for much more
intimacy.
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Figure 2.90 Every picture 
contains a story. 



As you work, try to keep your instructions and guidance as clear as you can.
For example, get into the habit of beginning every instruction with the name
of the model it applies to, thus avoiding both models—or just the wrong
model—trying to carry out the instruction. More than in a single model
shoot, you’ll need to refer to parts of the model’s anatomy: “Opal, can you
move your hand closer to Natlialie’s breast?” and so forth. It’s a somewhat
unusual situation, but don’t let it fluster you: Choose the level of language
you feel comfortable with and use it. And be prepared for a lot of laughter,
some of it nervous, as the models begin to touch and hold each other; most
of it directed (affectionately, you hope) at you. Keep in mind also that few
models have formal training as actors. For them to express convincingly 
powerful feelings such as sexual desire depends partly on how well the 
photographer can direct them, and partly on the rapport between them. All
modeling is acting, but working with another model can make much greater
demands than working solo.
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Figure 2.91 Beginning simply.
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Setting a pose is, as always, a matter of giving clear instructions, bearing in
mind that simple factors such as differences in height between your models
may make some poses impossible or clumsy; so you’ll need to be able to
improvise. Think safety, too: For example, if you’re suggesting a pose where
one model is taking the other’s weight, make sure everything else is as ready
as it can be before you put the models in position, and be ready to let them
break from the pose before it becomes too much for them. 

Lighting may need to be more frontal than you’re used to, particularly for
standing poses, to avoid one model shadowing the other, but can still be
oblique enough to pick out musculature and create a pleasing shadowplay. In
Figure 2.92 the positions of the models have been cheated slightly: Gemma is
closer to the camera than Warner, and thus can be sure of being properly lit.

Figure 2.92 Ensuring that
both models are in the light.
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A shoot with two models offers rich possibilities for bodyscapes. Simple
curves offer symmetries, as in Figure 2.93. 

Bright lighting can create an intricate interplay between shadows and limbs;
see Figure 2.94. In Figure 2.95, subdued lighting molds itself around the
models, making the viewer work to read the image. 

Figure 2.93 Matching shapes.
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Figure 2.94 Delicate lighting
matches the delicacy of touch.

Figure 2.95 Low lighting 
creates powerful shapes out of
the models’ backs.



The great theme for a double nude, however, is surely the embrace, a pose
which can suggest, among other things, tenderness, passion, domination,
submission, energy, or rest. In Figure 2.96, for example, the low camera angle
and the relative positions of the two models convey (to me) a sense of
strength and security as she rests in his arms. Two elements make this image:
the sense of strength in the man’s arms, set parallel and firmly wrapped round
the woman, and the feeling of trust conveyed by the position of the woman’s
head and her closed eyes. 
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Figure 2.96 Safely held.



In that example the image came out pretty much as I’d planned it to (once I
realized, during the shoot, the importance of the position of her head). In
Figure 2.97 there’s an interesting interplay between his gesture and her
expression which I wasn’t really aware of at the time: Is he embracing her or
restraining her? Is she consoling him or rejecting him?
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Figure 2.97 What is she 
feeling?



I like using masks in photography of the nude because they reverse the 
normal order of things: The face is concealed and the body displayed. Models
Gemma and Warner pretty much created this image when they started 
playing with the masks during a break. The image carries the disruption 
of convention a step further by showing Gemma wearing a mask which 
represents the Green Man, a pre-Christian embodiment of the (male) 
potency of nature. In Figure 2.98 it’s seen next to a Venetian carnival mask,
whose appearance is rather asexual. The result is an uneasy combination of
sexual ambiguity, secrecy, and challenge to the viewer.
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Figure 2.98 Ambiguity and
concealment.
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Sleeping lovers is hardly a novel theme, but in Figure 2.99 I wanted to
emphasize the beauty of the male form, with Warner lying in Gemma’s 
tender, almost maternal embrace. The oblique lighting, from a single brolly
beyond and to the left of the scene, accentuates the arrangement of the 
models’ limbs. 

Figure 2.99 Tranquility and safety.



Figures 2.100 and 2.101 are similar in many ways. In both images much of
the emotion we sense between the characters comes from the positioning of
their hands. The difference is in Eliz’s gaze, directed at the viewer in one
image, but entirely private and inaccessible to us in the other. One image
might suggest that we’re voyeurs, snooping on lovers who are unaware of our
presence. In the other it seems that Eliz is watching us, but her gaze and
expression are ambivalent: She may be staring at the viewer or she may still
be withdrawn into her own emotions and sensations.
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Figure 2.100 The ambiguity
of the character’s gaze. 



In Figure 2.102 emotion is conveyed by gesture, as one character reaches
down to kiss another’s outstretched hand.
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Figure 2.101 Both characters
absorbed in the moment.

Figure 2.102 A touching 
gesture.



In Figure 2.103 the curve of Gemma’s back, the fall of her hair, and her 
straddling position all bring energy to the image. 
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Figure 2.103 The lighting
adds to the intimacy of the
scene.
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The final, disconcerting image in this sequence defies reduction to a single
narrative and leaves the viewer with a tantalizing glimpse of the world these
characters inhabit. What has prompted one of them to turn her gaze toward
us? Why is the other looking—deliberately, we might feel—away from us,
one hand resting so casually on her lover’s waist? See Figure 2.104.

Figure 2.104 More questions
than answers.



The Human Landscape
This isn’t about a pose as such, but about a style or approach to photo-
graphy, which we’ve already touched on earlier in this chapter. It refers to
nudes in which the face, and thus the identity, of the model is kept from the
viewer, in order to focus the viewer’s attention on the more formal qualities
of the image or the human body, such as shape, contour, texture, and line.
One of the greatest exponents of this style was the American photographer
Imogen Cunningham (1883–1976) in, for example, the series Triangles and
Two Sisters. Images may be cropped in tightly to a detail of the body, or they
may simply be shot from behind, as in Figure 2.105, a pose whose physical
instability seems to suggest both strength and vulnerability.
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Figure 2.105 An anonymous
back view.
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In the starkly lit Figure 2.106 the model’s hair is wrapped round her head in
a way that directs our attention to a whole series of contrasts and similarities
between hair, skin (and even the veins beneath the skin), and rock. The 
technique for monochrome conversion used here adds to the impact by
emphasizing the flecks of grit adhering to the model’s skin, making her seem
at once part of the landscape yet distinct from it.

Figure 2.106 Figure in a landscape. 
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In the next example, Figure 2.107, the silver belts and dark background
emphasize the curves of the model’s torso.

Figure 2.107 Strong positive
and negative shapes within the
frame.



One way of finding interesting bodyscapes is to set a simple pose and then,
working close to the model, use the camera to conduct a grid search so to
speak, working systematically across and down the model to find shapes
within the frame that are worth exploring and developing. In Figure 2.108,
for example, the first version didn’t include the arms and hands; I owe this
image to model Natalie, who moved into this graceful pose while I was still
trying to work out how to improve the original idea.
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Figure 2.108 A graceful pose
heightened by careful framing.



Striking images can be made from unusual arrangements of limbs (as 
in Figure 2.109), from a careful framing combined with a treatment in 
postproduction which reduces the image almost to a line drawing (as in
Figure 2.110), or to a very simple but still erotically charged shape (as in
Figure 2.111).
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Figure 2.109 The model’s
rings provide a focal point. 

Figure 2.110 A minimal
image such as this needs the
black keyline to mark its bor-
ders.
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Figure 2.111 An unusual
framing for a familiar theme.

A more extreme camera angle, combined with very shallow depth of field,
can turn the familiar into a picture puzzle, as in Figure 2.112.

Figure 2.112 The intention
here is to engage viewers by
challenging them to read the
image.



Figures 2.113 and 2.114 come from a continuing project on body piercing.
I’m interested in the practice and processes of body modification and the 
culture that surrounds them. The first image is a detail of a corset piercing—
a self-explanatory description. The treatment of the image goes some 
way toward abstraction, simplifying but not removing skin textures, and
emphasizing the richly colored ribbons and their shadows. The second holds
the skin textures and juxtaposes the corset piercing with a real corset.
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Figure 2.113 The corset 
piercing and its lacings.

Figure 2.114 Juxtaposition.



A tight frame and shallow depth of field produce a psychedelic human 
landscape in this image from a body-paint shoot; see Figure 2.115. 

Disagreements During the Shoot
Not every disagreement comes about because you’ve somehow managed to
shoot the model showing “too much.” You may shoot at an angle where the
model knows from previous shoots that she finds the results unattractive. It
may be, for example, that if you ask her to arch her back, her ribcage becomes
very noticeable, and she’s uncomfortable with that. But sometimes the level
of the shot is the issue. You may be using shadows, rather than the placing of
the model’s hands, to keep a shot within the realm of artistic nude, rather
than nude, and the model may be concerned that, however artfully you 
control the shadows, the shot is too revealing. 
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Figure 2.115 Dazzling UV colors. 



Either way, because you’re shooting digital, you have the opportunity to show
the model, during the shoot, any shots which you feel may be problematic
for her. I’d always recommend doing this. It’s only photography, after all, and
it’s more important, in my view, to treat the model right than to sneak shots
which she won’t be happy with. 

After discussion and reflection, the model may agree that the shot’s okay; or
you may agree to crop the shot, or perhaps burn the shadows in deeper, or
just delete it. The results of your negotiations with the model will depend on
how strongly each of you feels about the shot in question; what’s essential is
that, whatever you agree, you keep your word to the model.

A different situation can arise with less-experienced models, however care-
fully both you and she consider and discuss the shoot beforehand. A model
who’s agreed with you to work to a higher level than she’s used to may get
cold feet as the shoot progresses and decide that she’s no longer willing to
work at that level. Indeed it’s not unknown for a model to feel uncomfort-
able, on the day, with levels she usually works to without difficulty.
Frustrating though this is, I don’t think it does much good to anyone for you
to insist that the model stick to what was originally agreed: Unhappy 
models don’t make good images. If you’re paying the model you should 
certainly feel entitled to renegotiate for a lower fee; if it’s a TFP shoot, you
may want to give her a smaller number of photographs than was originally
agreed. One way or the other, you may well decide not to work with that
model again, and if you found the model on a web site which includes 
a Model Reference Check system, you may want to add an objective and 
factual comment about her.
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It’s often said that photography is all about lighting. Certainly few things
determine the emotional and sensual qualities of an image more than the
lighting you bring to bear on it. Light can be hard or soft, high contrast or
low contrast. The light source can be on, next to, or opposite the camera; it
may be high up or low down. Light may be bounced back into the scene by
a carefully positioned reflector or soaked up by dark drapes. The choices you
make influence the feeling of the final image.

Your aim in lighting the model may be to achieve anything from a natural
look to something much more dramatic. Natural here refers to a style of
lighting that doesn’t draw attention to itself, but recreates the feeling of 
a space which is pleasantly lit by daylight. In Figure 3.1 the main light 
source clearly is the daylight streaming through the window, but there’s also
a reflector close to the camera softening the shadows in the foreground. So
even here the photographer has to construct the natural look. Although you
can no longer see where the light is coming from in Figure 3.2, it has that
same natural quality. (Ways of achieving that natural look using artificial
light sources are described later in the chapter.)

In dealing with light sources other than available light, we’ll concentrate
mostly on the use of studio flash (strobe) lighting. Modern flash units of 
the monobloc type, which have all their electronics built into the flash 
head (from manufacturers such as Bowens and Elinchrom) are the most 
convenient design to use. Most units have variable output on both the flash
tube and the modeling light, so you can adjust the intensity of the flash
rather than having to change the position of the lights or adjust the lens 
aperture. Flash kits containing one, two, or three heads, along with stands,
cables, and attachments, are available. In a small studio, 500-watt heads are
powerful enough for most purposes, and while at times three heads might be
useful, two heads and a couple of reflectors work very well.
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Shadow
In Figures 3.3 and 3.4, on the other hand, your attention is immediately
drawn to a very forceful (and far from natural) interplay between light and
shade. This has been created by choosing a hard-edged light source (in these
examples, a Bowens 65º Maxilite reflector). In Figure 3.3 the shadows form
deep pools within which textural details are still just visible; and the barn
doors shape the light away from the model’s face, guiding the viewer’s 
attention to her torso and limbs. Figure 3.4 uses the same lighting setup with
a different pose, but the image has been grained in postproduction using 
a digital filter called Monday Morning from Nikon Color Efex Pro. This 
softens the edges of the shadows slightly, but at the same time increases the
contrast in the image.
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Figure 3.1 Window light 
balanced with a reflector.

Figure 3.2 The natural look.
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This chapter surveys some different light sources and the different lighting
styles they make possible. In general what distinguishes one type of light
source from another is the quality of the shadows they cast, in particular the
edges of the shadows and their density. Shadows from an on-camera flash
unit, for example, usually have hard edges and may be so dense that all detail
is lost in their darkest areas, as Figure 3.5 demonstrates; diffuse light may
produce faint shadows whose edges are so soft that they can scarcely be 
identified, as in Figure 3.6, where summer foliage spreading across the 
window which lights the scene produces a softly variegated effect. 

Figure 3.3 Using a hard-edged
light source.
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Figure 3.4 The same light
source after manipulation in
Photoshop.

Figure 3.5 Hard-edged
shadows, containing little 
or no detail.
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Another important consideration is the position of the shadow in relation to
the model. Harsh background shadows which surround the model are 
distracting. In Figure 3.7, for example, even with a relatively dark 
background to reduce their impact, the shape and pattern of the shadows
that surround the model make the image look messy and ill composed; it
draws attention to the fact that this isn’t natural lighting, but has been rather
crudely set up by the photographer. This is the result of choosing an 
inappropriate reflector for the flash head. Positioning the model right against
the background is always likely to produce close shadows, but soft-edged,
more diffuse shadows, such as a softbox (described later in this chapter) 
produces, are part of the natural look of a scene, as Figure 3.8 demonstrates. 

Figure 3.6 Scattered light and
shade.

Figure 3.7 Even the most
beautiful model will struggle 
to be seen against hard-edged
shadows like these.
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On the other hand it’s possible to come up with an image in which the shad-
ow is as important as the model. In Figure 3.9 the light source is positioned
low to project the shadow more strongly, and the rough surface of the wall
adds its own contrast to the texture of the model’s skin.

Other shadow effects are possible using a light source below the model. In
Figure 3.10 the main light source is a window located a couple of feet below
the landing on which the model is posed. The surreal and rather sinister look
of the image is heightened by the fact that the shadows look slightly off 
kilter because they’re being cast upward.

Figure 3.8 The model is still
close to the background, but
the shadows look natural.



Mastering Digital Nude Photography180

Figure 3.9 Projecting a shadow.

Figure 3.10 The window,
which is the main light source,
is slightly below the model.



Ugly shadows can also be cast onto the model. In Figure 3.11 the model’s left
arm and the straps and buckles create an incoherent set of shadows which, as
well as being unattractive in themselves, conceal the delicate groove of her
spine. Slightly repositioning the model, as in Figure 3.12, improves the image
by reducing the shadows and simplifying the relationships between them.
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Figure 3.11 The shadows add
confusion to the image.

Figure 3.12 A better-arranged
version.



Experimentation
As with so many other aspects of digital photography, it pays to experiment
and take risks with lighting. Not every shot will be a winner, but you’ll 
develop your repertoire of skills and methods. If, for example, you light your
model with a softbox from the side as your principle or only light, asking the
model to move toward you in small steps will produce different images shot
by shot as she passes the center line of the softbox and the shadows that the
light casts move across her. See Figures 3.13 through 3.15. 
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Figure 3.13 At the center of
the softbox.

Figure 3.14 Moving toward
the camera.
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Figure 3.15 Almost at the
edge of the softbox.

Another experimental approach is to keep the model in one position, and
vary the relative power of the lights in front of and behind her. In Figures
3.16 through 3.18 I’ve set up a softbox in front of and level with the model’s
head, and to the photographer’s left, with a backlight behind and above the
model’s left shoulder. In Figure 3.16 the camera-side light is dominant. In
Figure 3.17, as the back light is made relatively stronger, a more interesting
pattern of light and shade emerges on the model’s hips and the central line
of her belly. In Figure 3.18 that process continues.

Figure 3.16 Lit predominantly
from the front.
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Figure 3.17 Increasing the
backlight in relation to the
camera-side light.
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What makes an image well lit? It could be argued that technically a shot’s well
lit when the light varies in intensity from the maximum the camera can 
handle down to black; in other words, a well-lit shot is one which exploits the
full tonal range of the camera. Creatively, it could be argued that a 
picture is well lit when the scene achieves the photographer’s intended
effect—or to make the strongest impression on the viewer. Linking the tech-
nical with the aesthetic, we could say that an image is well lit when it shows a
full dynamic range, and the different light levels are all in the right places.

In Figure 3.19, for example, the full dynamic range has been used, but most
of the highlights are in the background, and there isn’t enough light on the
model. She isn’t backlit in a dramatic way or turned into a silhouette: there
just isn’t enough light on her because she’s too far forward and her body’s
angled away from the light. Moving the light round, as in Figure 3.20, 
provides a better balance, and puts the light where the image needs it to be.

Figure 3.18 Increasing the
backlight further.
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Figure 3.20 With the lighting
corrected. 

Figure 3.19 The right amount
of light, but not in the right
places.



And of course there are always exceptions to the rules. For example, an image
may contain either solid blacks with no detail in them, or blown-out high-
lights (or both), but may still work better than an image which follows only
the technical rules. The histograms for such images are characteristically piled
up at one end or the other (or both) with relatively little data in the center. 

Figure 3.21 is an example of contre-jour lighting (literally against daylight):
shooting directly into the main light source, which in this case actually is 
daylight. There’s a large, six-foot square, gold reflector near the camera. (This
reflector is white on one side and gold on the other. The gold side bounces
more light back than the white side does, but adds a distinct warm tone to a
color image. I was confident that this shot would end up monochrome, so
chose to use the gold side.) 

By moving the reflector backwards and forwards and adjusting the aperture
and shutter speed, I found a way of capturing the scene which retains the
highlights on model Naomi’s left thigh and breasts, while at the same time
holding the shadow detail around the legs of the chair and the skirting board,
and drawing attention to the extraordinary shoes Naomi’s wearing. As well as
the window itself, the texture of the floorboards under the chair is blown out,
but these seem to me to be natural elements which contribute a great deal to
the light, bright, summer mood of the scene overall.
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Figure 3.21 Contre-jour 
lighting, supported by a 
reflector close to the camera. 
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Photoshop
There are lots of occasions, then, when it makes sense to push lighting to the
extreme in this way. On the other hand, an image whose dynamic range is
restricted (one whose histogram doesn’t reach all the way from one side to the
other) will look flat and lacking in impact. That’s where Photoshop comes in.

Figure 3.22 is an example of a picture whose tonal range is narrower than it
needs to be. As the inset histogram shows, the image has no blacks in it. 
It’s an image whose delicacy matches the intimacy of its subject, shot with 
available light from a north-facing window. However, we can improve what
the camera captured by adjusting the exposure in Photoshop’s Camera Raw
interface. Doing so produces Figure 3.23, where the histogram demonstrates
that we’re now using the full dynamic range. Increasing the shadow value 
in Photoshop Camera Raw tends to make colors stronger, as well as 
extending the tonal range; I’ve slightly reduced the Saturation of the image 
to compensate for that. The corrected image has lost none of its original
qualities, but has gained an additional intensity.

Figure 3.22 The image as shot.
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Figure 3.23 After extending
the dynamic range.

This demonstrates a significant aspect of the digital era in photography:
Many elements of the final appearance, which were once mainly dependent
on lighting, can now be easily and seamlessly manipulated on the computer.
Photoshop contains a number of powerful methods of manipulating a shot’s
lighting: Not just the Render > Lighting Effects filters, but simpler methods
such as adjustment layers and blend modes, the Levels settings and
Brightness and Contrast controls or, as here, Camera Raw facility are all
invaluable. Taken all together, these processes are more powerful and flexible
than even the most sophisticated traditional darkroom. You will have in
mind, as you light a shot, the possible ways of manipulating and improving
its lighting which programs such as Photoshop make available. Except where
indicated otherwise, all the images in this chapter have gone through at least
minimal manipulation. On the other hand, Photoshop can’t create a lighting
state, so craft and skill of photographic lighting remain as important as
they’ve ever been. 



Positioning Lights
Intensity of light and shade is one key element in determining the impact of
an image; the position of the light is another. If you light your model from
the front you’ll see her clearly, with few or no concealing shadows between
her and the viewer. The image’s power will depend on how the model’s
framed and posed. If you’ve chosen a light source which creates only faint,
soft-edged shadows around her, there will be nothing to diminish the 
viewer’s pleasure in looking at the model. Figures 3.24 and 3.25 illustrate two
versions of frontal lighting. Note that, as the shadows indicate, the main light
source is positioned at an angle of around 45º to the camera, which ensures
that even with minimal shadows the light still molds the model’s curves. 
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Figure 3.24 Frontal lighting
with a dark background.
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Figure 3.25 A high-key image,
frontally lit.

On the other hand, if you light your model obliquely—let’s say with the light
source set at around 90º (or more) to the camera—you’ll create a richer, more
complex and intriguing blend of light and shade that molds limbs and
curves. The body is made more three-dimensional by lighting at this angle.
Perhaps the pleasure in viewing such photographs stems as much from the
image as an image, as it does from the image as a photograph of an attractive
model. Figures 3.26 and 3.27 illustrate the different qualities of oblique
lighting, using the same models as in the previous two images.



Mastering Digital Nude Photography192

Figure 3.26 The model’s form
is molded by oblique lighting.

Figure 3.27 A subtle interplay
of light and shade.



This solidity of form changes in interesting ways as the angle between 
camera and light source opens up, until you reach the contre-jour shot, as 
in Figures 3.28 and 3.21. Adding a little Photoshop work can produce a 
powerfully graphic image, with all the intermediate grayscale values of the
original expressed as either black or white; see Figure 3.29.
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Figure 3.28 The dramatic
look of contre-jour lighting.
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Backlight
Backlight is light aimed at the model from behind; backlight faces the 
camera. At a low level, its purpose is to add a small amount of light around
the model’s head and shoulders to make her appearance more three dimen-
sional, and also to separate her from the background. As the ratio 
of backlight to camera-side lighting increases, you move closer, again, to 
contre-jour lighting. Backlit images can be elusive and tantalizing, concealing
as much as they reveal, as Figures 3.30 and 3.31 demonstrate. 

This concealment also creates a deeper sense of intimacy, of a private 
experience shared with the viewer. Figures 3.32 and 3.33 are two versions of
a familiar scene. Figure 3.32 conveys the parents’ love for their child and each
other, but it achieves that effect mainly through the pose and the parent’s
expressions: The lighting doesn’t contribute in any significant way. Figure 3.33
similarly draws part of its impact from the inclined angle of the 
mother’s head and the baby’s gaze toward the camera, but the greater feeling
of tenderness in this image comes from the way mother and child seem to be
protected, cocooned almost, by the light and shade which wraps around them.

Figure 3.29 A purely black-
and-white image.



Lighting 195

Figure 3.30 The body in near
silhouette.

Figure 3.31 A backlight 
positioned high sculpts the
model’s body.
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Figure 3.32 A moment of
deep affection.

Figure 3.33 Here the lighting
contributes to the emotion of
the image.



Backlighting works well with double nudes because the subtle interplay of
light and shade it creates adds to the erotic sense of bodies and emotions 
fusing and uniting that such images imply. In Figure 3.34 the principle light
is a white brolly on the left, behind model Ginga Pixy; the hairlight 
which outlines model Eliz on the right is softened with a couple of layers of
diffusion material, and shaped with barn doors. The angled pose allows the
light from the brolly to catch the models’ eyes, which are as shot, with no
enhancement in Photoshop.
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Figure 3.34 A single gaze from
two models.



Depending on the environment you’re working in, you may need to use a
camera-side light to balance the backlight, or you may find that a carefully
positioned reflector is sufficient, as in Figure 3.35. In Figure 3.36, similarly
lit, the tangle of limbs and their shadows forms a picture-puzzle which 
gradually resolves itself.
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Figure 3.35 A reflector 
prevents the foreground 
shadows from filling in.

Figure 3.36 A pattern of limbs and shadows.



Figures 3.37 and 3.38 depict moments of passionate intensity. Figure 3.38
has been manipulated in Photoshop to give it the feeling less of a photo-
graph than a nineteenth-century lithograph, but its essence is the steeply 
angled, fairly hard-edged backlighting which creates a vivid, almost tangible
sensuality.
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Figure 3.37 Tenderness con-
veyed by low-key backlighting.
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Continuous Light
Continuous light sources deserve a mention also. There’s a growing range of
well-designed cold light sources, based on fluorescent luminaires, such as the
Bowens 9Lite, which uses a 3 � 3 array of coiled fluorescents behind a sheet
of diffusion material to create a reasonably soft light source. Few sources of
this kind are as powerful or as flexible as modern flash heads (the 9Lite 
is approximately equivalent to a 1kw tungsten source), and their main appli-
cation in photography of the nude is to let you shoot motion-blur images,
where slow shutter speeds are essential. 

In Figure 3.39 I’ve relied on the Bowens 9Lite as the main light source, but
I’ve positioned a flash head, set to its lowest power output and with a double
thickness of diffusion material in front of it, behind and to the right of the
model. This makes it possible to freeze some elements of the image, even
with a shutter speed (after a series of tests) of 1/6 second (at f/7.1). In this
case the flash has frozen model Eliz’s hands as she spins toward the camera,
while the slow shutter speed captures the trail of the highlight from her ring,
as well as the spectacular swirl of her hair. 

Figure 3.38 Sensation
emphasized by lighting.
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Incidentally, the opposite effect is achieved by using flash, which stops the
movement of the model’s head and torso while retaining some blur in 
her hair. In Figure 3.40, the lighting is carefully balanced, with a backlight
lighting up the hair without casting shadows over the model’s face.

Figure 3.39 Motion blur lit by
a continuous light source.

Figure 3.40 Frozen movement.
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Shadowless Light
It’s not easy to produce totally shadowless lighting. In a large, well-equipped
studio, the usual approach is to position the subject 10' or so in front of the
background, light the subject with soft light sources, and blast a lot of light
onto the background to swamp any shadows. Lighting-equipment manufac-
turers produce translucent igloos for doing product shots for advertising,
which really do enable shadow-free lighting; and one manufacturer—
Lastolite—has recently produced one large enough to pose a model inside.

Completely shadowless lighting isn’t necessarily desirable in photography of
the nude. Shadows add character, orientation, and three-dimensionality to
the image: They ground the model so she doesn’t appear to be drifting in a
featureless void. This can be seen in Figure 3.41.

In my own studio I’ve found that simpler methods can be quite effective in
producing bounce lighting, in which shadows are reduced to a minimum.
My studio has a low ceiling (just over 10' high), which is usually a source of

Figure 3.41 Just enough 
shadow to give the image 
orientation.



irritation; but it makes it easy to set up a flash head with a set of barn doors,
aim it at the ceiling from a height of about 7', and get an even coverage of
light over an area about 10 � 10' at floor level. The light should be aimed at
a point on the ceiling midway between the light and the subject, and t
he angles of the barn doors can be adjusted to ensure that no light spills
directly onto the subject.

To make this setup work effectively it helps to have as many white walls as
possible, so I roll down the white paper background to cover one draped wall,
and place my 6 � 6' white reflector in front of the other one. The result is
very clear lighting, which has the natural and perhaps slightly 
characterless feel of a brightly and evenly lit room. Shadows are reduced to a
minimum because the white ceiling acts as a massive diffuser, scattering and
bouncing light in all directions, and the white walls surrounding the scene
increase that effect. In Figure 3.42 the vivid red of the sofa helps make the
image more punchy. Shadowless lighting also creates a luminous setting for
black models, as in Figure 3.43.
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Figure 3.42 The red sofa adds
impact to the shot.

Figure 3.43 Shadowless 
lighting emphasizes delicate
skin tones.



Candles
It’s not difficult to include candle light in an image, as in Figure 3.44, where
the position of the candles creates the impression that they’re the light
source for the photograph. In fact, a flash head on the right, with its beam
narrowed by barn doors and softened with diffusion material, is providing
99 percent of the light in the shot. Note that because the shot is very low
key, the candlesticks don’t cast the telltale shadows that would reveal the
existence of the real light source. 

That works well enough, in its context. But genuine candle light has a
uniquely soft, caressing, intimate look, and repays the perseverance needed
to get it to work. Candles are open flames, so safety measures are appropri-
ate: To capture the images in Figures 3.45 and 3.46, we worked in a clear
space in the middle of the studio floor, away from all drapes and free from
drafts, exercising great care when moving either the candles or the model.

For these images we worked with 10 candles, all but one of them out of shot.
In Figure 3.45 the other candles are stacked up on the steps of a ladder to the
right, and in Figure 3.46, seven of them are arranged in front of the model,
with two behind her. This is the image I like best from the shoot: The one
visible candle makes a convincing source for all the light in the image, and
the model’s hand curled round the candle integrates it into the shot.
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Figure 3.44 Creating the
impression of candle light.
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Figure 3.45 Lit by a stack of
candles out of shot to the right.

After some trial and error moving the candles around, the best exposure was
found to be 1/6 sec at f/2.8. I didn’t try to color balance the camera to the
candles, but left its white balance set to Auto. I did shoot a ColorChecker
chart, but the “correct” color looked so uninteresting that in the end I 
adjusted the color temperature by eye in Photoshop’s Camera Raw plug-in,
settling for something closer to the very red temperature of the picture as

Figure 3.46 Light in front of
and behind the model.



shot, rather than to the more accurate color produced by following the
ColorChecker. Figure 3.47 demonstrates the range of colors. You can also see
here the green hotspots produced by the candle flames’ refracting inside the
lens. Apart from removing those and resetting the color temperature, the
only other tweaks I made to the image were to brighten the whites of the
model’s eyes slightly.

Attachments
Attachments come in various forms.

Softboxes
Out of the box, flash kits are likely to contain, among other attachments, a
small softbox. The softbox provides a diffuse light source which, ideally, has
the same brightness at every point, although in reality the output of even
well-designed softboxes does fall off at the edges. When you use the softbox
for frontal lighting its shadows are so soft edged that it’s hard to tell where
they start, and even in their darkest areas retain detail. 

The softbox is an important tool for many kinds of photography of the nude,
and it’s worthwhile buying the largest size (6 � 3' isn’t excessive) you can
afford. Small softboxes may be easier to work with when lighting a model
from directly overhead, as in Figure 3.59 later in this chapter, but for more
conventional angles, bigger softboxes are better. It gives the light I prefer for
most of the studio photographs I take. 
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Figure 3.47 The color of the
image as shot (top), and after
using the ColorChecker to
white balance (bottom).



To create the even lighting which it achieves better than any other lighting
device, the softbox should be aimed at the center of the scene, with its face
parallel to the subject. In Figure 3.48, the softbox is positioned high, and is
angled downward, creating a visible falling off of light toward the bottom of
the frame. The image doesn’t look badly lit, but in this position the softbox
doesn’t provide the even lighting I was aiming for. When the softbox 
is adjusted to the correct orientation and position, which in the case of a
standing pose such as this means being positioned vertically and aimed at the
model’s waist, the lighting is even from top to bottom, as can be seen in
Figure 3.49. In both images a white reflector on the viewer’s right lifts the
darker areas.
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Figure 3.48 When the softbox
is level with the model’s head,
the light falls away. 
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Figure 3.49 The model evenly
lit.

Figure 3.50 shows a typical setup. (The cat isn’t essential for the lighting to
work!) Note the vertical alignment of the softbox, which is also slightly
behind the model. By moving her a little closer to the reflector on the right
or to the softbox, I can control the balance of direct and bounced light across
her: A few inches makes a big difference. I can also angle the reflector around
toward me. A leg supports it when it’s not leaning against the wall.



It’s instructive to compare softbox light and shadows with north light. At its
best, the softbox provides a very satisfactory equivalent, as Figures 3.51 and
3.52 demonstrate. Figure 3.51 is lit from the window above the model’s right
shoulder, with light-colored walls all around providing some fill. Figure 3.52
is lit by a softbox on your right, with fill from the white background paper
and a small amount of additional light on the model’s hair.

Positioned obliquely to the subject, the softbox also provides great illumina-
tion to show textural details in skin. In the first of these examples (see Figure
3.53), the lighting creates a compelling and moving image out of the
model’s stretch marks—a telling demonstration of the difference between
conventional ideas of beauty and what makes a beautiful photograph. In the
second (see Figure 3.54), the different textures of skin, hair, and nails (in
this case, the model is a man in his late forties) are vividly reproduced. The 
softbox also works effectively in bringing out the sensuality of smooth skin,
as in Figure 3.55.
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Figure 3.50 Typical setup
using the softbox.
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Figure 3.51 Diffuse light.

Figure 3.52 Using a softbox to
create a similar effect.
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Figure 3.53 A different beauty.

Figure 3.54 Soft lighting
emphasizes textures.



Big softboxes positioned on the far side of the model work well for rim-lit
shots. The softbox itself can be used as a white background, as in Figure 3.56.
It’s positioned by trial and error to light the curves, here, of both buttocks,
without creating refraction patterns inside the lens and without blowing out
the edges nearest the softbox. In this position the softbox also shadows the
deep furrow of Naomi’s spine. The composition is suggestive of a yin-yang 
symbol. Posing the model against a dark background, and repositioning the
softbox out of the frame, we can create a different rim-lighting effect, with
the illuminated curves standing out against the black, as in Figure 3.57.
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Figure 3.55 The sensuality of
smooth skin.



Mastering Digital Nude Photography214

Figure 3.56 Rim lighting with
a bright background.

Figure 3.57 Rim lighting with
a dark background.



A small softbox positioned above the model’s head gives a different look. 
To position the light so that it’s facing straight down I hang it from a sturdy
ringbolt screwed into a ceiling beam in my studio; an alternative is to use a
securely weighted tripod with a boom arm. By itself, the softbox will light the
shoulders too strongly, so a reflector needs to be used as well.

Once the light’s set up, it’s a matter of finding the best position for the model
underneath it. In Figure 3.58 light from the reflector catches model JadedRed’s
eyes, as well as molding her curves attractively. A different head angle works
well in Figure 3.59, lighting her eyes from the softbox itself (and with the
reflector backed off slightly), but in Figure 3.60, after I’d asked JadedRed to
shuffle backward barely a couple of inches, the play of light and curves has lost
most of its subtlety. Softboxes typically have a reflective inner surface and two
diffusers: an internal one as well as the front surface. You can experiment with
different combinations of these, as well as remove both and use the softbox’s
reflector by itself.
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Figure 3.58 Reflected light
catches the model’s eyes. 
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Figure 3.59 Here, light from
the softbox catches the model’s
eyes.

Figure 3.60 A small change in
the model’s position makes a
big change to the image.



On-camera Flash
The built-in flash on most cameras isn’t really a serious light source: It lacks
power and leads to red-eye. On-camera flash units, on the other hand, 
have their uses. You can use a unit which has variable output as a fill light,
particularly working outdoors, but you’ll get better results and make more
interesting shadows if you take it off the camera. In Figure 3.61 I’ve mount-
ed the Nikon SB800 flash unit on a tripod to the right, adding extra punch
on a bright but overcast day. The slightly hyperreal look of the lighting works
well with the setting and the model’s pose and fantasy makeup.
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Figure 3.61 Horizontal 
shadows from a fill-in flash add
a sense of unreality.



You can also bounce a sufficiently powerful on-camera flash off the ceiling if
your studio flash units aren’t available, or experiment with a diffuser cover for
it. Or you can exploit the flash’s intrinsically harsh, hard-edged journalistic
feel, and go for a paparazzi look, as in Figure 3.62, where the model’s caught-
by-surprise expression contributes to the impression the image conveys. I’ve
heightened the unfriendly effect of the lighting by pushing the shadows
down a little further. Again, this was shot with the flash unit mounted on a
tripod a little to the right of the camera. In instances such as these, the 
on-camera flash unit provides an effective light source which is both 
cheaper and more easily handled on location than a standard studio flash
head driven from a portable power supply.
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Figure 3.62 In the style of the
paparazzi.



Other Attachments
Like lenses for cameras, there’s almost no limit to the different reflectors and
other attachments you can buy to enhance your lighting kit, as a quick
browse through the manufacturers’ web sites will reveal. Apart from buying
bigger softboxes and several square feet of diffusion material, I work with a
couple of attachments with my Bowens two-head 500W kit. This is the
120º wide-angle umbrella translucent reflector you can use as a diffuser to
shoot through, as well as a silver reflector cover for the brolly, and a Maxilite
reflector with barn doors. The wide-angle umbrella reflector, which can 
be used by itself, has a highly polished reflective surface; the Maxilite’s
reflective surfaces are duller and stippled. Highly polished, reflective surfaces
combined with a narrow diameter produce intense, hard-edged shadows like
those in Figure 3.63.
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Figure 3.63 A highly polished
reflector casts crisp shadows.



Apart from its usefulness in casting intentional shadows, the umbrella 
reflector seems to me too brutal for most photography of the nude. Shooting
through its white brolly, however, softens its shadows, which are still harder
edged and denser than the softbox. This works particularly well in creating
pools of light and shade in images such as Figure 3.64, but is perhaps less
appealing when used as a main frontal light source, as in Figure 3.65.

Mastering Digital Nude Photography220

Figure 3.64 Using the brolly
in a backlit image.



The barn doors on the Maxilite reflector allow its beam to be narrowed
down—for example, to create shadowless lighting or to provide a hairlight
like that in Figure 3.66. By itself, the Maxilite’s light is rather too harsh to use
as a hairlight but it can be softened by clipping one or two thicknesses of 
diffusion material onto the barn doors. Diffusion material, principally 
produced for use in film and video lighting, is available from manufacturers
such as Lee (www.leefilters.com) and Rosco (www.rosco.com).
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Figure 3.65 Brolly light is
harsher than the softbox.

Figure 3.66 Barn doors pre-
vent light from the hairlight
spilling onto the background.

www.leefilters.com
www.rosco.com






Taking pictures during the shoot involves many aspects: planning, preparing,
posing your model, and finding interesting angles and frames; deciding on
locations; furnishing the studio; choosing from the dressing-up box. Other
considerations include working with your model before, during, and after
the shoot.

Planning and Ideas
Where do ideas for images come from? Different photographers give 
different accounts. Talented young Floridian photographer Chris Oakley
neatly summed up the interweaving strands of his creativity:

I’m always reading books on photography, and there are always shots that
catch my eye. I use them for a basis (not to copy them). It could be 
the pose, the lighting, the contrast…just something that gets my mind
thinking about integrating something in there which I like, into my shot.
Once that process starts, it takes on a life of its own, and grows into what
I will capture. I’ve trained my imagination to develop scenes: I can 
actually build an entire shoot (lighting, costume, makeup, location, etc.)
in my head and see it just as it will appear when I shoot it. When I plan
something out in my head there’s no guesswork; everything in the shoot
is set up as I [envisioned] it. And when I know for a fact I have the whole
setup the way I planned it and want it, I shoot very instinctively and 
follow the model, reading and anticipating her poses and emotions.

Chris clearly expresses here what seem to me the three main components 
of photographic creativity. The first is the photographic and visual environment.
We’re all of us inevitably influenced, more or less consciously, by the endless
flow of images all around us. Chris seeks such images out, as part of the 
development and growth of his art as a photographer. The visual environment
also includes the real world around us. If you live in an area where seasonal
change makes a big difference to the light and to nature, your ideas for 
location shoots are bound to be shaped by the time of year.

The next element is imagination: the photographer’s ability to assimilate and
transform those found ideas and images into something new and distinctive,
within a carefully considered framework of lighting, location, and so on.
Imagination isn’t a rational, thinking process so much as a subconscious,
intuitive one making connections while the conscious mind is busy doing
something else. 

And the final element is awareness, by which I mean the photographer’s 
ability to respond to what actually happens during the shoot, allowing 
immediacy and spontaneity into work already partly shaped by environment
and imagination.
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Although in terms of our own practice of photography each of us would
probably emphasize differently each of these three elements, we need to keep
them all in mind as we shoot. Clinging too much to a preconceived plan, we
may fail to notice marvelous but fleeting poses and expressions from the
model, and distrust our intuitions in the moment. At the same time, going
into the shoot unprepared is, in effect, expecting the model to do all the work
for you. A good, experienced model with a wide repertoire of poses won’t dis-
appoint you, but who really created the resulting photographs—you or her? 

So developing ideas and planning for the shoot go hand in hand, whether you
work your ideas out in your head, as Chris does, or keep a notebook of themes
and ideas, as many other photographers do. As your experience grows, you
acquire a repertoire of techniques, approaches, and working methods in which
you have confidence, and can adapt and combine to express the theme you’re
working on and to respond to what you see and feel as the shoot progresses.

One theme, for example, might be creating bodyscapes. Another might be
setting the model in a dominant position: shooting powerful poses from low
angles. You might choose to shoot one set in a limited location, such as one
corner of a room, giving the model scope to find different poses within that
constraint, which you combine with a specific style of lighting. Figure 4.1
exemplifies this. Being positioned in the corner gave Jessie a feeling of 
confinement, which she responded to by drawing even more closely against
the wall. The scene was lit by a small flash head bounced off the wall out 
of shot to the left, creating the feeling of an image illuminated only by 
window light. 

Figure 4.1 Model Jessie posed
in the corner.



Another approach might be to work with available light; another might be to
shoot silhouettes; another might be to set up your lights to give virtually
shadowless illumination; and so on. The purpose of approaching the shoot
in this way is to provide a framework within which you can operate with
assurance, moving toward goals you and the model both understand. This
also helps project a sense of purpose to the model, to encourage her to keep
focused on the work.

Once you’ve evolved the theme or themes for your shoot, many aspects of
planning are straightforward, although they can be time consuming. There
are the hours you spend on the Internet, in online chat, on the phone, 
writing emails, signing up a model, discussing ideas, pinning down a date
and time, and confirming levels for the shoot. Then, locations need to be
secured, the studio set up, and lights, storage cards, and lenses checked; 
perhaps you wish to book a makeup artist; and so on. You may want to hire
additional equipment, like the fish-eye lens I use for one of the summertime
location shoots described in this chapter, or negotiate with a body painter to
do a piece of collaborative work. 

Places to Shoot
In this section we’ll consider the range of photographic settings provided by a
commercial studio and by shooting on location. Then we’ll see what can be
done in an ordinary house and garden, and end by looking at the possibilities
offered by a home studio; see Figures 4.2 and 4.3.
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Figure 4.2 This was shot 
in my garden. The color 
treatment combines with the
enveloping foliage to suggest 
an escape into solitude, with 
an additional element of 
sensuality conveyed by the
model’s sandals.



Commercial Studio
Even if you have a home studio, you may be tempted to make occasional use
of a commercial studio. It may offer more space and equipment, as well as a
range of sets which you’d find difficult to create at home. If you don’t have
access to a usable space at home, then a commercial studio is even more
attractive, providing a controllable environment in which to work. In this
section I’m using, as an example, Photo-Studio, a small commercial studio
about 35 minutes from Cambridge. 

As a basic set of facilities for the photographer, a commercial studio should
offer the following things: 

� Up-to-date flash heads

� A good range of softboxes, umbrellas, snoots, and barn doors

� Reflectors, colored gels, and diffusion material

� A wind machine to blow the model’s hair about is also a common item
of equipment
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Figure 4.3 One of the features
of my home studio is its 
wooden floor. The floorboards
are pine and about 100 years
old. After experimenting in
other studios with highly 
varnished floorboards or 
laminates, I chose to stay with
this rougher, less-finished look. 



� Rolls of background paper in different colors (and possibly other 
backgrounds)

� A private changing space for the model 

� A well-lit area with a table for the makeup artist (mua) to set out 
materials and work effectively

Background rolls are regarded as consumables, and you should expect to pay
for the amount you use. Most studios will also offer free coffee or tea. And
the studio’s management should be discreet: quickly available when you need
them, invisible when you don’t. 

Typically the studio is divided into sets, as in Figure 4.4, where behind model
Eliz and mua Tess Mangan you can see the bedroom set, a sheet metal 
background, and a military set hung with camouflage netting. Photo-Studio
also offers office and classroom sets and a rustic barn set, complete with 
150-year-old oak beams. On this shoot we decided to use the bedroom, the
metal background, and the rustic barn.

If you haven’t seen examples of work done in the studio on its web site (or 
possibly even if you have), when you walk in and view the studio for the first
time you may feel disappointed: The sets, squeezed in next to each other, may
look unreal and unconvincing. With competent lighting, however, they’ll
come to life. Once you settle into working in this different environment and
your eye adjusts to it, the results you get can be of at least the same standard
as the rest of your work.
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Figure 4.4 Some of the sets at
Photo-Studio. 



It’s a good idea to check with the management how freely you can move
equipment and furnishings around for yourself, or whether the studio staff
expect to do that for you. By default studios tend to assume that you’ll want
to use fairly conventional, open, frontal lighting and organize their sets
accordingly, so you may need to move lights and even parts of the sets around
to achieve different lighting styles. In the bedroom set, for example, I wanted
to shoot into the light, which required the bed to be moved away from both
walls to make room for the flash head and to avoid light spilling from the edge
of the softbox creating a hotspot on the wall behind the model’s head; see
Figure 4.5. There’s also a large, silver reflector on the camera side of the shot
(and the encroaching column of the tripod behind the model’s hip was
removed in postproduction).

Makeup for the bedroom was a basic natural look, but we decided to be more
experimental with makeup for use in the other settings. The pattern of ridges
on the metal background and the hard, reflective properties of the metal 
suggested a design of cross-hatched lines of dark, iridescent body paint across
the model as Figure 4.6 shows. 

The pair of images I was most pleased with from this shoot were made on the
barn set, making use of nothing more than a few handfuls of the straw lying
on the floor. Figures 4.7 and 4.8 show the results, with the tight framing and
sepia toning evoking the early days of photographic erotica. The digitally 
created sepia toning also helps the carefully positioned straw blend with the
body makeup.
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Figure 4.5 Setting up this shot
required furniture and lights to
be shifted.
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Figure 4.6 The metal 
background is most effective
when it’s sharply in focus. 

Figure 4.7 Straw from the
floor of the barn, used…



Location
Location shooting is a stimulating challenge. Far from the security of the
studio, where the components of every shoot are well known and reliable,
location work may involve travel, extra expense, issues of access, the vagaries
of weather and light, the need for solitude, the fragility of equipment…. At
the same time, the location shoot also places the photographer and his
model in the real world, with its opportunities for originality, creativity,
imagination, and strikingly different images. A location may just be your
own back garden; it might be a barn or factory; or it might be the middle
of a desert. In each case (except perhaps the first) you won’t want to go back
for anything you’ve forgotten, so preparation is important.

Technically the greatest challenges in outdoor location photography are to
do with containing the range of lighting intensities within a scene which
contains bright sunlight and deep shadows. Avoiding the vertical angles of
light and shade at noon helps reduce the problem, and a polarizing filter can
make a huge difference also. Polarizers work best when the lens axis is at
right angles to the direction of the sun: They have little effect when you’re
shooting straight into the sun or have the sun on your back. In Figure 4.9
the sun is to my left, and the polarizer holds the full range of tone and color
in the cloudscape behind the model.
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Figure 4.8 …to conceal and
reveal.
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The unpredictable flow of light and shade in outdoor location shoots makes
the histogram and highlight displays of a digital camera invaluable. Bright
sunlight and deep shadow push digital cameras to their limits, but at least the
photographer can tell what’s happening. The wonderful shadows across the
path in Figure 4.10 and the play they make with the model’s skintones
proved less than straightforward to capture: A lot of time was spent waiting
for just a wisp of cloud to drift across the sun, in the hope that it might make
the dynamic range more manageable. (And yes, that is a cyclist, complete
with faithful dog, coming rapidly into view at the far end of the path.) 

Shooting your images uncompressed rather than JPEG also helps here, as this
maximizes the dynamic range the camera can capture. This in turn makes it
more possible to improve the results in postproduction in Adobe Photoshop.
In Figure 4.10 I’ve used Photoshop to lift the highlights and midrange of the
image, while allowing the shadows to hold their intensity.

Figure 4.9 Using a polarizer.
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Choosing a Location
The locations you choose will be those which move you and stimulate your
curiosity. Coming to the U.K. as a young man, used to the vastness of the
Australian landscape (while at the same time being ignorant, as most
Australians were then, of its human history), I couldn’t fail to be struck by
the extraordinary diversity of the U.K. landscape and scenery, even in the 
shortest journey. Both natural and man-made features are densely packed
into this small country, and you quickly come to understand that almost all
the nature you see around you is far from natural, but is the result of human 
intervention. People have been making marks on this landscape for 
millennia, whether for agricultural, architectural, or ritual purposes. Living
in this landscape, and spending much of my free time exploring it on foot,
led to a deep interest in landscape history and painting, which in turn have
influenced my approach to photography. And this combined somehow with
my education in classical Greek culture, with its reverent awe for the forces
of nature.

Photography in this landscape thus becomes a way of creating a new, 
personal vision of what it is to be human, drawing and building on that long
tradition. The first set of images in the next section were created within four
miles of each other, yet draw on very diverse settings. I’d known the area in
which they were taken, not far from Stonehenge, for about six months
before the shoot, and had walked much of the ground in preparation. I also
worked with detailed maps to identify locations which were likely to have
deep vistas and varied growth. Even so, the day was full of surprises and
unanticipated opportunities.

Figure 4.10 Waiting for the
light: a traditional pastime for
the outdoor photographer.



In terms of equipment, the only special item I took with me was a fish-eye
lens. The overall theme for the shoot was to find as many different settings
within a small area as I could, as a series of reflections on the balance and
scale of the human figure against the English summer landscape and sky.
Initially I envisaged doing some shots with a wide-angle lens, to manipulate
the scale of the natural setting within which the model appears. Eventually 
I decided to rent a fish-eye lens to maximize that effect. As so often, the 
reality worked out rather differently. The morning was very bright, with
almost no cloud. Without a polarizing filter for the fish-eye lens (such a thing
is prohibitively expensive), it wasn’t possible to get enough detail and color
in the sky to make the image work as I’d wanted it to. In the end, the shots
which work best made use of the glitter of the water, with less emphasis on
the sky. Figure 4.11, with its distant swan, illustrates this. With a standard
lens and polarizing filter back on the camera, the limpidly clear water of the
stream provides scope for a range of poses, as Figure 4.12 illustrates.

The rolling fields and rough pastures provided a number of opportunities,
some of which benefited from diverse treatments in postproduction. Figure
4.13 is such a shot, except that the seven-strand barbed-wire fence which
marks the field edge and ran right across the foreground has been removed.
This clean-up job makes clearer the harmony between the model’s skintone
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Figure 4.11 A helpful swan
adds to the composition of the
shot.



and the color of the grasses on the field edge in the afternoon light, as well
as the connection between the flow of the grass and the model’s hair in the
breeze. In Figure 4.14 the model’s pensive pose and the sense of solitude, and
engagement between the human figure and nature, are enhanced by the
warming effect of digital sepia toning. It’s an image which evokes the spirit
of an ancient Greek landscape, with the model in the role of the goddess
whose benevolence ensures fruitfulness and survival. 
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Figure 4.12 Venus emerging
from the river.

Figure 4.13 Deep views across
the English countryside.



The diminutive scale of the human figure against the mature trees in the
background in Figure 4.15 is balanced in the image by the opposing contrast
of light and dark. The high-contrast treatment of the image also catches the
gleam of light on the foliage. A softer treatment of light and texture is more
appropriate to this meditative image (see Figure 4.16) in which human 
mortality and physical beauty are juxtaposed. Just as Figure 4.14 evokes
ancient Greece, so this image derives from a painting by the 18th-century
artist Poussin, in which a group of shepherds in an idyllic landscape gather
around a tomb, clearly reflecting on the transience of their own existences.
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Figure 4.14 From the ancient
world.



Other Locations, Other Models
A worked-out lime quarry provides a location with a very different feel to it
(see Figure 4.17). The wide swathes of bare chalk have a harsh, almost lunar,
quality and the cliffs and scrubby trees have an arid look very different from
the English countryside we’ve seen so far. The day was windy, with periods of
bright sun and fine cloudscapes—again, shot with the help of a polarizing 
filter, which also helped keep the brightness of white chalk on the quarry floor
within manageable limits; see Figure 4.18. It’s worth noting that the effects of
a polarizing filter are amongst the hardest to mimic in digital postproduction.
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Figure 4.16 Reflecting on
youth and eternity.

Figure 4.15 A study in light
and shade.



Mastering Digital Nude Photography238

Figure 4.17 A deep view of
the location.

Figure 4.18 The polarizer
takes the glare off the chalk.



Chalkland is home to numerous species of wildflower, many of which have
returned to the quarry since it was abandoned: they contribute to a more
intimate image in Figure 4.19. An unused agricultural building, in Figure
4.20, creates a very different mood again. Its rigid, straight lines, harsh 
textures, and stark emptiness are offset by the softer play of light entering
through the open end and side of the building and through roof lights. 
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Figure 4.19 The spider is a
happy accident!

Figure 4.20 Pools of light.



Around the House
Moving between varied locations provides good opportunities to experiment,
diversify, and create a varied portfolio. There is in any case a great attraction
in domestic environments which look natural and real, so I’m going to 
take you on a photographer’s guided tour of my terrace house in Cambridge,
U.K., to demonstrate some of the opportunities even a small dwelling offers.
Mostly this is a series of exercises in using available light (see Figure 4.21),
though of course it’s always possible to work with flash heads anywhere
indoors, not just in the studio.

At the same time, for all their attractiveness, such locations may suffer from the
disadvantage that they’re too cluttered with all the signs of everyday life to work
well without a certain amount of adjustment and simplification, and that also
needs to be allowed for and carried out. It’s a question of getting the balance
right: If you strip out of the frame every item which forms part of domestic life,
the picture takes on a studio look. (Nothing wrong with that, of course!) If you
fill the frame with too many distractions, the model might as well not be there.

Compare the images in Figures 4.22 and 4.23 which illustrate both sides of
this dilemma. This idea started with the view from my kitchen window on a
wet summer day, the beautiful light coming through the window and the
interesting Mexican tiles below it. But even after managing to bounce
enough light back from the camera side to light the model the way I wanted
and to make the scene look natural, the picture still wasn’t satisfying and
needed a fair amount of postproduction work to eliminate or modify its 
distractions. (In fact, I’d put this image aside after the shoot, over two years
ago, because it seemed likely to need so much work, and only reconsidered
it when I started to look for examples for this book.)
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Figure 4.21 Available light
from a large window is hard to
beat for the sensual, romantic
look it gives.



I rotated the picture in postproduction to level the edge of the windowsill and
remove that tangle of wires, the shiny brass security lock on the window, and
the electrical outlets on the right. (With hindsight, it might have been a good
idea to remove the window catches as well.) I’ve carefully blurred the more 
distant surfaces of the window frame and the view through the window (a 
different amount of blurring for each). As well as creating a better sense of
depth, this also has the effect of losing those distracting raindrops on the pane.
The eye is now able to concentrate on the model and the contrast between her
curves and the shapes and patterns of the tiles. 
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Figure 4.22 Using a real
domestic location, with its
inevitable distractions.

Figure 4.23 This is more what
I envisioned when I set the
shot up. 
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Any dwelling is likely to offer a range of possible locations, each with its 
particular qualities. In Figure 4.24 a different window, partway up the stairs,
enables me to shoot from a low angle, which emphasizes the curves of the
model’s hips. In this example I haven’t used a reflector: The stairwell is fairly
narrow, and the wall out of shot on the viewer’s right is painted a pale color
and reflects sufficient light to make the image work.

I shot half of this set with the lily prints in position on the wall behind the
model, and half without. Along with the window frame, they seem quite
effective in creating an uncluttered sense of a real domestic space. (There’s
actually a third lily print on the wall, above the two seen here. The top edge
of this image cut through it, so I removed it postproduction.) The window
overlooks a quiet side street and is high enough off the ground not to draw
attention to the model.

Figure 4.24 Working on the
stairs makes it easy to shoot
from low angles.
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Like many British terrace houses, mine has a bay window in the living room
at ground level. The bay faces north, and as there are no tall buildings 
opposite, it provides bright, diffused lighting. A sofa positioned in the bay
window catches the light well, and because the house is set back from the
road behind a shallow garden, models positioned here don’t attract the 
attention of passersby; see Figure 4.25. (There’s a slight cheat here. The view
through the window is taken from a different shot in the same set and 
combined digitally with this interior, because I like the coat of the passerby,
which closely matches the color of the sofa.) So exploring the house reveals a 
number of possibilities for using it as a photographic setting, relying simply
on available light. And then there’s always the bathroom and the bedroom.

Wetting the skin—with water, oil, or mud, for example—adds to the 
sensuous appeal of the image. The bathroom’s an easy and safe place to work
with water in your shoot. Figures 4.26 and 4.27 show where I’ve covered the
wall tiles around the bath to get a less distracting background. In the first
example the cosmetic mud needed to be kept wet, or it would dry to an 
unappealing, pale color. I was assisted here by an artist friend of the model’s,
who daubed and painted and sprayed water on the model while I clicked
away. In the second example I’m using aluminized plastic sheeting as a back-
ground: It reflects light back into the shot and provides a beautifully frag-
mented reflection of the model as well. 

Figure 4.25 Passersby pass by.
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Figure 4.26 Working with wet
cosmetic mud.
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Then there’s the bath itself. A white bath in a white bathroom can be a 
frustrating location to shoot, with light on all sides killing shadows and 
making images look flat; and the bath itself reduces the range of camera
angles. In my bathroom the main available light comes through a tall 
window at the faucet end of the bath, so I hung a black velour drape on the
wall at the opposite end of the bath and along the wall at the other end to
kill some of the reflected light. 

This would have worked fine for a conventional girl-in-the-bath image. But
what caught my eye as we worked was the way the water eddied around the
model when she moved. After some experiments, with the model’s husband
sending the water swirling over her, I settled on a shutter speed of 1/6 second
(at f/5.6). The water was moving fast and rather unpredictably, so I improved
the chance of getting a couple of good images by switching the camera into
continuous shooting mode. In the end we took 100 photographs in less than
5 minutes.

The two images shown here demonstrate the very different moods that
result. In Figure 4.28 the body seems hard and unyielding as the water is
driven around it. (The apparent shadow of a bird flying over the model is
actually the partially visible gothic cross tattooed in the small of her back.) In
Figure 4.29 the body is inundated by the almost sexual energy of the water.

Figure 4.27 On reflection.
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Figure 4.28 The body resisting.

The bedroom is another frequently used photographic setting, for obvious
reasons; see Figures 4.30 and 4.31. The smooth regular curves of the ornate
wrought-iron bed frame adds to the voluptuousness and dynamism of the
couple’s entwined bodies in the first example, and is visible in the mirror in
the second example. 

Figure 4.29 The body yielding.

Figure 4.30 Exploiting the
curves of the bed frame. This
image was suggested by
Gustave Courbet’s great 
painting Le Sommeil (1868).
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Home Studio
The final stop on our guided tour of the house is the home studio. I use this
term for what is, in fact, a temporary conversion of my living room. Setting
it up as a studio involves hanging dark, full-length drapes on two walls and
using the same fittings that support the drapes to set up rolls of background
paper. I then take up the rug which normally covers the wooden floor. 
The roll of background paper is the easiest way to achieve a flat, bright 
background. Light-colored drapes show every wrinkle and shadow.

Originally I draped all three walls, but then discovered that just two dark
walls at right angles to each other work fine, and that it is useful to have some
light bouncing off the third, white wall behind the camera. The drapes can
also be opened on one wall to enable me to use window light. In Figure 4.32
the dark drapes provide a strongly contrasting background for the model’s
skin tones, and the window provides the principle light source with a 6 � 6'
reflector opposite it.

Figure 4.31 The mirror fixings
are shimmed at the top so that
the mirror angles slightly
downwards, making shots like
this easier to achieve.
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But why work in a studio? The argument against the studio nude is that the
studio is an unreal and artificial setting that represents a convention that has
been worn out and overused since photography began, and that studio 
lighting draws attention to that artificiality. The factual part of the argument
is certainly true: The studio is an unreal setting, and countless nudes have
been shot in studios (just as in earlier ages countless nudes were painted in
studios). But while the tradition may be old, it isn’t necessarily exhausted:
The photographer’s imagination, vision, and skill can still find new things to
say, and new ways of appealing to and moving the viewer. Studio images can
also acquire an extra richness precisely because they belong to that long 
tradition. In Figure 4.33 the pearls, fake fur, and model’s voluptuous look
evoke the tradition of nineteenth-century French erotic studio photography
and painting, reframed into a more modern white space. 

Figure 4.32 Working in the
studio with available light
(f/4.5 at 1/15 sec).
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I’d hate to be confined to the studio environment forever, with no opportu-
nity to shoot elsewhere, but there’s no doubt the studio remains a valuable
resource for every photographer. There’s more excitement, but also more
frustration, in location shooting—all that time spent waiting for the light to
be right, for example, and, on a nude shoot, finding suitable and safe 
locations. The more your eye and attention to detail develops, the more 
frustrating and limiting it can be to have to work in environments where too
many variables are outside your control. Think of working on location on a
windy day, with clouds whipping across the sun (and the model’s hair 
whipping across her face) as you try to set the aperture. There’s a balance to
be struck here, between the vividness of the real world and the more austere
look of the studio; and between the intractability of the real world and the
precision of the studio. 

The strongest argument for working in a studio, then, is the control it 
provides over both lighting and the image’s whole visual environment.

Figure 4.33 An image which
evokes a long photographic 
tradition.
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Furnishing the Studio
The idea of creating a home studio came about because my nearest 
commercial studio is nearly an hour’s drive away, and I have to pay to rent it.
Even the endless supply of free coffee provided by the management doesn’t 
diminish the inconvenience of having to pack and take with me everything I
might possibly need that the studio doesn’t have. I don’t mean lighting or
other photographic equipment, but things like furnishings and garments for
the models. (See “The Dressing-Up Box” later in this chapter.) 

The furnishings in my studio are pretty basic, because I have limited storage
space and need to be able to turn the studio back into a living room when
I’m not shooting. I have a few chairs and stools of different styles, as well as
a 1930s chaise lounge, whose shape produces distinctive reclining poses. The
living room also contains two red leather sofas, as well as a large pine chest.
None of these were bought with photography in mind; in fact, the color 
of the sofas makes it difficult to use one of my preferred techniques for 
converting color to monochrome on any image in which they appear,
because it bleaches out to an unattractive pale grey. But all have their uses. 
As well as these items of furniture, I keep lengths of fabric of different 
textures and colors. In Figure 4.34 swathes of muslin give the whole studio a
completely differnt look. In Figure 4.35 a length of richly colored velour
transforms the chaise lounge.

Figure 4.34 Altering the 
studio’s look.
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The Dressing-Up Box
Why would a photographer of the nude need a wardrobe? Maybe you don’t
if you only ever shoot pure nudes, but if you have an interest in the partial
nude, it’s worthwhile building up a collection of suitable garments. (This is
in addition to the clothes and shoes you’ve arranged for the model to bring.)
Your specific tastes and preferences may differ from mine, but I think the
principle of building up an inexpensive collection makes sense for every 
photographer in this field.

Over the years I’ve accumulated a range of clothes in lace, net, and other sheer
materials, gloves, scarves, and shoes, mostly bought secondhand or on sale.
There’s a wonderful vintage clothing stall on Cambridge market which, over
the years, has produced some great bargains. Most models, not surprisingly,
love dressing up, and will become absorbed in the contents of the dressing-up
box. Many will find something which strikes a chord with their own fantasies.
This can lead to great images as the model puts that special something extra
into her poses, as in Figure 4.36.

Figure 4.35 Different 
coverings make the chaise
lounge a versatile prop. 



Mastering Digital Nude Photography252

Figure 4.36 I thought I’d
never get Alex to remove the
red gloves!

Models are often happy to lend each other garments for a shoot, as in 
Figure 4.37.

Figure 4.37 In this, her first
shoot, Claire is wearing a 
spider-web dress from my
wardrobe and a corset 
belonging to Jackie, who 
introduced me to her.



Some garments hang around for months until an opportunity to try them
out arrives; see Figure 4.38. 

The “Slut” top, despite or because of its unusual graphics, is also a favorite
with many models. In Figure 4.39 Naomi’s “Don’t mess with me!” gaze and
severe hairstyle create a teasing and ironic contradiction of the top’s apparent
message.
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Figure 4.38 Zoey’s distinctive
and contemporary look seems
paradoxically to work with this
1920s-influenced lace dress.

Figure 4.39 Typography as
fashion statement?



Mastering Digital Nude Photography254

Corsets are a favorite theme for many photographers. There’s no point for a
photographer in owning huge numbers of them, however, because corsets
have to fit properly if they’re to photograph well. It makes better sense to rely
on using the model’s own. Under-bust corsets may be an exception to 
this, and a 24" under-bust corset—one which reduces the model’s waist to
24"—has proved very useful. The others in my collection (of four) fit some
models, but not others. With practice it only takes a moment to try a corset
out on a new model. See Figure 4.40.

The dressing-up box also includes a couple of synthetic fur jackets; see 
Figure 4.41.

I also collect jewelry, but this can be an expensive pastime; see Figure 4.42.

Figure 4.40 The corset 
emphasizes the model’s curves
by narrowing her waist.

Figure 4.41 The contrast of
fur against skin forms a theme
in itself.
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Figure 4.42 Fake pearls don’t
quite have the luster of the real
thing, but Rosie’s mischievous
expression more than makes up
for that.
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Rather than build up a vast collection of expensive pieces which would fairly
quickly become redundant (you can’t photograph everyone wearing the same
jewelry), I’ve developed agreements with a couple of local stores which deal in
ethnic and other unusual pieces to borrow from, in exchange for doing their
publicity and advertising shots; see Figures 4.43 and 4.44. 

Figure 4.43 Tia’s dark skin
tone beautifully sets off this
simple silver necklace and 
pair of bracelets from India. I
borrowed the pieces from a
shop called Nomads in
Cambridge for this shoot.
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Figure 4.44 A beautiful and
unusual turquoise piece, also
from Nomads.

Over time one can build up a very useful network of contacts with crafts-
people as well as stores; see Figure 4.45. Models often find shoots appealing
if they’re allowed to keep a favorite piece from the collection they’ve 
worn. It’s a variation on the time-for-clothes form of payment discussed in
Chapter 3.

Figure 4.45 For this shoot I
worked with John Rothwell, a
local silversmith specializing in
making body jewelry. 



Moving into the Shoot
Once you’re ready to start, you have different options, which you’ll want to
talk through with the model. If as well as nudes I’m intending to shoot the
model in garments which leave marks, such as corsets or fishnet tights, I 
prefer to leave those to the end of the shoot, to avoid the Photoshop 
clean-up work. On the other hand, if I have the sense that the model would
prefer to ease into the nude sets gently (keeping in mind that at this stage she
and I may have only known each other face to face for about 20 minutes),
then I’ll look for some clothed or partially clothed themes to pursue. 

If I feel that the model’s particularly tense, I may suggest that she and I do a
few shoulder-rolling exercises to unwind. This also gives me a chance to talk
about posture, and in particular about how important it is to keep the spine
long, strong, and straight in most poses, while keeping limbs soft and relaxed. 

I also remind her that there are really only two rules in my studio. The first
is that we’re there to have fun. We’re going to work hard, but if the whole
experience isn’t enjoyable for both of us, that’s a sign that I’m doing 
something wrong. And the second rule is that if I ask her to take any pose
that she’s not happy with, she must feel free to tell me so, so that I can change
the pose to keep her comfortably within her limits. We will almost certainly
have discussed both these points online, but they’re always worth repeating.

My goal in the first half hour or so of a shoot, particularly with a new model,
isn’t to produce great pictures. That, hopefully, will come later, as the shoot
develops. At the beginning, I’m aiming to get used to handling the camera
again (I know, it’s foolish!), to get the lighting setup right and, most 
importantly, to discover how best to develop a rapport with the model 
and to build a relationship of trust with her. The most difficult part of 
communication is receiving, not sending, messages, so this means not only
giving instructions, but also noting how she responds to them, picking up on
her comments and on the subtler body language which indicates how she’s
feeling about the whole process. And, of course, I’m also trying to learn about
the model’s appearance: what angles work best, how flexible her body is, how
the camera “sees” her skin, and so on. I also assume with every model that I’ll
want to work with her again, so I’m trying to keep a mental note of other 
possible directions and themes to pursue, either later in this shoot or on a 
subsequent occasion. 

How do you set a pose? The simple answer: You explain to the model how
you want her to stand, sit, or lie. If (and only if ) the model’s agreed that you
may do so, you can touch her to adjust the pose; otherwise, you explain in
more detail until the pose is as you visualize it. With practice you’ll get your
and the model’s left and right the right way round more often than you 
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confuse them. (I’m still working hard to achieve that!) You may find that you
need to remind the model to keep her back tall, strong, and straight, and
check that she’s doing so just before you press the shutter. I find also that
even with experienced models it’s helpful to remind them to continue to hold
each pose and not to move the moment they hear the shutter trip. This lets
you check the shot on the back of the camera, and make any necessary
adjustments to lights, camera settings, or your position, without having to
reset the pose. As the shoot progresses, you’ll issue an almost continuous
stream of requests, in order to make small (but not necessarily minor) adjust-
ments to the pose: “Turn your head to your left…sorry, I meant your
right!…That’s a bit too far…that’s fine! Now look straight into the
lens…your left shoulder needs to be a bit lower…” and so on. Lift your eye
away from the viewfinder from time to time as you work, and look at the
model in the real world, not just as an image.

A note on touching: The quickest way to make minor changes to a pose is
often for the photographer to adjust the position of the model’s hand, arm,
or whatever. The rule is to always ask first! Some models are comfortable if
you hold them carefully by the shoulders, say, to adjust their pose; but 
others will simply refuse to allow you to touch them, so you’ll need to give
them verbal directions instead. If you’re doing a shoot where the model’s
agreed to be covered in something like oil, you may need to apply it to her
back: Tell her exactly what you’re going to do and make sure she’s okay with
it before you get started. It’s better to have a model laughing at you for being
overly cautious and repeatedly checking that she’s okay, than resentful, 
distressed, and uncooperative because you’ve overstepped the mark. (On a
practical note: If the model has a chaperone, it’s much better, with the
model’s agreement, to ask the chaperone to do the oily work. That way you
don’t have to worry about getting oil on your precious lenses.) 

In Digital Nude Photography I discussed the question of touching and received
some criticism for bothering to mention it: Surely every photographer, even
the most basic beginner, understands how to behave towards models? The
blunt answer, which every model will give you, is that not all photographers
understand. Apart from raising questions about the empathy and ethics of
some photographers, there’s a more pragmatic point to be made here. You
won’t get good pictures from a model who is stressed, upset, uncomfortable,
or angry. 

I’ve described this process so far as if it were a one-way flow of instruction
from photographer to model. In reality you can expect to get feedback from
a good model as you work—for example, when you show her images on the
back of the camera. She may also offer advice about the poses you’re asking
for, based on her ideas about which angles show her at her best. This isn’t
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advice you’re obliged to accept, but it shouldn’t be rejected out of hand. 
In addition to all of that, you should remember to check from time to 
time that the model’s okay—not too hot, not to cold, feeling comfortable
with the work, enjoying herself. All in all there isn’t a lot of peace and quiet
in the studio. 

You may also want to check with the model about any edgy shots you feel
may be overshooting her limits. Even a slight position change by the model
or camera angle may be more revealing than the model is happy with. Here
the camera monitor and the Delete button come into their own as a way of
helping build the model’s trust and confidence in you. 

As an example of how a typical shoot might run, here are some images from
my first shoot with Opal. When I first worked with her, Opal had only a 
little experience of nude modeling, but we’d been friends for some time, so
we already had good rapport. Her preferred way of working was to start off
in the robe and gradually shrug it off her shoulders, finding poses with which
she felt comfortable at each stage. See Figures 4.46 and 4.47.

As Opal became more comfortable with the shoot, the poses became freer
(see Figure 4.48), and over time we explored a wide range of different setups
(see Figure 4.49). 
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Figure 4.46 After changing
into a robe.
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Figure 4.47 The robe becomes
part of the shot.

Figure 4.48 The model relaxing into posing nude. Figure 4.49 Working with another model.



As we start to work, I’ll be carefully checking each image on the back of the
camera, set to display the histogram. I’ll also zoom in on the camera monitor
to check that I have the depth of field I want. I won’t show the very first shots
to the model, because they’re unlikely to be impressive: however many shoots
I do, it always takes time to get my eye in. But once I feel there are some good
images appearing, I’ll show them to the model so she knows what’s going on.
Often this produces suggestions from her as to how the pose could be
improved. Sometimes that will be an adjustment that the model feels will
show her to better advantage—you may not always agree with her!—but
sometimes it’s a new take on what you’re trying to achieve. It was SarahW’s
suggestion, for example, that helped me develop Figure 4.50—nice S curve
and hair and some erotic impact from the tights, but a bit of a cliché—into
Figure 4.51—the tights find a different use and the flying hair and SarahW’s
smile of pleasure make for a much more distinctive image.
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Figure 4.50 A familiar pose.
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As I work I’m also thinking about how the images might be manipulated in
postproduction. This may involve nothing more than a decision not to stop
to sort out a slightly untidy background because I know I can fix it “in post,”
and that’s preferable to disrupting the flow of the shoot. (On the other hand,
I may conclude that a couple of minutes spent fixing the problem in the real
world is preferable to much longer struggling with it in Photoshop.) Or it
may mean pushing the lighting levels up to lay the foundations for a 
high-key image. Overall, the deeper your skills in picture editing, the more
confidently you can approach the shoot.

The shoot will gradually fall into a rhythm: set a new pose, adjust the 
lighting, make some test shots (including the ColorChecker Chart), adjust
the pose and exposure until you have the image you’re looking for, check it
with the model; set a new pose…. Plan to take a break every 90 minutes or
so to offer the model something to eat and drink and to check with her that
she’s enjoying the shoot, to start downloading images, and also to give 
yourself a moment’s calm and relaxation. 

Figure 4.51 A different twist,
following up on the model’s
suggestion.



Shooting Faces and Expressions
What does each of the portraits in Figures 4.52 through 4.54 say to the
viewer?

Let’s reflect on how a viewer reads—attributes meaning, expression, and 
emotion to—the face of the subject of a photograph, whether it’s a nude or a
portrait. As viewers we have no way of knowing what the model was really
feeling in the 1/160 second in which the photograph was taken; instead, we
create an interpretation of the model’s expression, make up a story into which
the model and her expression fit, and take that interpretation and story to 
represent the truth of the model’s experience and emotions at that time.
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Figure 4.52 We seek to find
the meaning of facial 
expression, in a baby’s face 
as much as an adult’s.

Figure 4.53 Serenity? Challenge?
Detachment?

Figure 4.54 Defiance? Disregard?
Rejection?



As viewers, then, we respond strongly to facial expression. The nature of that
response is shaped not just by the expression in itself, but also by all the 
elements of photography which have been brought to bear on it: lighting,
camera position and angle, and so on. 

In the case of nude images, the way the viewer reads the model’s expression
will also determine how the body is read as a whole. From our point of view
as photographers of the nude, this is very important: By setting the model’s
expression, we can influence how the viewer reads the entire image. There
can be considerable differences between the readings different viewers give of
the same photograph, but in any shot which includes the model’s face, her
expression is a critical part of the image. So our discussion of how to pose
models begins with the face. 

There’s no such thing as an expressionless face. Some facial expressions may
seem to the viewer to have a clearer, more obvious meaning than others, but
if we can see the model’s face we will seek to read a significance into her facial
features. We may shoot the model frowning, smiling, snarling, or maybe
looking enticing; see Figure 4.55.
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Figure 4.55 “Hi there!”



In Figure 4.56 the gloves suggested the pose to the model, and the expression
followed spontaneously from the pose. But the way we read the image works
in the opposite direction, beginning with the expression.
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Figure 4.56 Pose and 
expression go together.



These are expressions which seem pretty unmistakable: When we see them
we can easily believe that we know what emotion the model’s projecting at
the viewer. On the other hand, the model may be gazing at us in a way which
is much harder to read, her features less obvious or less distinct, and more
ambiguous in what they convey. Or we may deliberately ask the model for an
expression which contradicts the rest of her pose.

We can take this a step further.

If we shoot the model with her or his face turned aside or down, the viewer
may still not escape from the impact of the absence of their gaze, that is, of the
fact that they seem to be avoiding looking at us. Once more this is ambigu-
ous: As in real life, a person may be not looking at us for a variety 
of reasons. The turned-aside gaze creates a vacuum, which the viewer’s 
imagination works overtime to fill. We see this clearly in Figures 4.57 and
4.58, where the only difference is the direction of the model’s gaze. With her
eyes downturned she appears (to me) to be absorbed, either with something
just outside the frame or perhaps with the adornment of her own body. With
her eyes directed at the viewer, her expression seems assertive and 
challenging, the body paint taking on almost the quality of warpaint. 
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Figure 4.57 The model’s gaze
turned away.

Figure 4.58 The model’s gaze directed towards
the viewer.
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One of the most striking aspects of the facial expression is the extent to which
it draws our eye, even in an image where other, more obviously erotic elements
are present. In Figure 4.59 the voluptuousness of the model’s body and pose,
with its undertones of masochism, isn’t sufficient to hold our gaze away from
her eyes and mouth. How would we describe her expression? 

In Figure 4.60 all we see of the model’s face is one eye. But because its gaze
is unequivocally directed towards us, here again it calls our attention away
from the sensual curves and vibrant colors of the rest of the image. Here
again, our reading of the image as a whole begins and ends with the face.

Figure 4.59 The model’s
expression recaptures our 
attention.

Figure 4.60 The model’s eye
provides a focal point.



The conclusion, then, is that any approach to photography of the nude which
includes the model’s face needs to give serious attention to facial expression
and make a choice across this range of possibilities: from unmistakable 
yielding sexual invitation to the challenging level gaze which meets the 
viewer as his equal.

In practice, however, not all expressions are equally achievable. I’ve found
that many of the models I’ve worked with find it hard to smile naturally for
the camera: The results often look self conscious or rather frozen. The most
natural smiles often come about by chance, or by managing to catch the
model off guard, as seen in Figures 4.61 and 4.62.
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Figure 4.61 Happy in their
work.

Figure 4.62 Naturally at ease
with the camera.



Working with more than one model, the possibilities increase significantly.
Each of the models can be looking at the other or at the viewer; their 
expressions can be similar or different. Figure 4.63 achieves its tender 
sensuality through the gaze of one model on the other, who rests in her
friend’s gentle embrace. In Figure 4.64 the two women seem almost amused
at the viewer’s intruding gaze. 
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Figure 4.63 A tender embrace.

Figure 4.64 A separate 
existence.



Themes and Poses
The practice of photography is holistic. We can discuss features of the image
such as location, lighting, camera angle, focal length, depth of field, and the
model’s pose separately from each other, but every photograph you take 
consists of the outcome of your choices and decisions about all of these 
features, as they stood at the moment the shutter was pressed. So every image
in this book has something to say about posing models.

In describing how to pose a model, therefore, we won’t be able to keep the
discussion focused just on the pose itself; we’ll also often need to take those
other aspects into account, as Figure 4.65 demonstrates. Looking at it we can
see vividly how the mood and sensuality of the image are constructed out of
many elements, all of which the photographer strives to be aware of and to
control as they interact with each other. A shot like this is also a reminder of
how very valuable the instant replay of the digital camera is during a shoot,
enabling the photographer to adjust those interactions easily and quickly. 
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Figure 4.65 How many 
elements are at work here?
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An analysis of what makes the photograph work might include: the confident
set of the model’s head (even when seen from behind); the corset, high heels,
and the dangling corset laces; the play of light across the model’s back; the
pools of light on the floor and the background; the hard shadows of the
model’s legs; and, of course, the pose with its strong, braced stance. Perhaps
the pose is the most important element; but if so, it’s first among equals.

Some themes appeal because they combine the everyday with nudity. Others,
such as Figures 4.66 and 4.67 appeal, in their very different ways, to our
sense of imagination and fantasy. 

Figure 4.66 Images which
derive from fantasy…
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In this section I want to establish and illustrate some useful guiding principles
about posing, rather than try to create an exhaustive catalogue of how to pose
models. As in many other fields of creative activity, rules are, at best, only
guidelines for what’s often been found to work before (or not). In specific
instances the rule may work best if flipped upside down.

Standing
Consider symmetry, for example. Books on photographic composition often
warn against it and talk about the need to avoid too much stability within
the frame. Some symmetrical poses do seem dull—they’re too obvious and
they lack sensuality. In Figure 4.68 the model’s attractiveness and her calm,
direct gaze into the lens don’t compensate for the very static pose. Too much
symmetry, we might decide: Only the lighting is off the center line.

Figure 4.67 …and
imagination.
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Figure 4.68 An excess of 
symmetry?

But Figure 4.69 is a shot which seems to achieve its impact precisely through
its symmetry. A number of elements at work here interact, so to speak, with
the symmetry. One of them is the model’s expression, in particular her gaze,
which engages the viewer very much on the model’s terms; another is the
exotic torc round her neck; and another is erotic positioning of her hands. So
we could argue that the reason symmetry works so well here is precisely that
it provides a stable framework within which those other, more arousing and
challenging elements can do their work more potently.

Figure 4.69 Symmetry 
working against the other 
elements within the frame.



Let’s stay with standing poses. The S curve, created by the model placing
more weight on one hip than the other, and allowing the other leg to flex at
the knee, is perhaps the most commonly used way of making the model more
dynamic, as Figure 4.70 illustrates. This is a pose whose roots can be traced
back to classical Greek sculpture. (New models may discover, with a little
experimentation, that they prefer placing their weight on one hip or the
other for this pose; it’s like being left- or right handed.) Notice also that in
this and Figures 4.71 and 4.72 I’ve positioned the model to one side of the
frame, thus avoiding symmetry in the composition. Incidentally, after the
model’s been in the S-curve pose for 30–40 seconds, she should find that she
can bend further, as her muscles adapt to the pose. 

In the last picture, the S curve was two dimensional. We can add a third
dimension to it by asking the model to move so that the shoulder above the
hip carrying her weight twists forward. The model’s head in these examples
is turned over her forward shoulder, but other positions, either facing
towards the camera or turned over the other shoulder, also work.
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Figure 4.70 The basic S curve—simple but
effective.

Figure 4.71 The three-dimensional S
curve, with the model’s gaze directed along
the line of her shoulder.



So far the examples have been shot with the camera more or less at the
model’s eye level. Figure 4.72 is a very asymmetrical pose where it’s also
apparent that the shot has been made from a much lower level. This gives the
model a more dominant position within the frame: She’s literally looking
down on the viewer. There’s a lot of energy in the pose, in the twist of the
body and the outspread arms, but the camera angle counts just as much here. 

And if we revert to a symmetrical pose, but keep the low camera angle (see
Figure 4.73), the power in the image seems to remain. Looking at all the 
elements in the image, we can see that the gunslinger positioning of the
hands contributes to the vivid sense of the model’s presence, as do the red
shoes, both in themselves and in the tension they create in the model’s calves.
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Figure 4.72 The S curve with
a low camera angle.



Floor
So far we’ve mostly kept the model on her feet. Now let’s ask her to sit or lie
on the floor.

Initially, in Figures 4.74 and 4.75 we’re in classic art nude territory: We don’t
see the model’s face, so the image is a representation of woman, rather than
of one woman in particular. (We could make this interpretation more 
convincing, perhaps, by removing the tattoo from the back of the model’s
neck!) In the first example the near-shadowless lighting will allow us to rotate
the image to any orientation. Poses of this kind are endlessly variable. 
You can experiment by asking the model to move one limb at a time to a 
different position until the pose is completely opened out; you can change
your shooting position; you can vary the lighting; and so on.
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Figure 4.73 A symmetrical
pose with a low camera angle.

Figure 4.74 The body reduced
to a minimal shape…
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Figure 4.75 This pose invites
us to reflect on the smooth
articulation of the body.

In Figures 4.76 and 4.77 the model’s grace, her short-cropped hair, and the
proportions of her limbs add impact to these simple poses.

Figure 4.76 A folded pose.



On the other hand we could choose to stay with variations on these simple
floor poses, but include the model’s face, thus creating a stronger sense of
engagement with the model as an individual. The difference can be seen in
Figures 4.78 and 4.79, which developed out of the related poses shown earlier.
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Figure 4.77 Gradually
opening out.

Figure 4.78 The pose 
opened out further, and 
made asymmetrical.
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Let’s pursue the theme of high camera angles, as in the last image. You can
experiment with different relationships between the axis of the model’s body
and the camera, and also with varied depth of field and focal zone, as in
Figures 4.80 and 4.81. I keep a couple of ladders in the studio to make it easy
to work directly above the model.

Figure 4.79 The pose opened
out and the camera angle 
shifted. Symmetry is essential
to the effectiveness of this shot.



If we now ask the model to stretch out on the floor, new possibilities are
added to those we’ve been exploring in the seated poses. As well as working
above the model, we can bring the camera down very low, for example.
Figure 4.82 shows the effect of getting the camera right down onto the floor.
Not comfortable for the photographer, but this less familiar angle produces
a striking image.
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Figure 4.80 A bold crop 
combined with a disorienting
camera angle.

Figure 4.81 Contrast the focal
zone of this image with the
previous one.
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As well as camera position and zone of focus, we can experiment with depth
of field within a single pose. This is pretty basic stuff, but it’s important not
to lose sight of its value in photography of the nude. In these examples the
different effects of depth of field depend also on the diagonal framing of the
model. See Figures 4.83 and 4.84. The same principles work on location
shoots. In Figure 4.85 the composition and depth of field are similar to those
in Figure 4.83.

Figure 4.82 More impact
when the camera is at floor
level.

Figure 4.83 Shallow depth of
field directs the viewer’s 
attention, in this case, to the
model’s expression.

Figure 4.84 Greater depth of
field draws the viewer’s eye all
the way along the diagonal.



Floor poses offer the model more scope to experiment with the pose than
standing ones do: “There isn’t so far to fall!” as one model commented. So
it’s worthwhile inviting your model to move around freely and see what poses
she can find. It’s helpful also if she can be encouraged to move in slow
motion, so that you have a chance to yell, “Stop!” when you see something
interesting and unusual emerging. Figure 4.86 is one of a series of striking
body shapes, both on the floor and on the stool, that model Caz devised. My
only requests to her were to move slowly and to avoid symmetry. This curved
pose displays Caz’s spectacular tribal tattoo. 
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Figure 4.85 Asleep in the long
grass.

Figure 4.86 Caz uses the stool
as a climbing frame. 



At the opposite extreme, familiar poses can be made to look different by a
shift of camera position. I shot Figure 4.87 on the stairs, which enabled me
to work from below the model. I could have achieved the same effect in the
studio by posing her on the dressing-up box. 

Backs
I’ve always found backs a very alluring subject, but also difficult to shoot.
The challenge is to create a vivid impression of the spine’s combination of
strength and flexibility along with the traditional erotic appeal of the 
buttocks, rather than leaving the back as a bland, featureless surface. Cross
lighting which brings out the dips and hollows of the back is often the key
element in conveying these elements to the viewer. Partial concealment can
be another ingredient in the composition of the image, as in Figure 4.88,
where the curve of Akemi’s kimono contributes to the elegance of the image. 

Figure 4.89, on the other hand, offers more concealment than revelation.
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Figure 4.87 The low camera
angle gives the shot extra
impact.



General principles are sometimes better turned inside out. In Figure 4.90 the
model is posed within an 800-year-old oak tree. Here the photograph 
was shot on a day of very faint shadows. The combination of color and
monochrome, manipulated in postproduction to bring out the roughness 
of the oak while making the model’s skin very smooth, suggests human
fragility protected by the encircling strength of the tree.
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Figure 4.88 The graceful
curve of the kimono adds to
the image. 

Figure 4.89 Revealing less;
implying more?
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Figure 4.90 Safe within the
tree.

A more fetishistic approach in Figure 4.91 makes use of high heels and
stockings, with the model posed to give the impression that she’s stalking
away from us. Note how, even in this grained image, the cross lighting
emphasizes the Venus dimples at the base of the model’s spine.

Figure 4.91 Venus in heels.



Cross lighting is equally effective on the male back, as Figure 4.92 demon-
strates. It’s also possible to emphasize the shape of the back by covering it. In
Figure 4.93 the sand that sticks to the model’s back similarly draws the eye
to the curves of shoulders, waist, and buttocks.
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Figure 4.92 Cross lighting
brings out the structure of the
model’s shoulders and spine.
The model is a gymnast, and
the lighting here brings out his
lithe muscularity.
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Figure 4.93 Sand marks the
contours of the model’s back.

Finally, in Figure 4.94, a different view of the back, showing the scars from
major spinal surgery. Model Phillippa’s willingness to pose for this and other
images in this book serves as a reminder that disability and sexuality are not
incompatible.

Figure 4.94 The symmetry of
scars.



Reclining
The final pose we’ll consider is the reclining nude. Whereas standing, sitting,
and kneeling poses derive ultimately from ancient Greek sculpture and vase
painting, the reclining nude begins with painters of the Renaissance. It’s easy
to understand its popularity: The location of the (usually) female body on the
couch powerfully suggests a range of sensual and erotic possibilities, and the
pose itself does much to emphasize female curves. Conventionally, this pose
is seen from the front, with the lens axis at right angles to the couch, garden
bench, or whatever the model is reclining on, and at the model’s eye level.
The classic reclining nude has to pay attention to where she places her hands.
In Figure 4.95, is the model defending her modesty or drawing our attention
to what she conceals? 

We can also work from above, as in Figure 4.96.
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Figure 4.95 What does the
position of the model’s hands
signify?

Figure 4.96 Gazing straight
down.
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And a model who’s comfortable with the pose can slide partway off the
couch, head first. (This isn’t as easy as it looks in Figure 4.97: My model here
is a circus artist and is used to hanging upside down.) 

We might also catch the model halfway lying down or tying her shoelace, as
in Figure 4.98. The effect of a familiar reclining pose can also be strengthened
by a strikingly different location, such as this deck with its sharp lines in
Figure 4.99.

Figure 4.97 Half on, half off.

Figure 4.98 Responding in 
the moment; this was taken
spontaneously, rather than
posed.
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Figure 4.99 Strong diagonals
disrupted by the model’s
curves.







Digital postproduction represents the most significant advance for photo-
graphy to have emerged from the era of the personal computer. Applications
such as Photoshop provide us with a range of powerful image-manipulation
tools, producing effects which a traditional darkroom, however lavishly
equipped, would find it difficult to match, and even more difficult to repeat
accurately time after time. 

Digital photographic postproduction begins with the moment you start to
download files from your camera’s storage card onto the computer, and ends
when you save and close the edited file. Except…postproduction is never 
really over. It’s always possible to rework an image—maybe to use it in a 
different medium or for a different purpose; or because you’ve seen a 
different potential in it; or because you’ve learned some new techniques which
will enable you to realize your previously unachievable vision. See Figure 5.1. 

Some photographers still debate how far to go with image manipulation 
programs such as Photoshop, questioning whether it’s legitimate to use 
software to transform an image so far that its photographic origins are lost. My
own view is that anything—be it camera, lens, or computer—which provides
better tools for the imagination should be embraced wholeheartedly and
exploited fully. The photographer now works on a continuum of creative 
possibilities which extend all the way from simply using Photoshop to correct
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Figure 5.1 Images reworked
over time and for different 
purposes.



the brightness and contrast in an image, through to works of digital art which
may begin with a photograph, but which manipulate that original image to
the extent that it’s no longer identifiable in the final product. This is a process
which has been happening, on the border between photography and the 
traditional visual arts, since photography began. 

In fact, in the course of writing this book, with its attention to digital 
postproduction, I’ve come to think, in my own practice, of the data produced
by the camera as no more than the raw material which the photographer (even
that term no longer seems entirely adequate) takes as the starting point for 
creating the “photograph.” In Figures 5.2 and 5.3, for example, we begin with
an image which is adequate, but not much more than that. Its strong points
are the model’s expression and the graceful lines of her raised arm and breast.
The computer allows the image to be manipulated into this simplified, very
high-key interpretation which emphasizes those qualities. And the result is
still unmistakably a photograph, rather than anything I’d call digital art.
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Figure 5.2 An adequate image. 

Figure 5.3 This simplified version has much
more impact.
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At the same time, there seems little point in striving to make a photograph
look just like a painting or just like any other art form. The benefit of image-
manipulation software lies in two things. The first is its power to allow you
to make your photographs look as near perfect as possible, in terms of 
maximizing dynamic range, cleaning up, straightening images, correcting
color, producing punchy monochrome work, and so on. The second is the
vast range of experimentation it permits the photographer.

There’s a comparison with language here. A community shares vocabulary and
linguistic structures, in whatever language it speaks, yet every day people in
that community produce any number of utterances which are entirely 
original, and have never been spoken before. In the same way, we all share
image-editing tools, but each of us has the capacity to produce, with those
tools, different treatments for our images. These treatments will be achieved
not by just sticking a filter on, but by exploring different combinations of, for
instance, layers, blends, filters, and opacities, and using them imaginatively. 

In the case of Figure 5.4, for example, I wanted to develop the image with an
emphasis on the contrast in form and texture between the delicacy of the
model’s curved pose and the massive, harshly lit stonework of the bridge. The
low-key treatment in Figure 5.5 uses two layers. The bottom layer is as shot.
I’ve applied the Midnight filter from Nikon Color Efex Pro! to the top layer,
adjusting its settings to increase blur and reduce color. I’ve changed the blend
mode of the top layer to Multiply, and then used a partial layer mask on the
top layer (done with the brush opacity at about 20 percent) to allow the
brighter version of the stonework in the lower layer to be visible. This may all
sound daunting, but don’t worry—we’ll look at all these steps individually in
this chapter.

Figure 5.4 The image as shot.
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So this chapter includes how to organize your work; understanding and using
the Camera Raw plug-in to set the white balance and maximize the dynamic
range of an image; basic processes such as cleaning and straightening up the
image, fixing skin blemishes, tidying up backgrounds; making selections, 
processing color images into black and white; and using filters.

A note on software: As explained in the Introduction, this section of the book
is written around Photoshop CS2. And as the book is part of the Mastering
series, it’s assumed that you have a reasonable familiarity with Photoshop’s
tools and interface, and that you can find your way around Photoshop’s
online Help to fill in any gaps in your knowledge of basic techniques and
steps, such as duplicating a layer, adding a layer mask, and so on. This
assumption doesn’t apply to the sections dealing with the use of the Camera
Raw interface, because it seems that many photographers haven’t yet
switched to shooting RAW, and because the interface is both very richly 
featured and initially rather difficult to make sense of. For these reasons the
use of Camera Raw is dealt with in detail.

A couple other aspects of the way you run Photoshop, whose value isn’t
always appreciated, are worth mentioning here. One is that it’s well worth
setting up a scratch disk, following the guidelines set out in Photoshop Help,
to speed up the processing of large, and particularly multilayered, images.

Figure 5.5 The image after
postproduction.



The other is to set the History options to Automatically Create New
Snapshot When Saving. This is to be found under History Options in the
flyout menu for the History window, not in Photoshop Preferences where
you might expect it to be. Once you’ve done this, just remember to save the
file before trying out any daring new modifications to it, so that if your exper-
iment goes wrong you can just click the last snapshot you created and bring
the file back to its previous state. But keep in mind that snapshots can’t be
retrieved after you close the file: If you create more than one possible 
version of the image during an editing session and want to leave them aside
so you can mull them over, you need to save each of them to a separate name
before closing the file. 

Because Photoshop represents the gold standard for still-image manipulation,
there’s a large industry of third-party software companies producing
Photoshop-compatible plug-ins, covering everything from faster and better
blur and sharpening filters to fake painting effects. A good range of other
applications work seamlessly with Photoshop to provide, for example, a wider
range of digital picture frames. In this section I’ll be keeping pretty much 
to Photoshop as you get it out of the box, referring to or making use of 
only two additional plug-ins. If you want to explore further, searching online
for “Photoshop plug-ins” will provide a mass of links to the wealth of
resources available.

The process of editing and manipulating images as shown here assumes that
you’ve been shooting RAW images, and will therefore make use of Photoshop’s
Camera Raw plug-in for the early steps in editing your pictures. If you’ve not
been shooting RAW, you can pick up the process at the point where I move
from Camera Raw plug-in to Photoshop itself. Using Camera Raw is, in many
ways, easier than the following description might suggest: With practice you’ll
spend no more than a minute or so tweaking the Raw settings for most images.

One final note of caution: Photoshop has been compared (by me, if no one
else) to a huge ball, made up of hundreds, maybe thousands, of separate
strands of wool. Learning to use Photoshop is a process of teasing out some
of those strands, until you understand enough to make Photoshop do what
you need it to do. But hardly anyone teases out all the strands! My son, for
example, who’s an illustrator, paints and draws with Photoshop, using tools
and techniques I’ve never even tried; and he’s completely unversed in the
photographic manipulation methods which are my daily bread and butter.
What’s the point of all this anecdotal rambling? Simply to indicate that in
this chapter we’ll be looking at the methods and tools which I’ve found most
effective, but not attempting to survey everything that Photoshop can do. The
Bibliography contains details of some excellent books about Photoshop
which work through all the other strands.
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Organization
I’m describing one method here. Your approach may be different. The details
of the method are less significant that the fact that, whatever working methods
evolve, apply them consistently to ensure that your images are secure.

Once your images are downloaded, the next steps, before you embark on
editing selected pictures, are likely to include doing these things to the shots:

� Cataloguing

� Reviewing 

� Renaming

� Backing up

� Burning to CD for the model

Cataloging, Reviewing, Renaming
Photoshop’s old Browse facility has been significantly upgraded in CS2, and
has metamorphosed into Bridge, a standalone application which works with
Photoshop to provide wide-ranging cataloguing features. (Bridge can still be
accessed through Photoshop’s File > Browse command.) However, Bridge
still seems one of Photoshop’s weaker features. Even on a fast machine, it’s
slow to start up, works very slowly when building thumbnails, and is also
slow opening multiple images into the Camera Raw plug-in. Rather than rely
on Bridge, I use MediaPro (www.iview-multimedia.com), a multimedia 
cataloguing application available for Macintosh and Windows, which creates
and opens image catalogues quickly. 

Figure 5.6 shows MediaPro in thumbnail view. The thumbnail size is
adjustable. In my method of working, the MediaPro file has the same name
as the folder of images it catalogues, and is stored in that folder. Note also the
numbering convention used here. The info panel on the left (only partly 
visible here) shows the metadata for the edited image, which is highlighted
in the thumbnails area, including the EXIF metadata for the original image
on which the edited version is based. EXIF metadata is information, stored
with each image, about the data which comprises the image. The metadata
includes the camera make, the filename, the ISO setting, the lens aperture,
the shutter speed, and the lens’ focal length, along with the time and date the
image was shot.
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Figure 5.6 MediaPro in
thumbnail view.

When it’s time to review the shoot, MediaPro also has a very useful timed
Slideshow facility, as well as the option to work through the catalogue in 
your own time using the cursor keys, with images displayed full screen; see
Figure 5.7. Note the filename below the image and the controller top left.
Like Bridge, MediaPro also seems to know which way photographs taken 
by recent cameras should be oriented, and will rotate the thumbnails 
automatically into the correct position. 

Figure 5.7 Image displayed in
slideshow mode by MediaPro. 



Again like Bridge, MediaPro lets you add your own information, such as
copyright details, to the metadata. MediaPro doesn’t let you view the settings
for RAW files, but I haven’t found that to be a problem. And MediaPro offers
one useful feature not available in Bridge: a double view, with two images
shown as large as possible next to each other on a black background, either
side by side for portrait format or one above the other for landscape. (The
settings are found in Make > Slide Show Settings.) This can be helpful when
you’re trying to decide which of two similar images you prefer: As Figure 5.8
shows, the black background makes it easier to focus on the images than does
trying to arrange the same thing in Photoshop with all its clutter.

I download images into a folder whose name consists of the name(s) of the
model(s) in the shoot plus the date. Once your images are on the computer,
you may want to review them to delete any you feel are not going to 
be useable. Do this very cautiously, if at all. A decision taken at this point in
the process is irrevocable, and in general I’d rather use some extra storage
space and keep even the most marginally useable images. Having made any
deletions, the next step is to rename the image files. You can do this as a batch
process in either Bridge (Tools > Batch Rename) or MediaPro (Action >
Batch Rename). I think it’s well worth doing, because the numbering 
conventions used by digital cameras aren’t at all user friendly and tell you
nothing about the content of the image. I rename each file after the model(s)
in that shoot, then number them, including a couple of leading zeroes, so
that if I shoot more than 999 images of the same model, the filenames will
be consistent. Some photographers include the date within the filename,
which makes for very long filenames! On the other hand, my method does
have the weakness that finding a specific image of a model with whom I’ve
done a large number of shoots takes a little longer because I have to find the
right folder first. 
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MediaPro’s Organize button allows you to select files according to type. In
Bridge you can select View > Show Graphic Files Only, or Show Camera Raw
Files Only. If you’ve shot RAW + JPEG, as suggested in Chapter 1, this
makes it easy to select and rename all the JPEGs, then all the RAW files. 

Remember to set the starting number back to the same value for both the
JPEG and RAW files! (See Figure 5.9.) These commands also make it easy to
review only the JPEG files when you’re evaluating the shoot (quicker 
than viewing each image twice) or to select and copy the JPEGs into a 
separate folder. First time round I review the JPEGs because they load faster
than the RAW files; more precise judgments will be made later looking at the
RAW files.

In MediaPro you can also set the default application into which the files will
open. This may be necessary if you’ve had to load your camera manufacturer’s
proprietary software onto your computer, but don’t want to use it to edit 
the images. Select all the files in the folder, then click Action, Set Finder
Properties, Creator. Use the Browse button to navigate to the application
you’re using; see Figure 5.10. Once you’ve culled and renamed the files, set the
correct Creator, and saved the catalogue, you can back up the folder. There’s
a detailed discussion of the importance of this step, and how to go about it,
in Chapter 1.
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Making a CD for the Model
After the discussion in Chapter 3, there’s not much more that needs to be
said about this. Some photographers allow the model to have only a selection
of the best images from the shoot. I usually give her all the images, because
the model release she’s signed makes it clear that I retain the right to check
and edit (or reject) the images she wishes to use on her web sites or have
printed. It’s also possible that images which seem only adequate to me as
photographs nonetheless show the model well and would be useful for her
portfolio. Either way, you probably won’t want to give her full-size images,
which are too large for the Internet. To carry out the task you can write an
Action and make use of Photoshop’s Automate > Batch command to process
a number of files at once. An Action is essentially a series of prerecorded steps
that you can play back in one go to save time. Figure 5.11 shows such an
Action, written to batch process full-size camera JPEGs (3,008 � 2,000
pixels) down to 650 � 432 pixels, a more suitable size for web use. The
Action is applied to a folder into which I’ve put copies of the camera JPEGs,
not to the folder containing the original camera JPEGs themselves!

Postproduction 303

Figure 5.10 Setting Photoshop
as the default application to
open all the files in this folder.



Mastering Digital Nude Photography304

The Camera Raw Plug-in: Main Features
In this section I’ll refer to the Camera Raw plug-in, its window, and its inter-
face as Camera Raw; and to the main Photoshop window and its interfaces
as Photoshop.

The first steps in editing may appear to be predominantly technical rather
than creative, but they still call for an imaginative eye, as well as a careful one.
To start with, we’ll use Camera Raw to optimize the image, giving it 
maximum dynamic range, placing the white point correctly, and achieving
the most expressive brightness. Once the RAW phase is completed, we can
move on to cleaning up the image in Photoshop.

We’ll start by opening some images into Camera Raw. Ideally, you’ll have
taken a shot of your test chart (see Chapter 4) in the set you now wish to
work on. I’m assuming you’ve used a GretagMacBeth 24-square
ColorChecker chart, and the values for white balance I’ll use are based on
that. If you used a different test chart, you’ll need to experiment to see what
values work best. If you’ve been shooting RAW + JPEG, simplify the work by
changing your view of Bridge or MediaPro to show only the RAW files. (In
Bridge, View > Show Camera Raw Files Only; in MediaPro, click the
Organize button, then select the RAW files from File Type.) 

Figure 5.11 A straightforward
action to resize camera JPEGs. 



Command+click (Ctrl+click) the test chart image from the set you want to
edit, and then Command+click (Ctrl+click) the most promising images from
the same set. When you’ve selected the images you want to work on, press
Command+R (Ctrl+R) in Bridge or double-click any one of them. 

The files will open into the Camera Raw window in the order they’re sorted:
The test chart, assuming you shot it first, will open in the 
preview area, with all the images you’ve selected visible as a filmstrip down
the left side of the window. If you don’t have a shot of a test chart, just open
one of the images which has an area in it you know 
is white. Without some known white area in the image, it’s harder to get the
best out of Camera Raw. You should now see something like Figure 5.12.

Time for a guided tour of Camera Raw, before we start to apply it to our
images. Camera Raw has a relatively small set of essential controls, as well as
a rather larger bunch of features which you’ll make use of less frequently. This
section is pretty detailed, because Camera Raw isn’t well documented in
Photoshop Help or in the Photoshop manual. Photoshop CS2 includes 
version 3 of Camera Raw, which is much more user friendly than the version
released with CS, but it’s still easy to lose one’s way. 
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Camera Raw is rigid in some regards, but flexible in others. For example it
really is best to work through the settings in the Adjust tab from top to 
bottom; but there are at least three different ways of saving changes you’ve
made to a file, and a range of possibilities when it comes to saving and 
reapplying settings from one file to others.

By default, and differently from Photoshop CS, Photoshop CS2 saves the 
settings for each edited RAW file in a sidecar file, in the same folder as the
original file and with the same name, with the extension .xmp. This means
that when you copy your files to a different computer or archive your work,
providing you do so a folder at a time, the .xmp files will always be accessible
to Camera Raw if you want to do more work on any of the images or retrieve
them from the archive. The other option, available in the Camera Raw 
preferences, stores the .xmp files in a central Camera Raw database. (See
Photoshop Help for more details.) Whichever option you choose, Photoshop
will maintain the link between a RAW image and its .xmp file even if you
rename or move the RAW file, providing it’s still on the same computer.

When Camera Raw is in use, the only item available from the main
Photoshop menu is View. By default, Camera Raw opens with the whole of
the image visible (View > Fit on Screen). The window titlebar contains some
EXIF details of the camera settings for the photograph. It may be comforting
to see that Camera Raw has all this information, but its display doesn’t seem
to have much practical value. In Figure 5.12 I’ve shot the test chart and its
context, rather than just a close-up of the chart. This lets me keep an eye on
the image as a whole—helpful with a window-light picture such as this, where
I’ll deliberately let part of the picture blow out.

The largest section of the Camera Raw window is the preview area, where
you can see the selected image and, if you’ve selected the Preview checkbox,
the changes you make to it as you adjust the settings. The filmstrip of other
files you’ve opened runs down the left side. Top left, above the preview area,
is the toolbar; see Figure 5.13.

The Hand and Zoom tools (which are arranged the opposite way round to
the main Photoshop toolbox, with the hand to the right, not the left, of the
zoom icon) work as they do in Photoshop. The first eyedropper is the White
Balance tool: We’ll look at it in detail when we discuss making adjustments
later in this chapter. The next eyedropper is a Color Sampler, which you 
can use to observe the shift in RGB values of up to nine sampler points—
for example, when you make adjustments using the Settings > Calibrate 
controls. The Crop tool allows you to crop the image, but is applied only to
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Figure 5.13 The toolbar and
checkboxes.



the preview in Camera Raw, and to the image itself when you open it 
in Photoshop; in other words, the original RAW file isn’t affected by the crop-
ping you apply. There’s a drop-down menu on the Crop tool which requires
you to specify an aspect ratio for the crop, but once you’ve drawn a marquee
around the area you want to select, dragging any of the handles will change
the aspect ratio, just like the Crop tool in Photoshop, unless you hold down
Shift while you drag

A cautionary note: As in Photoshop, holding the spacebar down with any
tool selected turns that tool into the Hand tool, which should make it easier
to navigate around the image. However, I’ve found that at 100-percent zoom
the Camera Raw window scrolls slowly, so it’s easy to get ahead of yourself
and inadvertently click in the window without the computer’s realizing 
that the spacebar is depressed. If you’ve been using the Zoom tool plus the
spacebar, this isn’t a significant problem because you can readjust the amount
of zoom easily. If you’ve been using the White Balance tool with the 
spacebar, you may reset the white balance dramatically. Press Command+Z
(Alt+Z) to undo the change

Next is the Straighten tool: Drag it along a line in the image which is meant to
be horizontal or vertical, and you’ll see a crop which, if applied, would rotate
the image to make that line horizontal or vertical. (Again, this won’t affect the
original RAW file.) It’s a rather crude tool: It’s much easier to carry out the same
procedure in using Edit > Transform > Rotate in Photoshop. Finally, we come
to the Left and Right Rotate tools, which spin the image through 90º in the
specified direction, once more without affecting the RAW file.

To the right of the toolbar are checkboxes for Preview and Shadow and
Highlights clipping displays. Toggling Preview on and off lets you see the
effect of the adjustments you make, in comparison with the state the image
was in when you opened it. If you’ve already worked on the image, you’ll see
that previous version of it when you deselect Preview. (See “Setting the
Defaults” in this chapter for further discussion of this.) When the Shadow or
Highlight boxes are checked, shadows which are solid black are shown in
blue, and highlights which are blown out are shown in red. RGB values
under the cursor are displayed to the right of these checkboxes. The Shadow
and Highlight displays are essential for optimizing the dynamic range of your
images.

The Workflow options, bottom left, include the Space and Size drop-down
menus; see Figure 5.14. These reflect the settings for the image as they were
downloaded with the image from the camera, and Resolution is the default
print resolution as set in Photoshop’s preferences. You can use the Size 
drop-down menu to alter the processed image’s resolution. (Sizes larger than
the original camera file are helpfully marked with a +, and smaller sizes with
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a -.) If you want to increase the image’s size, doing so by interpolating from
the raw data in this window will give smoother results than working on the
file in Photoshop.

Assuming, then, that you had these three values correctly set to begin with,
you won’t need to alter them. The only option specific to the Camera Raw
plug-in is Depth. I have it set to 16 bits per channel rather than 8, thus
enabling me to use all the information produced by my 12-bit camera. See
this book’s Introduction for more.

It’s worth pointing out that expert opinion on the real value of working in
16 bit is strongly divided. The argument in its favor is, broadly, that it makes
sense to use the largest possible colorspace when editing, in order to more
precisely adjust to the image’s colors. Even if the image is going to be 
displayed or printed on devices which only handle 8-bit color, this argument
runs, working in 16 bit must give you more accurate color, which must in
turn improve the look of the image when it’s expressed in 8 bit. Certainly if
you have to stretch the tonal range of an image using levels (discussed later),
there are more likely to be gaps in the histogram in 8-bit mode than in 
16-bit mode. The counterargument asserts that while the color may be more
accurate, the difference is too subtle to be visible to the human eye, and that
the slower working and larger file sizes which result from using 16 bit just
aren’t worth it. You will, in any case, at some stage have to set the bit depth
to 8 for any images you wish to convert to JPEGs.

The histogram is located to the right of the preview area; see Figure 5.15. It
shows the tonal distribution of the Red, Green, and Blue channels in the
image, from each color’s being completely absent (value 0) on the left side 
of the histogram, to being present at maximum value on the right side 
(value 32,767, as we’re working in 16 bit). It also shows the distribution of
composite RGB, represented by the white trace. The higher the histogram at
any point, the more of that color is present at that level in the image. The 
histogram for a well-exposed image of an average scene will extend all the way
from one side to the other. (A larger histogram would be very helpful in work-
ing with the Camera Raw plug-in; perhaps one day Adobe will give us one.)
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Figure 5.14 The workflow
controls.



Setting the Defaults
Before we get to the Settings tabs, a note about Camera Raw’s default settings:
Out of the box, Camera Raw applies Auto settings for Exposure, Shadows,
Brightness, and Contrast as soon as you open a RAW file for the first time.
This is an unusual default action in that all other Photoshop dialogs leave it
to you to decide whether you want to use auto correction or adjust the image
manually, and you’d expect Camera Raw users to be unlikely to settle for auto
settings. As with most other Auto settings, the results you get here will be per-
fect for some images, but less satisfactory for others, particularly when dealing
with such things as specular highlights, bright white 
backgrounds in high-key images, or dark backgrounds in low-key shots. So I
prefer to change the defaults to open the RAW file without auto adjustments
being applied to Exposure, Shadows, Brightness, and Contrast, so that I can
see what I shot, as I shot it. 

So if you decide you’d like to reset the defaults to open your images as shot,
follow these steps. Open any RAW file into Camera Raw, then deselect Use
Auto Adjustments from the Settings flyout menu. You can also uncheck the
Auto boxes one by one. You’ll see the image change back to its as-shot appear-
ance. If your image isn’t perfectly exposed, and you have the Highlight and
Shadow gamut boxes checked, you’ll see overexposed highlights showing up
in red, and/or solid blacks showing up in blue. Click Save New Camera Raw
Defaults from the same menu. Click Done in the Camera Raw window. This
will save the changes you’ve made to the defaults and close the file. 

There’s one other default you may want to consider resetting. Click the
Curve tab, and you’ll see that, by default, Camera Raw slightly increases the
contrast by applying a medium-contrast curve. After a period when I’d set the
default for the tone curve back to Linear (no change applied), I realized that
I still ended up using the Medium Contrast setting for almost every image,
so I restored it to my default settings. If you decide you’d rather work with
the Linear curve, you can select it and once more save your new default 
settings as described.

Once you’ve carried out these steps, selecting Camera Raw Defaults from the
Settings menu will always take you back to the as-shot settings of your RAW
image, regardless of how much adjustment it has undergone. However, if
you’ve applied a Crop or a Straighten to the image, selecting Camera Raw
defaults won’t cancel that: You can cancel these adjustments by selecting
Clear Crop from the Crop tool menu, or by hitting Escape with the Crop
tool selected.
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Note that if you decide you want to go back and start from scratch on a RAW
file you’ve already worked on, the safest way to preserve the settings from
your previous attempt (if you wish to do so) is to select Save Settings from
the Image Settings flyout menu before you do anything else to the file. 

The Settings Tabs, Part I 
At last we come to the Settings tabs, where all the work is done; see Figure
5.16. The Adjust and Curves tabs are the most important. Before you start
to work on the image, all the Adjust settings are set to default values:
Exposure 0.00; Shadows 5; Brightness 50, and Contrast +25. The Exposure,
Brightness, and Shadow controls are the ones you’ll use most.

Adjusting the Image
Let’s go to work. 

Make sure that the color chart image is open in the preview window. Click
the Select All button at the top of the filmstrip; see Figure 5.12. You’ll see all
the images in the film strip are highlighted. Now click with the White
Balance tool on the third gray patch from the left on the color chart in the
preview window, and observe the result. (You don’t have to use the third
square—any square in the middle of the range will do—but that’s the one
I’ve chosen to use here.) Unlike the Color Sampler tool, which analyzes the
color you click, this eyedropper equalizes the RGB values of the pixel it
touches. You’ll see this change ripple through all the images in the filmstrip.
In my example, this patch as shot has RGB values 138, 154, 166. When you
click it with the eyedropper, Photoshop adjusts its values to remove all color
from it and make it a pure gray with values, in this case, of 165, 165, 165.
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In correcting the white balance for the image, this step should also provide
accurate color across the whole spectrum. 

If you’re working without a test chart, find an area in your image which you
know is on the grayscale, (somewhere between white and black, with no
color in it, or what’s also referred to as a neutral color). Click that area, and
again observe the result. A mid-gray is best, but I’ve also found that, in 
desperation, with care the whites of the model’s eyes work quite well.
Specular highlights (with RGB values of 255, 255, 255) give unpredictable
results and if you click one persistently, Camera Raw will warn you that the
area is too bright, and advise you to click somewhere else. If your image has
several different mid-gray areas, try clicking each of them to see which gives
the most acceptable white balance.

I find that, even though it might seem a rather crude tool for such a crucial
setting, the eyedropper gives pretty good results, and you’ll rarely need 
anything else to get a satisfactory white balance. In Figures 5.17 and 5.18, by
way of experiment, I set my camera as far off the correct lighting setting as
possible, and to make things tougher, dispensed with the test chart.
Fortunately, I know that the window sill’s painted a true white, neither warm
nor cool. Clicking it once (in a less brightly lit area, to the model’s left) with
the White Balance tool in Camera Raw produces the result in Figure 5.18. It
compares well with Figure 5.19, taken with the camera correctly set and 
balanced using the color chart.
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Figure 5.17 I usually do better
than this! 
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Figure 5.18 White balance set using the
eyedropper on the white window sill.

You may find that the even simpler method of selecting one of the preset
values available for white balance also works well for most images; see Figure
5.20. However, if you need to adjust the white point further, you can use
the Temperature and Tint sliders, which between them allow you to create any
white balance imaginable. Moving Temperature to the left makes the image
more blue; moving it to the right makes it more yellow. Moving Tint to the
left adds green; to the right adds magenta. Whichever method you choose,
don’t move on to the next step until you’re fully satisfied that you’ve set the
best possible white balance. (This process is difficult, if not impossible, to
carry out successfully if your monitor isn’t calibrated.)

Figure 5.19 White balance set using the
test chart.

Figure 5.20 The preset white
balance options.



Using the eyedropper, then, has produced values for the third gray patch of
165, 165, 165. GretagMacBeth specifies that the correct Red, Green, and
Blue values in the Adobe RGB (1998) colorspace, for the six gray patches on
the bottom row of this chart are as follows, from left to right: 243, 243, 243;
200, 200, 200; 160, 160, 160; 122, 122, 122; 85, 85, 85; and 22, 22, 22. So
we need to adjust the image so that the values for the third square come
down from 165 to 160. 

This isn’t surprising, because I can see the spike on the right edge of the 
histogram, which tells me that parts of the image are overexposed. At the
same time, the spike on the left indicates that the blacks in the image are
slightly compressed, so any correction made to the image needs to allow for
this as well.

The next step, then, is to adjust the exposure. (Because I still have all the
images in the filmstrip selected, the changes I make in this next set of steps
will all be applied to all the images.) The Exposure value is calibrated in 
increments equivalent to f-stops. Rather than using the slider, which is a bit
too erratic to allow for fine adjustments, I click in the Exposure value box,
then use the up and down cursor keys to make the necessary changes. If after
clicking in the box I reposition the cursor over the same gray patch (without
clicking!), I’ll get a reading from it. The cursor keys by themselves alter the
exposure by 0.05 stops every time you press the cursor key; holding down
Shift while using the cursor keys adjusts the value by 0.5 stops. With the 
exposure reduced by 0.25 stops, I get the desired readings of 160, 160, 160.
Incidentally, the Exposure control, like all the controls in Settings, is 
scrubbable: If you position the cursor over the name of any slider, the cursor
changes and you can adjust the value by scrubbing with your pointing device
to left and right. Again, it’s not entirely smooth. 

At this stage you may still see some blue and red indications of clipping in the
shadow and highlight areas. You’ll get a clearer idea of how significant these
are by zooming the image up to 100 percent. What you see may surprise you.
There’ll be some small areas of red or blue which you couldn’t see when the
whole of the image was visible in the Fit on Screen view; but some of the red
and blue you could see in that view may have disappeared. This suggests that
Camera Raw is displaying highlights and shadows on the basis of the data as
it’s been processed to create the preview, rather than on the basis of the raw
data as a whole. At any rate, it’s a good idea to check the 100-percent view 
frequently as you work, to make sure that you’re not limiting the dynamic
range of the image more than you need to. Achieving the “correct” values for
the color chart may not be perfect for your image as a whole.
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Camera Raw also supports the other method of viewing highlights and 
shadows which is available in, for example, the Photoshop Levels dialog.
Option+drag (Alt+drag) the Exposure and Shadows sliders. Completely
blown-out areas show up as white as you adjust the Exposure slider. Areas
which are blown out in one or more colors show up in color, and areas which
are safely exposed show as black. When you adjust Shadows in this way,
white areas are safe, black areas are crushed in all colors, and so on. However,
because the accuracy of these indicators depends partly on the zoom level
you’ve chosen, and because you can’t drag the sliders and move the image
around in the viewing area at the same time, I find it easier to work with the
blue and red clipping indicators. 

Now we tweak the Shadows. The Shadows adjustment is pretty fierce, 
compared to all the other Adjust sliders, and you probably won’t want to hold
down Shift with the cursor keys. A couple of strokes on the down cursor
remove the spike on the right, but leave the histogram still extending all 
the way across. If you zoom the image up to 100 percent, this adjustment 
has recovered some detail in the shadows on the model’s black jacket and
skirt. However, it also reduces our cherished values of 160, 160, 160 for that
gray patch!

The final step with the Adjustment tab is to raise the Brightness to bring the
gray patch back up to its correct value. Some small areas of the image may
blow out, so you may have to go round the Exposure/Shadow/Brightness
loop two or three times to get everything as close to correct as possible. In
Figure 5.21 the window remains blown out intentionally (and you can see
that reflected in the narrow spike which remains on the right of the 
histogram), but the model’s skintones have been brought into line compared
with Figure 5.12. 

If in the process of juggling all these settings and sliders you feel you’re 
getting lost, just Option+click (Alt+click) the Cancel button to reset all the
dialogs, or select Camera Raw Defaults from the Settings menu and start
again. Keep in mind that nothing you can do in Camera Raw will make a
permanent change to the RAW file! 

Now click the Curve tab. As well as a linear state which doesn’t alter the
image, the Tone Curve menu offers two preset curves for Medium and
Strong Contrast. These may offer a quick way of adding a bit more punch to
your image. And, of course, you can always draw your own, watching the 
histogram and the preview area closely as you work, and cycling back round
through the Adjust settings if necessary.
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After all this work, you now have a beautifully adjusted photograph of a test
chart! The next step is to look at the other images in the set to check how
well the settings have worked on them. The white balance should be fine;
other settings may need adjustment, depending on, for example, whether the
model’s turned towards or away from the light through the set. To check this,
click each image in the filmstrip to open them in the preview window. (If the
color chart image is at 100-percent view, you’ll notice that each of the other
images is also at 100 percent, and that the area of each image visible in the
View window has scrolled to the same position as the color chart image.) 

In the set shown in Figure 5.22, the model’s wearing fewer clothes in the real
images, so more light is reflecting off her pale skin than off the black leather
jacket she was wearing in the test chart shot. But the light outside hadn’t
changed much between shooting the test chart and the real image, and the
model hasn’t changed position. As a result, the settings work pretty well. I’m
not worried about the fact that the window’s still blown out: That’s part of the
mood of the picture; and the smaller blown-out areas on the model’s face have
also been corrected by applying the settings from the test chart. If they weren’t,
I could try making some more alterations to Brightness and Shadows.
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Figure 5.21 The correctly
exposed gray patch. The X 
represents the position of the
cursor.
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It’s often the case, however, that the technically most accurate settings don’t
look right or don’t fit with the emotion you’re trying to create in the image.
It’s not impossible, therefore, that you’ll choose to readjust the highlights
and shadows (and perhaps even the white balance) away from their most
accurate settings; but at least you’ll be able to see clearly what difference
your subjective changes make to the “correct” version of the image. 

Camera Raw offers one useful additional trick. Suppose you’ve adjusted one
or more images’ settings so they’re now different from the color chart
image’s settings, and you change your mind and want to revert their settings
so they’re the same as the color chart again. Select the color chart image, 
so it opens in the preview window. Its setting values will appear in the
appropriate boxes in all the tabs. Command+click (Ctrl+click) in the 
filmstrip on the images whose settings you need to revert. The boxes for any
settings you adjusted for the other images will go blank, because those 
settings are now different from the values for the color chart image. Click in
the blank boxes, and the values for the color chart image appear in the
boxes, and will be applied to the other images.

Once you’ve finished adjusting a RAW image (see “Leaving Camera Raw”
later in this chapter), its settings are held in its .xmp sidecar file and applied
whenever you reopen it. So you can use this same trick if you decide 
subsequently to work on other images from the same set. Select in Bridge or
MediaPro the color chart image and the other images you want to adjust, and
open them all into Camera Raw. Then just follow the steps described in the
previous paragraph.

Figure 5.22 The settings for
the test chart image work well
on this real image.



In addition, as an example of Camera Raw’s flexibility, if the color chart
image was the last image you adjusted before leaving Camera Raw, you don’t
need to reopen it to get access to its settings. Just open all the images you
want to apply its settings to, select them all in the filmstrip, then click
Previous Conversion in the Settings drop-down menu. And, in Bridge, if
you’ve saved the settings from the test chart image, and have a very large
number of photographs taken under the same conditions which you want to
apply those settings to, you can select those files and use Automate > Apply
Camera Raw Settings in Bridge to apply the same settings to them all 
without opening them, rather than working through them individually or in
small sets as we’ve been doing here.

Finally, there’s one more method for saving the settings for the color chart
image in case you wish to apply them to other images in the set. From the
Settings menu, choose Save Settings. This will save all the settings for the
image. If you wish to save only some settings, choose Save Settings Subset
and deselect the settings you don’t wish to save; see Figure 5.23.

By default the saved settings will be named after the file you’re working on.
To apply the settings, open (and select) the image(s) you want to apply them
to, then select the settings from the bottom section of the Settings 
drop-down menu. (Unlike .xmp sidecar files, saved settings are stored by
default in a single central Raw Settings folder. If you need to move images
from one computer to another, you may want to save the settings into the
same folder as the image.)

I didn’t adjust the contrast when I was working on the test chart image,
because it’s a more subjective alteration which is best judged while working
on the real images. So I could now experiment with the Contrast slider or
value box, image by image, keeping an eye on the left end of the histogram,
as well as on the image, to make sure I don’t crush the blacks unacceptably.
Alternatively, I could wait until I have the image open in the main Photoshop
window and use Curves, with its capacity to make subtler changes, to adjust
the contrast.
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Figure 5.23 The options for
saving Camera Raw settings.
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Much the same argument applies to the Saturation control. If you have a
bunch of images that need the same saturation adjustment applied in a
batch operation, then you could use this control. But as far as individual
images are concerned, a Hue/Saturation adjustment layer in Photoshop is 
a much more flexible way of altering the image. An adjustment layer is
a clever way in Photoshop of making an image look different without 
permanently changing the RGB values of its pixels. For example (as done
here), you can apply a Hue/Saturation adjustment layer and use it change
the hue, saturation, and lightness of all image layers stacked beneath in the
Layers tab. But if you remove the adjustment layer, or toggle it off, the 
layers below it still look as they did before you applied it. Adjustment layers
are used later in this chapter.

So far we’ve taken the color chart image as our starting point for all the
adjustments we’ve made. Without a shot of a test chart, or at least a reliably
neutral object in the shot, setting the white balance depends on a subjective
judgment, but even without the precise RGB values of the test chart to guide
us, we can use the shadow and highlight-clipping indicators to adjust the
dynamic range of the image. 

So start by checking both clipping indicators. To adjust the exposure, make
sure the whole image is visible in the preview window. Look at the areas, if
there are any, in which red highlight warnings are visible, and scrub the
Exposure slider down until they just disappear. Ease the slider back up, and
note which significant areas light up first. They’re the brightest areas of the
image. (Significant means excluding specular highlights and areas which you
want to allow to remain blown out, such as the window in Figure 5.22.) If
there aren’t any red highlights showing, hazard a guess at which area of the
image is the brightest. Next, zoom the image up to 100 percent and scroll that
potential highlight into view. Now adjust the exposure down to reduce the
highlight, or up to extend the dynamic range. The ideal setting is the one
where (for an overexposed image) the highlight warning has just disappeared,
or (for an underexposed image) where the highlight warning will appear if you
increase the exposure by one more up-arrow click. You may want to scroll
around to other bright areas and check that they also are now within range. 

Now go for the shadows. The easiest way to check these is to repeat the same
process, working this time with the blue shadow warning and the Shadow
slider. And just as there are highlights which you’re happy to leave blown out,
so there may be peripheral areas of the image in which you’re willing to lose
shadow detail. 

The capacity to maximize the image’s dynamic range, and thus use all the
information recorded by the camera’s sensor is what shooting RAW is all
about. I would have lost detail at both ends of the range, irretrievably, in a



JPEG. Exactly how much useable latitude shooting RAW provides, by 
comparison with shooting JPEGs, will depend on your camera. With a Nikon
D70 it’s just under a stop either way. Having said that, it’s also important to
emphasize that RAW can’t work miracles: If your image is so overexposed that
there’s simply no detail at all in some areas (the RGB values are 255, 255,
255), then no amount of playing around with Camera Raw will re-create the
missing information. In Figure 5.24 the blown-out area is obvious; in Figure
5.25, a later shot from the same set, the highlights are just within range.
Equally, pushing the exposure to retrieve a seriously underexposed image may
create the necessary dynamic range, but it may also significantly increase the
visibility of noise in mid-tones. It is, however, possible to graft new texture
onto small blown-out areas, thus potentially rescuing images such as Figure
5.24. This will be discussed later in this chapter. 

Figure 5.26 shows the real picture from the set shot by the window, as 
finally edited: cropped, blemishes removed, and the window frame tidied up.
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Figure 5.24 The model’s
shoulder is blown out.

Figure 5.25 After adjusting
the lighting.
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Leaving Camera Raw
Camera Raw can be dismissed by any one of the four buttons in Figure 5.27.
The easiest one to understand is Cancel: That closes the window without 
saving or remembering any changes you may have made to the raw image(s)
you were working on. If you Option+click (Alt+click) Cancel, it will reset 
the Camera RAW dialog. This means it will take the dialog back to the 
settings that applied when you opened the file, not automatically to the
Camera Raw defaults. 

The default button is Open. This opens the image into Photoshop, incorpo-
rating the adjustments you’ve made in Camera Raw, and also updating the
metadata for the RAW file. Option (Alt) with Open will open the file, but
won’t update the metadata—useful if you’ve just made some experimental

Figure 5.26 The edited image.

Figure 5.27 Dismissing
Camera Raw.
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changes to an image which you’d already adjusted satisfactorily, and want 
to work on the image in its current state in Photoshop without losing the 
earlier adjustments. If you’ve opened more than one image into Camera Raw,
the Open button reads Open 1 Image, and will open the image currently in
the preview area. If you Command+click (Ctrl+click) more than one image
in the filmstrip, the button changes to Open 2 Images, and so on.

Save allows you to save the image into a non-RAW format without opening
it. (Remember that nothing in Photoshop allows you to make changes to the
RAW file itself.) Just pressing Save opens up a dialog box in which you can
specify file format, extension, and the like; Option+Save (Alt+Save) just saves
the file, in accordance with the current settings in the Save dialog, without
opening the dialog. If you’ve opened more than one image into Camera Raw,
the Save button reads Save 1 Image and will save the image currently in the
preview area. If you Command+click (Ctrl+click) more than one image in
the filmstrip, the button changes to Save 2 Images, and so on.

This is an appropriate moment to mention Adobe’s DNG (digital 
negative) format. At present, RAW file formats are determined by camera
manufacturers, and creators of RAW-editing software have to struggle to keep
their products current by adding a new set of parameters for every new 
camera which comes on the market (assuming that the camera manufacturer
is willing to make the information available). To try to overcome this 
problem, Adobe has proposed DNG as a universal format for all RAW images.
From the photographer’s point of view it’s a very sensible proposal, ensuring
compatibility and guarding against obsolescence, and it’s to be hoped that in
time all camera manufacturers will either go over to DNG completely, or at
least offer it as an alternative to their own RAW formats.

By default, the Save dialog offers DNG as the format to save into. Other for-
mats available are .jpg, .tif, and .psd. If you’ve adjusted several images in
Camera Raw and want to work on a number of them in Photoshop, you can
save them as .psd or .tif files. This Save dialog is the only way just to convert
and save images to work on in Photoshop later, without opening them into
Photoshop now. 

Finally, the Done button applies the changes you’ve made to the RAW image,
without opening it, and dismisses the dialog. 

The Settings Tabs, Part II 
Here I’ve grouped together features which are provided better in the main
Photoshop window and those you’re less likely to use every day. Several of
them could be useful, however, if you have a large number of images to which
the same alteration has to be applied, again using Automate > Apply Camera
Raw Settings. 



Burrowing deeper into the Camera Raw interface, the Detail tab offers
Sharpness, Luminance Smoothing, and Color Noise Reduction. By default,
Sharpness is set to 25. On the one hand it seems to me to be pretty safe to
leave this setting as is: It gives images a natural look (remember to zoom the
image at least to 100 percent when assessing this) with no obvious sharpening
artifacts. On the other hand, it’s not as subtle as Unsharp Mask or Smart
Sharpen in Photoshop, and those are the tools to use to improve the sharpness
in individual images, as the final step in editing. It’s also worth noting that
many image libraries require submitted pictures to be unsharpened, so if you
have this destination in mind, you can set Sharpness to 0.

Luminance Smoothing and Color Noise Reduction both come into their
own when you’re working with images shot at high ISO ratings under low
light conditions, circumstances which the serious photographer of the nude
is perhaps unlikely to encounter every day! Both are likely to soften the image
significantly if applied with too heavy a hand. Tweaking Luminance
Smoothing can smooth out the darker flecks of noise in the image, and Color
Noise Reduction handles the brighter color noise which also occurs under
these conditions. Be sure to view the image at 100 percent at least, and to
toggle the Preview on and off, to be certain that using these controls is 
really worth it: A noisy but sharp image may be preferable to a marginally
cleaner but much softer one.

Moving on to the lens controls, you’ll find two adjustments for chromatic
aberration and two for vignetting. Chromatic aberration is visible as a color
fringe, caused by the lens’ not converging different colored light accurately.
It’s a feature you’re most likely to encounter in lenses which are cheap or very
wide angle, or both. In Figures 5.28 and 5.29 I’ve simulated an example of
chromatic aberration, showing first the whole image, then a couple of details
in which the aberrations are clearly visible. The controls allow adjustment on
two color axes: Red/Cyan and Blue/Yellow. You may need to zoom up to 200
percent or more to see clearly the effect of making adjustments. 

Vignetting is caused by another type of lens defect, and results in the corners
and edges of the image looking (usually) darker—as in Figure 5.30—or
(occasionally) lighter—as in Figure 5.31—than the rest of the image. Again,
these are simulated examples of vignetting. Moving the slider to the right
lightens those areas of the image; to the left darkens them. By default it’s
assumed that the vignetting occurs equally all round, but you can also adjust
its midpoint if necessary. 
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Figure 5.28 Chromatic 
aberration is barely visible in
the whole image…

Figure 5.29 …but can be
clearly seen in details. 
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Figure 5.30 Dark vignetting.

Figure 5.31 Light vignetting.



The final tab reveals the Calibrate controls. These have two separate uses. In
a studio with a fixed and unchanging lighting setup, you can calibrate a shot
of a test chart and apply the resulting settings to everything you shoot to get
a very accurate rendition of the whole color range. The other occasion, 
theoretically, is to use the Calibrate controls when you need to pull back into
line images which can’t be satisfactorily color corrected using Camera Raw’s
Adjust tools. This is most likely to happen because Camera Raw’s built-in
profile for your camera won’t stretch to handle the lighting under which
you’ve shot a particular set of images—under some very green fluorescent
strip lights, for example.

In the course of writing this book, I tried several times to create lighting
conditions which Camera Raw’s Adjust tab couldn’t put right. I never 
succeeded in fooling it, so it didn’t seem necessary to go into the intricacies
of the Calibrate controls. Nonetheless, if you want to explore the quite
extraordinary manipulative capacity of this aspect of Camera Raw, you’ll
find included in the Bibliography some books which deal with it in detail.

That completes our survey of the uses of Camera Raw, and brings us back to
Photoshop proper. If you’ve been working in Raw you have the comforting
knowledge that however you’ve altered your images, you can always revert to
the original data. If you’re working from your camera’s JPEG files, however,
the only way to ensure that the original remains unchanged is to copy it and
edit the copy. I can’t emphasize too strongly how important this step is.
There’s nothing more frustrating than deciding to start over from scratch,
and then realizing that you’ve irretrievably altered the original file.

One simple method of ensuring that you always work on a copy is to 
double-click the Background layer in the Layer tab as soon as you’ve opened
the file. This will bring up the New Layer dialog, with the effect of changing
the Background layer to Layer 0. Once this change has been made, any
attempt to save the file brings up the Save As dialog. The best choice here is
to save the file into Photoshop format (.psd), but if you try to save the file as
a JPEG, it will be flattened and saved as a copy. Either way the original file
won’t be changed.

Adjusting Levels
The first step in editing JPEGs is to use Image > Adjustment > Levels to opti-
mize your image’s dynamic range before moving on to clean it up. Levels has
the capacity to stretch the dynamic range of underexposed images (see Figure
5.32), but not to pull overexposed images back into line (see Figure 5.33). 
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The right Input Levels slider, Highlights, works somewhat like the exposure
control in Camera RAW, except that it isn’t bidirectional. The highlights 
slider won’t allow you to recover detail out of highlights which have been
clipped, but it lets you stretch the image and force areas that are close to
highlights. For example, if you drag the highlight slider from 255 to 240,
every pixel in the image with RGB values of 240, 240, 240 or more will be
increased to 255, 255, 255. Values below this point will be adjusted to make
the transition from level to level as smooth and imperceptible as possible,
thus brightening the image. A downside is that you may lose detail in some
areas of the picture. 

The Shadows slider on the left works in the same way: You can’t use it to
“uncrush” blacks with a value of 0, but if you raise its value to 30 (for 
example), every pixel with a value of 30 or less will be crushed down to 0.
Compared to the Camera RAW plug-in, Levels works effectively at stretch-
ing a narrow dynamic range, but can’t help recover apparently clipped areas
from an image. 

The midtones control does at least offer bidirectional adjustment, but tends
to push both ends of the dynamic range more than the brightness control in
Camera Raw. Applying these changes results in what you see in Figure 5.34.
In Figure 5.33, the dynamic range is beyond what Levels can correct, as the
histogram makes clear. 
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Figure 5.32 The levels controls and 
histogram, superimposed over an 
underexposed image. Figure 5.33 An overexposed image.



If you click Image > Adjustment > Levels again after correcting the levels,
you’ll see on the histogram the effect of the corrections you’ve made. (Clicking
Auto in the Levels window when you first open the image will show you
instantly how the histogram would change if you used the Auto adjustment.)
A number of white gaps appear in the histogram, representing levels where
there’s no longer any information, and some taller, black spikes where two or
more levels in the original image have been compressed into just one level.
Figure 5.35 shows the histograms before and after adjusting levels—done in
this case by applying the Auto setting. I’ve chosen a very underexposed image
to demonstrate how many levels can go missing as a result of this process.
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Figure 5.34 The image 
“corrected” using Levels.
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Figure 5.35 The effect of
applying auto levels to an
image with a narrow 
dynamic range.

Making Selections
One of the most common procedures in image editing is selecting part of an
image to manipulate it separately from the rest of the picture. Depending on
the context, a selection may need to have a hard edge (making a strong 
separation between two areas) or it may need to be feathered (creating a 
softer edge). Photoshop offers a range of tools for doing this, including the
Magic Wand, Lasso, and Pen, all located in the toolbox, as well as the very
powerful Extract, which is available under the Filter menu. Every Photoshop
user has favorite methods, and most people tend to stick to one or two. So
after an overview of everything that’s available, I’m going to concentrate 
on the methods I’ve found most useful. Other methods also have their 
champions, and the some of the books listed in the Bibliography provide 
further instruction in using the tools which are only briefly considered here.

Magic Wand Tool
The most obvious way of making a selection—and the method that seems to
make the biggest impression of any tool on Photoshop newcomers—is the
Magic Wand. It really does seem magical! However Magic Wand is also the
tool which Photoshop professionals favor least. It’s often difficult to judge
what Tolerance will work effectively on a given image. If you set it too low,
you’ll spend hours making your selection. If you set it too high you run the
risk of selecting areas you don’t intend to select (see Figures 5.36 and 5.37),
some of which may be so small that they don’t become evident until you



make some change to the selected areas, and observe it taking effect in places
you didn’t intend it to. I don’t think I’ve ever made a Magic Wand selection
without having to go round it and tweak it with one variant or another of the
Lasso tool. All in all, the Magic Wand seems too slow and too risky.

Pen Tool
The Pen tool, in all its many guises, is at the opposite end of the precision scale.
The Pen tool lets you draw around the areas you want to select. Although it’s
less intuitive than most Photoshop tools, it is very accurate and, once you’ve 
gotten used to it, pretty speedy. However, the Pen tool seems to have one signif-
icant disadvantage in editing images: It isn’t possible to feather a selection as you
make it with the Pen tool, and as most edges in photography aren’t razor sharp,
selections made with the Pen tool may need feathering separately, and with 
different amounts of feathering at different points, if they’re to look natural. 

Lasso Tool
Somewhere in between the Pen and the Magic Wand tool comes the Lasso
tool and its variants. The Magnetic Lasso in particular can be impressively
fast and accurate in selecting strong, clear edges, but like many other tools
tends to get lost in the intricacies of hair.

Extract Tool
Hair. There’s a book to be written about handling hair in image manipulation.
The Photoshop tool which separates hair from its background best is the
Extract tool. But this isn’t an easy ride. Even using Extract, selection of big hair

Postproduction 329

Figure 5.36 So far the Magic Wand has made a usable 
selection of the background of the image.

Figure 5.37 Just one more click selects the wrong area. 



is a slow process that needs patience and a meticulous hand and eye. I’ve never
seen a perfect and totally convincing example of extracted hair in any textbook
on Photoshop, and I’ve certainly never managed to create one myself. This
demonstrates nicely that some elements of photography are done best and
most easily by getting them right in the real world—in this case by getting 
the background behind the model’s head as it needs to be before you take the
photograph.

Layer Mask 
The final method we’ll consider is the one I use most: a layer mask. In essence,
it’s simple. You create a layer mask in a duplicate or adjustment layer and paint
out, in the mask, the area you want to select. Because you’re painting the mask,
rather than drawing it, you can easily vary its hardness by varying your paint-
brush’s hardness; you can also vary the opacity of the mask areas; and you can
easily correct the mask by flipping the foreground and background colors and
painting over the area where you went wrong. If you Command+click
(Alt+click) the layer mask, as I’ve done in Figure 5.38, you’ll see the familiar
marching ants which show the masked area as a selection that can be edited
(using the Lasso tool, for example) and saved under Select > Save Selection.
(You can work this way using Quick Mask as well, but keep in mind that quick
masks vanish when you save and close a file.) The mask is stored in a special
channel, known as an alpha channel. Masks and channels are grayscale images,
so you can edit them like any other image, as we’ll see later.
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Figure 5.38 The marching
ants show the first rough 
outline of background areas
which, in this case, are to be
darkened using an adjustment
layer and Multiply blend
mode.



Cleaning Up
It’s surprising, looking at photographic web sites, how many otherwise 
competent and creative photographers don’t bother to clean up images. By
cleaning up I mean the process of removing minor imperfections in the
image. These might be anything whose presence distracts from the purpose
and meaning of the image: blemishes on the model’s skin, a coil of the cable
for your flash head that strayed into the shot, or the like. 

However the need for cleaning arises, I can’t emphasize too strongly how
important a step it is. Along with correcting tilt in an image, it’s one of those
(usually) straightforward processes which can be carried out quickly, and
improves the appearance of the image out of all proportion to the effort
involved. So be thorough! Look your images over carefully, identify any
unnecessary elements, and use Photoshop’s battery of tools to eliminate them.

Admittedly, there’s always debate over how far it’s “right” or appropriate to
remove imperfections from the model. There’s no doubt that overcorrection
produces a plastic-looking, inhuman figure at the heart of your image, but
there’s much that can be done to make the model look better without 
reaching that extreme. It depends what impression you’re trying to give. For
example, is the model’s body in the image you’re editing intended to be 
symbolic of flawless physical perfection and allure, with every curve 
approximating to a classical Greek statue and marble-smooth skin? Or is it
intended to remind the viewer that we’re all physically imperfect and, over
time, likely to become even less perfect? 

On the other hand, even an image whose purpose is to depict the experience
of being human may need to be edited to emphasize some aspects of that
experience and deemphasize others. For example, in Figure 5.39 (already seen
at Figure 2.12) I looked for a black-and-white treatment which would
emphasize the parallel stretch marks on the model’s skin. I also wanted to
remove some marks which weren’t part of that pattern, such as shaving
bumps and also the mark left by the model’s belly-ring piercing. Compare
Figure 5.40.

As a general rule, be cautious about using destructive editing processes to
make any kind of extensive alteration to an image. Wherever possible, it
makes sense to use methods which allow you, at any stage, to get back easily
and safely to earlier states. For example, in the case of tools which have an
option to sample all layers, you can create an empty layer above the image
layer and edit on the empty layer. Where making selections are concerned,
you can make them using layer masks. (This is discussed in detail in “Making
Selections” later in this chapter.)
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Because I’m shooting RAW, I know that the original of every image is stored
in a format to which I can’t apply destructive editing and to which I can
always go back. But it’s frustrating to do a lot of basic work in Photoshop, like
removing blemishes, and then have to go back to the RAW file because some
adventurous but destructive technique (perhaps applying a couple of filters 
or cropping the image) you tried on the image hasn’t worked, and I can’t
recover the file to a stage before my unsuccessful adventure but after the 
blemishes were fixed. So it makes sense always to produce a clean, straightened
image first—and save it!—before approaching the riskier phases of editing. 

Photoshop offers several tools designed to deal with imperfections, such as
the Clone, Spot Healing Brush, Healing Brush, and Patch tools. The Spot
Healing Brush is new to Photoshop CS2, and is almost too good to be true.
You just make the tool slightly larger than the blemish you want to fix, click
the blemish, and it’s gone; see Figures 5.41 through 5.43. 

You can play around with the parameters for the Spot Healing Brush, but
nine times out of ten the defaults work perfectly. As well as just clicking a
more-or-less circular blemish, you can drag the tool over a more elongated
one. Note also that you can play safe, as recommended earlier, by creating an
empty layer above the image layer, clicking Sample All Layers in the options
bar, and making your corrections on the top layer. Too much trouble, I’d
agree, if there’s only a handful of blemishes to fix, but a useful precaution if
you have to do a lot of work with this tool.

Figure 5.39 The corrected image. Figure 5.40 The original for comparison.
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Figure 5.41 The image as shot.

Figure 5.43 The image after
cleaning up.

Figure 5.42 The Spot Healing
Brush at work.
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The Healing Brush and the Patch Tool both work by matching the texture,
lighting, transparency, and shading of the pixels from a clean area of the
image to the area containing the blemish. I find that I’m using them less now
that the Spot Healing Brush is available, but they give subtler and more 
invisible results than using the Clone tool on larger areas where the Spot
Healing Brush might seem too slow.

All these tools, however, are effective only if the area to be healed is pretty
homogenous in terms of color. In particular, attempts to use them to heal
areas with sharp edges between different colors will usually result in smearing.
Figures 5.44 and 5.45 demonstrate this. However carefully you use 
plastic wrap, it wrinkles. Fortunately, it’s easy to remove the rough edges 
convincingly and make the model appear smoothly wrapped. In this image I
also want to get rid of the feather (part of the model’s far-out hairstyle) which
is visible under her left arm, because in that position is seems distracting.
However, none of the healing tools can handle the difference between 
the black wrap and the background, or even between the feather and the 
background.

Figure 5.44 The unedited
image.
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So the way to handle this is to go back to the Clone tool. Create an empty
layer, check Sample All Layers in the Clone tool options, and in the top layer
clone the background over the rough edges. I’ve cloned out the feather as well.
You may need to adjust the brush hardness so it matches the crispness of any
edges you’re cloning up to and retains consistency with the rest of the edge.

On the other hand, don’t worry if you do clone slightly over areas you don’t
want to alter: You’re working on a separate layer, and the overlap’s easily
cleaned up. To clean the overlap, lower the top layer’s opacity, so you can see
the outline you need to preserve; see Figure 5.46. Then use the Eraser tool to
clean up any overlap areas. Again, you may need to adjust the Eraser tool’s
hardness to match the edges you’re cleaning. When you?re finished, move the
opacity for the upper layer back up to 100%, and click the top layer on and
off to check that your adjustments are all correct, before merging layers or
flattening the image; see Figure 5.48. 

A word on merging and flattening: Once you?ve taken either of these steps
with an image, then saved and closed it, you can?t get it back to its pre-
merge/flatten state. With corrections such as cloning, it?s easy to be certain
that everything?s okay before you merge or flatten. With many of the other
processes described later, however, it makes sense to keep the image layered
so you can rework it later. The opacity settings in Figures 5.61 and 5.63, for
example, result from revisiting and playing with the images over a period of
a couple weeks. Multilayer images do take up more space, but that?s a small
price to pay for the flexibility they offer.

Figure 5.45 Healing tools can’t
handle situations like this.
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Figure 5.46 Working with the
top layer half transparent
makes it easy to clean up the
effects of overzealous cloning. 

Figure 5.47 The final version
of the image has the plastic
wrap cleaned up all around.
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These examples have focused on the foreground, but getting the background
right can be just as important. If you’re working with a shallow depth of field
and the background’s a little soft, this makes it all the easier to alter. This
doesn’t mean, however, that it’s worthwhile spending hours and hours doing
clean-up work on every image. Each of us will have our own sense of where
to draw the line. Here’s an example, chosen because it needs quite a lot of
correction but where the quality I hope to achieve in the end product makes
that effort worthwhile. Figure 5.48 shows the unedited version of the image. 

This studio nude depends on simplicity. Here the backlight which picks out
the model’s musculature so beautifully has also caught and highlighted a
fold in the drapes (which are also wrinkled where they reach the floor). As
a further complication, a futon has also intruded into the shot; this was a
test shot which turned out to be the best of the set. I could crop the futon
out, but I like the positioning of the model in the space, so I’ll remove 
the futon. This is easier than it looks, because the background’s flat and
slightly soft with a shadowed lower edge (and therefore not difficult to
clone), and the lines made by the floorboards can be used to extend the floor
accurately and convincingly. I’ll also crop the image slightly on the right
side, and take out what remains of the leg of the lighting stand.

I’ve started by removing a couple of small spots on the model’s back, using
the Spot Healing Brush as described earlier. Next I used the Healing tool to
take out the bright fold in the drapes. The lasso around the area I want to
alter is deliberately drawn quite roughly and unevenly—the less regular 
the outline of the alteration, the less likely it is to be noticeable; see Figure
5.49. This is pretty straightforward work and doesn’t need to be done on a
separate layer.

Figure 5.48 The image as shot.
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The next and largest step is to take out the futon and the wrinkled lower edge
of the drapes using the Clone tool. This definitely needs to be done on a 
separate, empty layer. Using the largest brush size that will fit, I selected as
my source a point just to the right of the wrinkled area, where the drape and
its shadow meet the floor. Once I’ve made this selection, I press down the
Shift Lock. This will turn the open circle which normally represents the
Clone tool into crosshairs, which represent the center of that circle. Clicking
down carefully on the edge between drapes and floor just to the left of my
sample point, and starting to clone in new drapes, I made sure that I got a
clean new edge. I checked also that the edge was in the right place and ran at
the best angle; see Figures 5.50 through 5.52. In this case, because the drapes
recede slightly, I reshaped their edge a little forward of its real position. If you
don’t get it right the first time, undo what you’ve done (or go back a step in
History) and try again.

Figure 5.49 Lassoing the area
to be altered.

Figure 5.50 Positioning the clone tool. Figure 5.51 Cloning a new edge to the drapes and 
removing the upper part of the futon at the same time.



Then I extended the floor over the futon. The edges of the floorboards run
parallel to the edge of the drapes, so in theory the Clone tool needn’t be reset.
I tested it on a small area in the foreground first: If it weren’t producing 
convincing edges to the floorboards, I’d have used Undo or the History again
to get rid of the test and then reselect the source point; see Figure 5.53.

One irritating but inevitable feature of cloning areas in an image is that small
features within the source you’ve selected, which are scarcely noticeable in
themselves, begin to form a rhythmical pattern as you apply the Clone tool,
as can be seen in Figure 5.53. This wasn’t a problem with the drapes, but it
is with the floor. (There’s a tradeoff here: I’ve chosen to keep cloning with the
same sample point, in order to keep the edges of the floorboards dead
straight, and that’s why I’m getting these patterns. I find it easier to fix the
patterns than to keep those edges straight while changing sample points.) So
as a final step, after double-checking that the new floorboards are straight, 
I merged the two layers and used the Healing tool to take out any such 
patterned features; see Figure 5.54.
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Figure 5.52 Note that the new
edge where the drape meets the
floor looks convincing, thanks
partly to the shadows.

Figure 5.53 Starting work on
the floor boards. 
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Working in this way, fixing even large areas of images is straightforward, if
time consuming. All that remained was to crop the image slightly, clone out
the lighting stand on the right, and convert the image to black and white
using Image > Calculations as described later; see Figure 5.55.

Figure 5.54 Removing the
repeat pattern.

Figure 5.55 The image in its final form.



Correcting Tilt
Edit > Free Transform isn’t available for the Background layer: You need to
convert the background layer to a normal layer first by double-clicking it in
the Layer tab, then clicking OK in the New Layer dialog. Once that’s done,
you can rotate the image so that it looks right. There are at least three 
possible versions of “right” here, and they may not all be simultaneously 
possible: making the horizontals look right, making the verticals look right,
and making the model’s position look right. In Figure 5.56, for example
(already seen as a color image at Figure 4.22), the most important element in
judging the rotation turned out to be the edge of the windowsill tiles.

When you rotate an image, you either have to crop it to remove the empty
areas created in the corners by the rotation, or you have to fill those empty
areas. In studio images, this might just be a matter of cloning in some more
flat background; in location shots, particularly if you’re working with shallow
depth of field and deep perspective, it’s also easy to extend soft-focus, 
real-world backgrounds of trees, brick walls, and so on. It’s also possible to
clone (some parts, at least) of the model’s body or garments. In Figure 5.57,
for example, model RubyBlue seems to be leaning to the viewer’s right.
Rather than crop the image after rotating it, it’s possible to draw the missing
part of her thigh; this can be done the same way the floorboards were 
extended in Figure 5.53. Here the Clone tool needs to be set carefully on the
edge of the model’s thigh, just as it was on the edge of one of the floorboards;
see Figure 5.58.
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Figure 5.56 The image has
been rotated to make the edge
of the tiles horizontal.
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Altering Emphasis
Once you’ve adjusted the image so that it has the greatest possible dynamic
range, you can manipulate it to achieve the greatest visual and emotional
impact. Often this is just a matter of improving the brightness and contrast.
You can do this via Image > Adjustments > Brightness/Contrast or a
Brightness/Contrast adjustment layer. Another very effective way of doing
this is to use an adjustment layer with either Multiply or Screen blend

Figure 5.57 The original
image is tilted to the right.

Figure 5.58 Cloning in a 
section of thigh.



applied to it, to darken or brighten the image, respectively. Multiply and
Screen, in effect, each apply a predetermined tonal curve setting. In Figures
5.59 and 5.60 the adjustment layer is set to Multiply, with an opacity of 40
percent, after some experimentation.
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Figure 5.59 The image before
adjusting with a Multiply layer.

Figure 5.60 After editing.



Screen has been used in Figures 5.61 and 5.62, and again, the opacity setting
worked out at 40 percent.
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Figure 5.61 The unedited
image.

Figure 5.62 After applying a
Screen adjustment layer.



It’s often desirable to darken or lighten just the background to emphasize the
figure in the foreground. You can do this using the Burn and Dodge tools on
the background, but while these methods can work well on small sections of
the image, I find it difficult to get an even effect over large areas. Again, an
adjustment layer with either Multiply or Screen blend applied to it can 
be used; but this time we’ll mask out the foreground, so that only the 
background is changed. 

Figure 5.63 is the unedited image: I want to make the background darker.
Begin, again, by creating a Curves adjustment layer. Set the blend mode for
this layer to Multiply. This will immediately darken the whole image. Click
in the layer mask to make it active and check that the foreground color in the
toolbox is set to white. (Whatever colors were set before change to black and
white when you click in the layer mask. Press X to swap background and
foreground colors, if necessary.) Now press Command+Backspace
(Alt+Backspace) to fill the layer mask with black (the background color).
This makes the upper layer transparent, removing its effect. Next, choose a
paintbrush the right size and, still with the layer mask selected, start to paint
(in white) over the background areas of the image. As you make these areas
of the mask opaque, you’ll see the effect return, darkening the areas where
you’re painting the mask. 

If you go too far and paint over the foreground, just press X to reverse the
background and foreground colors for your brush, and paint the area where
you went wrong. You may need to change brush sizes frequently as you work:
The easiest way is to use the square bracket keys: [ makes the brush smaller
and ] makes it larger. There may be areas (particularly when dealing with the
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Figure 5.63 The unedited
image.



model’s hair) where you get the best results by reducing the opacity as well as
the brush size. In Figure 5.64 we see the work partway through. It may also
be helpful, in parts of the image where the background and foreground meet
with a fairly hard edge, to increase the hardness of the brush. And don’t worry
if, as you work, the background still seems too light or too dark. 

Once this process is complete, you have a range of further options. If the
background is too dark, you can reduce the adjustment layer’s opacity until
the balance between background and foreground looks right. If the 
background still seems too light, duplicate the adjustment layer. When you
do this, the new layer will include the adjustment layer’s layer mask and will
also be set to Multiply. This may make the background too dark; if it does,
reduce the opacity of the top layer to bring the image into balance. In Figure
5.65 the adjustment layer works best with an opacity of 80 percent.
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Figure 5.64 Darkening the background.

Figure 5.65 The edited image.



This works well with a simple (for example, single-layer) image such as this
one, but because adjustment layers are applied to all the layers below them,
it may produce unexpected results in a multilayered image. So if you expect
your image to acquire more layers below these, create a duplicate layer of the
image instead of an adjustment layer, and follow the same steps.

At the other extreme, you may want to make the background brighter, if, for
example you’ve been shooting against a white background and it’s slightly
underexposed. You can do this by following the methods described earlier:
selecting Screen rather than Multiply. 

Alternatively, try this method. The background of Figure 5.66 needs to be
made brighter. An adjustment layer won’t work for this method. Duplicate
the layer and use Image > Adjustments > Replace Color on the upper layer.
Set the eyedropper to Add to Sample, and click the background until all of
it is highlighted. Then set Saturation to –100 and raise the Lightness to give
the look you require. (Keeping some tone in the background usually works
better than turning it blinding white.) See Figure 5.67.

Each of these steps will also have an impact on the foreground figure in the
upper layer (see Figure 5.68), so the next step is to create a layer mask in the
upper layer and paint in the mask. Painting reveals the unaltered foreground
in the bottom layer. Once more, adjust the opacity of the upper layer to 
produce the desired balance between background and foreground; see Figure
5.69. You can also use Replace Color in this way to change, rather than 
lighten, the background color.
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Figure 5.66 This will 
work better with a lighter 
background.
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The combined use of duplicate layers or adjustment layers, blend modes, and
layer masks is at the heart of most serious image manipulation in Photoshop.
At its simplest, trying an idea on a duplicate layer is a good, risk-free way of
experimenting: If the idea doesn’t work, you just scrap the duplicate layer and
start over. At a more advanced level, the use of layers gives you powerful yet
subtle control over the your image’s “lighting,” enabling you to adjust 
anything from the whole picture to any small part of it.

Figure 5.67 The Replace
Color window.

Figure 5.68 Pushing the 
lightness value for the 
background may affect some
parts of the foreground.
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Figure 5.69 The edited image.



Here’s another example of the same techniques, used this time to control the
lighting in the foreground of the image in Figure 5.70. The model brought
the fan to the shoot, and we were struck by the possibility of making 
something of the model’s very striking eyes and the “eyes” of the peacock on
the fan. I lit the shot with a big softbox in front, and another light, with its
barn doors closed down to a narrow slit, aimed from the side and behind the
fan to bring out the model’s eyes. It all worked fine, except that the second
light also lit up the fan fabric from behind, reducing the saturation of its 
colors and making it look flat and dull. The solution was to create a Curves
adjustment layer, set it to Multiply, and in the layer mask paint in the fabric
of the fan (but not the fan’s wooden ribs, which are opaque and thus weren’t
backlit). See Figure 5.71.
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Figure 5.70 The fan’s tones are
made duller by being backlit. 

Figure 5.71 The fan masked in with a
Multiply adjustment layer.



Playing with Filters and Blend Modes
The filters supplied with Photoshop, to say nothing of those devised by
third-party manufacturers, constitute a huge resource for changing the
appearance of your images. But they suffer from one problem as far as 
creativity and originality are concerned: Every Photoshop user has access to
the same filters, so when you just apply a filter to your image, it’s likely to
come out looking just like every other Photoshop user’s work. The Filter >
Filter Gallery option helps you escape from this sameness by letting you carry
out quick tests of different filter combinations. Using the filter gallery, you
can create a stack of filters on an image, and change their order in the stack,
to see the different results; see Figure 5.72.

This is a very helpful first step, but because the gallery only allows you to
apply the filters full strength and has no blend mode controls, it’s still only
a test bed—not a way of getting straight to a finished image. The real power
of filters lies in varying their strength and blending them in different modes.
(Also, as Photoshop Help points out, some filters listed in the Filters menu
are unavailable in the Filter Gallery. This applies particularly to third-party
filters.)

Once you’ve applied a filter, however, Photoshop does provide Edit > Fade as
a way of adjusting the filter’s strength; you can use the same command to
fade changes made with tools such as brushes. However, Edit > Fade can only
be applied to the last tool or filter you used, and this isn’t very helpful. Here
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Figure 5.72 Using the filter
gallery.



again the easiest way to work is to create a duplicate layer and apply the 
filter to that, so that you can then experiment (at any subsequent point in
your work on the image) with varying the opacity of the top layer to reduce
the filter’s impact. 

Photoshop Help is surprisingly good on what each of the blend modes 
does, described in terms of the underlying math as well as the likely result of
applying it. You can find the information under Blending Modes >
Described in the Help index. At the same time, the results of applying the
same blend to different images can differ surprisingly, so always expect the
unexpected, particularly when using Image > Calculations. 

Many filters and blend modes push the dynamic range of an image to the
extreme. Applying Color Burn or Linear Dodge, for example, increases 
contrast to an extent that makes most normal images look very blown out.
Plastic Wrap, Accented Edges, Diffuse Glow, and Chrome are among filters
which often have the same impact. Once you understand how a filter or
blend mode is likely to effect your images, you can adjust the image before
applying the filter to avoid excessive blowout or empty black areas, thus 
getting more out of the filter or blend mode. I’ll illustrate this with a 
third-party filter: the curiously named Monday Morning from Nikon Color
Efex Pro! This is a great tool for applying subtle grain to an image, but it also
pushes the brightness and contrast, as Figures 5.73 and 5.74 demonstrate.

To hold all the detail in the image while using the filter, create a duplicate
layer and lower the brightness and contrast in that layer, use Image >
Adjustments > Brightness and Contrast, not an adjustment layer. Then apply
the filter and check it carefully in the preview window. There’s a certain
amount of trial and error in this process, so if the preview looks too flat or is
still too high contrast, cancel the preview, readjust the brightness and 
contrast for the layer, and apply the filter again; see Figures 5.75 and 5.76.

We haven’t been working on a duplicate layer just for security. Now you can
experiment with different blend modes for the top layer, combined with dif-
ferent opacities for the bottom layer, to produce a range of subtly different
versions of the image. In Figure 5.77, for example, a very punchy version of
the image results from setting the blend mode to Soft Light, with both 
layers at full strength; in Figure 5.78 the opacity of the lower layer is reduced
to 35 percent, making the grain more prominent.
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Figure 5.73 The original.

Figure 5.74 With Monday Morning
applied at default settings.

Figure 5.75 This very flat image 
produces…

Figure 5.76…this when Monday Morning
is applied.



Creating Monochrome
The advent of 35mm color films in the 1950s did little to challenge the place
of monochrome as the natural medium for much artistic nude photography.
Similarly, the fact that many digital cameras don’t have a black-and-white 
setting shouldn’t discourage photographers from working in monochrome.
We’ll start with a few different methods of converting images to black and
white, then look at the extra steps needed to tint these images—for example,
to mimic traditional sepia and selenium (blue) toning.

The Desaturate and Channel Mixer Commands
The simplest way to change a color image to black and white is to click Image
> Adjustments > Desaturate, illustrated in Figure 5.79. This is a one-shot
deal, with no parameters to adjust: Either you get a good-looking black-
and-white image or you don’t. Desaturate tends to reduce skintones to a
rather dull mid-gray, however, and that’s why you may choose to pursue
other possibilities.

The next method is Image > Adjustments > Channel Mixer (or a Channel
Mixer adjustment layer). Channel Mixer treats each of the three channels of
an RGB image as if it were a grayscale image, and allows you to, well, mix
the channels. (You can see the grayscale differences between the channels if
you go to Preferences > Display and Cursors, toggle off Display Color
Channels in Color, and then look at the channels of your image one by one.
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Figure 5.77 Both layers at full strength. Figure 5.78 Lower layer opacity at 35 percent.



The most noticeable difference, on skintones, is usually between the Red and
Blue channels.) 

By default, the Channel Mixer window opens with the Red channel set to
100 percent and the other two channels set to 0. Check the Monochrome
box and observe the results. Now try lowering the Red to 80 percent and 
setting Blue and Green each to 10 percent. Experiment also with the
Constant slider. Note that you generally need to keep the total value of the
RGB channels for a correctly exposed image to 100 percent to avoid the
image looking flat or blowing out; see Figure 5.80. When you finish mixing
the channels and click OK, all three channels will have the same values. This
results in an image which is technically in color (in this example, an RGB
rather than grayscale image) but looks monochrome.
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Figure 5.79 Monochrome
conversion: the quickest
method.

Figure 5.80 A more vivid
monochrome rendering using
Channel Mixer.



Channel mixer gives best results with quite big differences between the
channels. If you set all three channels to 33 percent, you’ll get the same
result as with the Desaturate command: rather flat and uninteresting. I find
that settings around 80/10/10, as described earlier, produce pale skin with
little textural detail. To increase texture, drop the Red and raise the Green.
Go cautiously with Blue: Too much of it tends to produce uneven skintones.

The Calculations Command
Channel mixer is clearly more powerful than Desaturate, but Photoshop has
another tool for creating black-and-white images. This is the very versatile,
but rather fearsome, Image > Calculations. I’ve no idea why it has that name,
and Photoshop Help is pretty unhelpful about it all.

In theory, Calculations allows you to combine channels from two or more
images, converting them to black and white and blending them at the same
time. “Or more” is a little imprecise: You can combine channels from a 
maximum of three images, and only in a rather inflexible manner. In 
practice, I use Calculations with just one image at a time, using its two 
layers and mask to achieve the most powerful and flexible manipulation and
conversion into black and white that Photoshop itself offers. 

To use Calculations, start by making sure that no other image with the same
pixel dimensions as the image you want to convert is open. This will avoid
confusion later. If the image is 16 bit, you can switch it to 8 bit. This speeds
Calculations, without losing any quality or dynamic range in your 
monochrome image. Double-click the background layer of the image in the
Layers window to convert it to a normal layer. (I’m assuming for the moment
that the image you’re working on has only one layer.) Then select Image >
Calculations. The interface presents two source layers and a mask, with
options for Layer and Channel for each source; for blend mode and opacity
between the two sources; and, if you check the Mask box, for Layer and
Channel for the mask as well. If you don’t convert the background layer to a
normal layer, you won’t have transparency as an option for any of the layers.
See Figure 5.81.

From this point on, it’s time to experiment, and it’s every photographer for
himself! I begin by setting the channels for both sources to Red, which gives
an ivory glow and transparency to a wide range of skintones. This works well
with Soft Light as the blend mode, but it’s worth experimenting also with
combinations of Red and Green channels for the two sources, as well with Red
or Green as one layer, and transparency as the other. (I avoid using the Blue
channel, because it’s the noisiest and tends also to produce uneven skintones.)
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Try running through the different blend modes and adjusting the opacity. (If
you’re just experimenting, dragging the opacity down to about 50 percent
will preview more quickly, to give you an idea of the possibilities in that 
particular blend mode.) Not all blend modes will work with all layer 
combinations: For example, Red + transparency produces a rectangle of pure
white when blended in Soft Light mode. Changing opacity will make no 
difference to some settings, either. If your image has more than one layer, you
can use any individual layer, or the merged image, in each source. Again,
some changes here will make no difference to the output.

Note also that the glowing skintone you can achieve with Red + Red in Soft
Light mode often extends also to darker areas such as the model’s lips, 
making them look rather ghostly; see Figure 5.82. You may want to fix that
afterwards, and there’s a good method for doing that, described later.

Try the effect also of switching the mask on. Generally it will flatten the
image noticeably. Check Invert and the flattening effect will reduce, and with
blends such as Multiply may provide a better tonal distribution than using
the blend without a mask. You’ll also get subtle changes in the mask’s 
effect by switching the mask layer from Gray to Red or Green. (If you have
another image open with the same pixel dimensions as the image you’re
working on, Photoshop will make it the default mask. Just click the Mask
menu and select the correct image.)

If you’ve been trying these steps on your computer as you read this, you’ll
understand why Calculations is less understood than it should be and less
used than it deserves to be. The range of results is perplexing. There’s a great

Figure 5.81 The Calculations
window.
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deal of redundancy, with different combinations producing very similar
results, and it’s hard to keep track of them all. It’s a good idea to keep a recipe
book of what works for your personal aesthetic. My own favorites are 
variants of Red/Green/transparency with Multiply or Soft Light, often with
a red inverted mask; and some slightly flat images can be given more punch
by applying Hard Light.

As you experiment, you’ll often find that different areas of your image look
better with different combinations of layers and blends. One example, as
we’ve seen, is the model’s lips, which often look darker, more sensual, and less
ghostly as Red + Green or even Green + Green. Rather than having to choose
just one of the many different possibilities, you can process the image twice,
once for paler skintones and once for darker details, and then combine the
two versions.

Once you’ve set the parameters for one of the versions you wish to combine,
you may want to make a note of what the settings for the second version should
be while you can remember them! Then select New Document from the Result
menu and click OK. This will create a new document of your first version, 
leaving the original image untouched, so you can go back to it to 
create the second version. This new document comprises only an alpha 
channel and will be called something like Untitled-1. Select it, then convert it
to RGB by clicking Image > Mode > Grayscale, then Image > Mode > RGB.

Figure 5.82 Glowing skin-
tones, but the lips are too pale.



Next, go back to the original image, go back into Calculations, and reset its
parameters to the other version of the image you want to combine with the
first version. (Switch the result back to New Channel to avoid creating more
versions of the image on screen than you need.) Now click OK. This time if
you click Window > Channels, you’ll see an RGB image with an alpha 
channel. To use it, you need to throw away the RGB channels, then convert
the alpha channel into a new RGB image. You can do this by flattening the
image, then dragging the RGB channels, one by one, into the trash at the
bottom of the Channels window. Now, as with the first version of the image,
go to Image > Mode > Grayscale, then Image > Mode > RGB. It isn’t 
strictly necessary to convert a black-and-white image to RGB, but I always
do this for the sake of consistency, and if you want to tint the image you’ll
need to do it anyway.

Finally, select Untitled-1, Shift+click the background layer in its Layer 
window, and drag it onto the other image to create a single image with both
layers. Then it’s just a matter of creating a layer mask for the top layer and
painting it out to reveal the appropriate areas of the layer beneath. In this case
I’ve varied the brush opacity to add more emphasis to the lips than to the
nipples. You can also safely close Untitled-1 without saving it: It’s now the
top layer of the other image, and you’re editing it nondestructively. Figures
5.83 and 5.84 show the darker image (created using Multiply in
Calculations) and the effect of combining it with Figure 5.82.

Postproduction 359

Figure 5.83 A darker version of the
image.

Figure 5.84 The result of combining
both images.



This may seem a lot of effort for an area as small as the model’s lips, which
could be darkened by simply burning them in with the Burn tool. However,
the right choice of settings in Calculations will retain the highlights on the
model’s lips in a way that’s hard to match with the Burn tool.

So far we’ve produced black-and-white images. There’s a long tradition in
photography of images which are monochrome but not black and white. In
traditional photography the most common forms of this are sepia- and 
selenium-toned images. Photoshop offers a quick and easy way of creating
such pictures, which still have a strongly sensual and nostalgic feel. Having
created your monochrome image, go to Image > Adjustment > Curves or use
a Curves adjustment layer. Click Channel > Red. Click the curve midpoint
(input value 128) and pull it up to an input value of about 117 and an 
output value of 140. Do the same with Green (input 122, output 133), and
reduce Blue at the midpoint to input 134, output 125. This will create that
sepia look shown in Figure 5.85. You’ll find that the precise values that 
work best vary a little from image to image. For the selenium look, set the
Blue channel at the midpoint to input 120, output 139, or thereabouts; see
Figure 5.86.
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Figure 5.85 Sepia toning 
created in Curves.
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That covers the methods available in Photoshop itself for creating 
monochrome images, but many third-party manufacturers have plug-ins
available. I’ve found ConvertToBW Pro from theimagingfactory
(www.theimagingfactory.com) a useful filter for this purpose. Its parameter
adjustments let you apply a prefilter; set a color response either by manually
adjusting the response across the color spectrum or selecting from a range of
presets which mimic different photographic negatives; adjust the contrast
ratio, mimicking the use of multigrade paper; and, in the sepia options, 
create a monochrome image based on any color, not just sepia. Figure 5.87
shows the results of using ConvertToBW Pro. I made two versions at 
slightly different settings and combined them to keep the skin texture of
model’s left hip and to reduce the shadow over her pubic hair. 

Figure 5.86 Selenium toning
created in Curves.

Figure 5.87 Selenium image
produced in ConvertToBW Pro.

www.theimagingfactory.com


The best parameters for converting even very similar images are rarely the
same, so the filter needs to be applied in Preview mode every time, rather
than opening a bunch of images, setting the filter for the first of them, and
then applying Filter > Last Filter to all the others.

Color Pass
Color pass is the process of retaining one color or color range in an image,
while converting the rest of the image to monochrome. The color you retain
needn’t be the color of the original. In Figure 5.88 (already seen at Figure
2.48), the lily was originally yellow.

Color pass is an easy enough technique to learn: You just create a mono-
chrome version of the image, put the color layer over it (or vice versa), add a
layer mask to the upper layer, and paint it out to reveal the appropriate areas
of the lower layer. However, finding interesting, striking, and unusual ways
of using color pass is less straightforward. Monochrome models in brightly
colored bikinis are a dime a dozen on the Internet, as are monochrome 
models with brightly colored flowers. In Figure 5.89 I aimed to achieve
something a little different, taking a subtler approach to color. Some color of
the model’s nipple has been retained, helping establish the formal parallel
between the shape of the breast and the curves of the lily.
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Figure 5.88 One carefully
positioned lily.



In Figure 5.90, the retention of the gold tones of the model’s shoes heightens
the richness of the selenium toning and draws the viewer’s eye into the 
composition.
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Figure 5.89 And another.
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In Figures 5.91 through 5.93, the original image has been treated in two 
different ways. The red PVC trousers look sexy and striking, but at the same
time they’re a bit obvious. (There’s something about red that seems to make it
many photographers’ favorite color for color pass work.) I prefer the second
version, which picks up the sensual texture of the model’s fake-fur jacket.

Figure 5.90 Selenium and
gold.

Figure 5.91 The original
image.
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Figure 5.92 Go for the red,
or…

Figure 5.93 …choose
something less predictable?



Incidentally, this image also illustrates clearly the benefits of combining 
layers produced with different settings in Calculations. The layer made with
Soft Light and Red + Red makes the red trousers a very unappealing gray, as
Figure 5.94 shows.

The basic method uses Calculations to create the monochrome layer. When
you do this, select New Document as the Result. The presence of a colored
element in the image often seems to make the monochrome areas look rather
flat, so go for a high-contrast black-and-white conversion. Using Image >
Adjust > Desaturate will let you down badly here. Once that’s done, add the
monochrome image as a second layer to the original picture, give it a layer
mask, and set to work painting out the appropriate areas. In the case of the
feathery edges of the fake-fur jacket, some experimentation with the opacity
of the brush was necessary to get a convincing look.

In Figure 5.95 (already seen in Figure 2.114), the rich colors of the laces in
this corset piercing contrast powerfully with the model’s skin, rendered very
white by using Red for both channels in Calculations. In this example the
reflections on the metal surfaces work best when held in monochrome, but
in some images you might want to try using a brush with reduced opacity
when you paint out the corresponding areas in the mask, allowing a little
color into the reflections. Figure 5.96 shows how the image is created: The
mask cuts a hole through the monochrome layer to reveal the color detail
beneath. The opacity of the monochrome layer is set to 100 percent, but 
it’s often worth experimenting with reducing this, retaining a little of the
skintone in the final image.
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Figure 5.94 The Calculations
settings which make the rest of
the image look good, but make
the trousers less attractive. 
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Figure 5.95 Strong contrasts
in color and texture in this
color-pass image.

As with all layer mask processes, meticulous accuracy is essential here, 
particularly when dealing with reflections on highly polished surfaces in the
image. Check the work by clicking the top layer off and on, watching the
edges of the color area closely. Try clicking the bottom layer off and on also,
and check the empty areas where you’ve painted the image out.

Figure 5.96 The hole cut
through the top layer, which
reveals the colored layer below.
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266
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serenity, 264
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shadows

image adjustment, 313–314
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hard-edged light source,

175–178
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skintone emphasis
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jewelry use, 256
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slideshows, 300–301
smooth skin theme, softbox 

lighting, 213
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softbox lighting, 51–52

diffuse light, 211
discussed, 207
evenly lit theme, 209
reflection, 208, 215
rim lighting, 214
smooth skin theme, 213
texture emphasis, 212
typical setup, 210
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spatial compression, 31–33
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Photoshop, 332–333
sprinkles, makeup use, 146–147
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tripod use, 36–37
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Straighten tool, Camera Raw, 307
straw from barn theme, 230–231
strobe lighting, 51–52
studio setup, 227–228

dressing-up box, 251–257
furnishings, 250

stylus, 62–63
subscriptions, Internet models,

108
subtle interplay, lighting, 192
symmetry

floor pose, 280
multiple model shots, 153
standing pose, 274
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120–122, 124

tint, image adjustment, 312–313
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touching gesture theme, multiple

models, 160
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lovers theme, 158
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36–37

U
ultra-angle lenses, 35
ultraviolet sensitive body paint,

lighting, 50
unreality theme, on-camera flash,

217
urban appearance models, 86

V
vertical viewing angles, LCD 

monitors, 62
vibration reduction (VR) lenses,
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W
web dress theme, 252
white balance control, 14–16,

310–311
White Balance tool, 307
wide-angle lenses, 30
wide-gamut inks, 65
window lighting, 43, 175, 180, 241
wooden floor themes, 227
Workflow options, Camera Raw,

307

Z
zoom lenses, 29, 31
Zoom tool, Camera Raw, 306
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